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Live Services Management

NetWitness Live is the gateway to a rich environment that offers access to feeds, tools, and other
resources.

NetWitness Live

Live is the component of NetWitness that manages communication and synchronization between
NetWitness services and a library of Live content available to NetWitness customers. Live provides a
simple interface for browsing, selecting, and deploying content from the NetWitness Live Content
Management System to NetWitness services and software. In addition to managing feeds from the CMS
Library, Live allows users to deploy custom feeds and packages.

Note: Any customer with valid maintenance can access NetWitness Live.

The content management system (CMS) library (known as Live) is a valuable source of the latest
internet security resources for NetWitness customers. It provides a view into the collective intelligence
and analytical skills of the worldwide security community to ensure that users have the most current
visibility into attack vectors.

Live gathers the best advanced threat intelligence and content in the global security community - the
ideas, research, ongoing tracking, and analysis - and brings it directly into the user’s security operations
center to definitively classify computers associated with botnets, malware, and other malicious exploits.
Live aggregates, consolidates, and illuminates only the most pertinent information relevant to an
organization on a real-time basis.

NetWitness Feedback and Data Sharing

Live Feedback is intended to help improve NetWitness. Once you set up and configure a Live account,
usage data is shared with RSA.

For more details, see NetWitness Feedback and Data Sharing.

For Debian Linux and NetWitness Endpoint Users

If you are upgrading to NetWitness 11.5 or later, and you are using NetWitness Endpoint and also have
any Debian Linux endpoint systems, NetWitness recommends that you go to Live and download the
following application rules:

 autorun debian package mismatch

 autorun file path not part of debian package

e debian package hash mismatch in important system directory

* debian package hash mismatch

« file path not part of debian package in important system directory
e file path not part of debian package

8 Live Services Management
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Deploy Content

This section explains the different ways available to deploy content:

e Deploy Content using Live Content Ul

e Policy-based Centralized Content Management

Deploy Content 9



Live Services Management Guide

Create Live Account

Note: The NetWitness Live Registration Portal now has a new user interface and supports email
verification.

You must create a Live account using the NetWitness Live Registration Portal
(https://live.netwitness.com/registration) on the Live server. Live Account is required to access all Live
services including CMS. The CMS Library provides access to all NetWitness content in one place where
you can view, search, deploy, and subscribe to NetWitness content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

Make sure the following are available to set up a NetWitness Live account:

e Active internet connection to access the portal.
e A valid and registered NetWitness License Server on the Flexera Server, before you can register for a

a4
Live account. You can view the License ID on the (Admin) > System > Info panel.

Note: If the License Server is not set up, contact NetWitness Customer Support.

To create a Live Account:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using
the URL: https://live.netwitness.com/registration

The NetWitness XDR Cloud Services Live sign up page is displayed.

10 Deploy Content
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NETWITNESS

Sign in with your username and password

Password *

Username *

SIGN IN SIGN UP FORLIVE

2. Click Sign Up For Live.
The End User License Agreement page is displayed.
Read the Terms and Conditions carefully and click Accept.

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

End User License Agreement

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER”) AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (ll) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (Ill) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED

OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or
Hardware is: (a) the subject of a separate written agreement set forth in a quotation

ACCEPT

3. In the Sign Up for NetWitness Live Account page, enter all the fields:
¢ The First Name and Last Name of the user.
¢ The Company for which the Live Account is being created.
¢ The Email address you enter will be used to receive the verification code for your new Live

account and other notifications related to the Live account.

The License ID can be viewed on Kl (Admin) > System > Info panel.

Deploy Content
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¢ The Username and Password for the Live Account.

NETWITNESS

Sign Up for Netwitness Live Account e

Company

First Name

Last Name

License ID
Username

Password

CREATE ACCOUNT

4. Click Create Account.
You will be directed to Confirm Sign up page.

5. Enter the Confirmation Code sent to your registered email address.
Click Confirm.
You can see the confirmation message for your NetWitness Live Account registration.

Note: You cannot create more than one Live account for the same License ID. For additional
license, contact NetWitness Customer Support.

6. Once the account is created, enter your credentials and click Sign In to access the NetWitness XDR
Cloud Services Live.

7. After you sign in, you can perform the following:

e Search and Download Content from NetWitness XDR Cloud Services Live

¢ Share Telemetry Data to NetWitness

12 Deploy Content
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Reset the Password for Your Live Account

If you want to reset the password for your Live Account, do the following:

1. Access the NetWitness XDR Cloud Services Live Registration Portal using the URL:
https://live.netwitness.com/registration

The NetWitness XDR Cloud Services Live sign up page is displayed.

NETWITNESS

Sign in with your username and password

Username *

Password *

SIGN IN SIGN UP FOR LIVE

2. On the Sign Up page, click Forgot Password?.

3. Enter your Username and click Send Code.
A verification code will be sent to your registered email address.

4. Enter the Verification Code and New Password on the Reset Password page and click Submit.

Deploy Content 13
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Set Up Live Services on NetWitness Platform XDR

To set up Live on NetWitness Platform XDR, you configure the connection and synchronization between

4
the CMS server and NetWitness. The user interface for this setup is the (Admin) > System > Live
Services Configuration panel.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

To configure the connection to the CMS Server:

Q
1. Navigate to (Admin) > System > Live Services.

2. Click Sign In and enter your credentials in the Live Services Account dialog box.

Live Services Account

cms.netwitness.com

Port 443
55l 4
Username admin
Password S T T T TS

Test Connection

3. Click Test Connection to make sure your connection is working.

14 Deploy Content
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4. If the test is successful, click Apply. If not, contact NetWitness Customer Support for help
connecting to the Live server.

5. Configure the timing for synchronization of NetWitness Platform XDR with updates from Cloud
Services Live.

For more details, see the "Configure Live Services Settings" topic in the System Configuration Guide.

Deploy Content 15
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Deploy Content using Live Content Ul

This topic explains the process of deploying the content using Live Content UI.

e Live Services Required Procedures

e Additional Procedures

e References

e Troubleshooting Live Services

16 Deploy Content
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Live Services Required Procedures

The following workflow describes the basic setup into four steps, which you perform individually.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download
Live Content

Configuration Step

Create Live Account

Set Up Live Services on NetWitness
Platform XDR

Find and Deploy Live Resources

Manage Live Resources

Search and Download Content from
NetWitness XDR Cloud Services Live

NetWitness Feedback and Data Sharing

(Optional)
Configure Feedback
& Data Sharing

Create a Live Account on the Cloud Services Live
Registration portal
URL: https://live.netwitness.com/registration.

Set Up Live Services on NetWitness Platform XDR by
configuring a connection with the CMS server.

Search and browse for resources in the Live Search view,
and then, deploy the selected resources.

Procedures for administrators to search for, subscribe to, and
deploy resources from Live.

Search and browse for content in the Cloud Services Live,
and then, download the selected content.

Describes the feedback and data sharing features provided in
NetWitness, from Live Services. Participation is optional, but
can help to provide useful threat intelligence for the
community.

Deploy Content
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Find and Deploy Live Resources

Administrators can search for resources in the Live Search view, which is also the same as browsing the
Live CMS for resources using the Search Criteria panel of the Live Search View.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
. Configure Feedback
Live Content & Data Sharing

Search/Download

Find Resources in Live

IMPORTANT: ESA Rules cannot be deployed manually via Live Services. By default, all the ESA
rules are available in the ESA Rule library if Live Service is configured.

To find resources:

1. Navigate to (Configure) > Live Content.

2. In the Search Criteria panel, specify search criteria. Enter any or all of these: keyword, category,
type of resource, medium, meta keys, meta values, date resource was created, and date resource was

modified.

18 Deploy Content
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Search Criteria

Keywords

Category
[CIFEATURED

» CJTHREAT

» CJIDENTITY

» C]ASSURANCE

» C]OPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Resource Modified Date: i

3. Click Search.

The Matching Resources panel displays detailed results.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS PARSER RULES
Search Criteria Matching Resources
Keywords Show Results | | 3 Package

gy RSA Malware PE Artifacts
Category B 1y pe Malware Rules updated 2018-05-04 11:11 PM version 0.2 size 74.5 KB no
[ FeaTURED Yara |0Cs which statically analyze Windows PE file artifacts for signs of malware.
» I THREAT
» D IDENTITY »:2 RSA Malware PE Packers
k™ e Malware Rules uf ed 2013-11-21 9:07 PM version 0.1 size 93.97 KB subs; ed no
» CJASSURANCE . . -
Yara 10Cs which statically analyze Windows PE files to identify Common Packers
» [ OPERATIONS
[JspecTrRUM == RSA Malware PDF Artifacts
[ MALWARE ANALYSIS i pe Malware Rules updated 2013-11-21 9:07 PM version 0.1 size 587 B subscribed no
Yara 10Cs which statically analyze PDF file artifacts for signs of malware
Resource Types
Malware Rules @  Log Collector @ v 4y McKesson HPF Log Collector Configuration
& Log Collector updated 2017-09-13 5:09 PM 0.2 size 1.42 KB s bed no
Medium Log Collector configuration content for event source McKesson HPF
v @ event analysis, operations, log analysis
Required Meta Keys g SAP ERP Central Component Log Collector Configuration
e Log Collector ated 2017-09-13 5:10 PM version 0.2 size 1.24 KB ed no
2 Log Collector configuration content for event source SAP ERP Central Component
B ouont analucic Anaratiane lno analucic %
Search .
- 191 Matching Resources

4. (Optional) To further narrow the results In the Matching Resources panel, click on a tag, meta key,
medium or resource meta value in a result.

Deploy Resources in Live

In NetWitness, you can deploy selected resources manually, using the Deployment Wizard, or you can
subscribe to a group of resources.

Deploy Content 19
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e When you have results from browsing resources in NetWitness Live, you can deploy resources
manually to a service or a service group without subscribing to the resources. To deploy resources,
select one or more from the list.

* Deploying resources manually deploys to services without taking advantage of the powerful resource
management capabilities of NetWitness. If you want to receive notification and updates for updated
resources and be able to easily remove resources from a service, you must subscribe to resources in
the Live Search view and deploy them in the Live Configure View.

e If you have previously created and saved a resource package, you can deploy the package to services.
Please refer to Resource Package Deployment Wizard for instructions on how to create a package.

Caution: For NetWitness 11.3, there is a new Content bundle for Endpoint, which contains
approximately 400 application rules. Do not deploy this bundle (or the Endpoint application rules) onto
any Log Decoder that is running an earlier version of NetWitness. The rules are only useful for 11.3
and newer, and would have major performance implications if deployed on Log Decoders that cannot
process them.

To deploy resources manually:

1. Goto (Configure) > Live Content.
2. Select a group of resources, or a previously created resource package.

To select a resource or group of resources:

a. In the Live Search View, browse Live resources (for example, search for the Log Collector
resource Type).

b. In the Matching Resources panel, select Show Results > Grid.

c. Select the checkbox to the left of the resources that you want to deploy.

20 Deploy Content
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NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[CIFEATURED

» CITHREAT

» CJIDENTITY

» CJASSURANCE

» [T OPERATIONS
[ISPECTRUM

[ MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:
Start Date End Date

Resource Modified Date:

SUBSCRIPTIONS

Investigate

CAPTURE POLICIES

Respond Users

POLICIES INCIDE

Matching Resources

Show Results |

Subscribed Name

[0 no RSA OSINT IP Threat Intel F...
O no RSA OSINT Non-IP Threat In
[ no Powershell Runs Command...
¥ no Runs ACL Management T...
™ no AWS Security Hub Log Col...
[ no NWFL_fw:outbound-networ...
[0 no 15027002 - Compliance Rep..
[0 no Direct Login By A Watchlist ...
O no 11.3 Endpoint Indicators by...
[0 no RSA Certificate Manager Lo...
[ no Top Outbound Source IP
O no Runs Chained Command S...
[0 no Enumerates Local Groups
[ no SecurlD Cloud Device Regis...
[0 no File Transport over ICMP
O no fingerprint_job
O no Cisco Ironport ESA Log Coll...
0 no HyTrust
[ no Bit9 Log Collector Configur...
O no Event Viewer Executes Unc...
no Microsoft Audit Collection S..

663 Matching Resources

Hosts

"8 Deploy

Files

NT RULES

A\ Subscribe
Created

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-00-12 2:24 PM
2013-11-226:13 AM
2014-02-14 3:34 AM
2013-11-226:11 AM
2019-04-102:17 PM

2014-02-14 3:41 AM

d. In the Matching Resources toolbar, click «* 2ERIaY

Deployment Wizard

Resources

Total resources: 2

Resource Mames

Services

Resource Type

Symantec Critical Systems Protection Log Colle...  Log Co
AWS CloudTrail Log Cellector Cenfiguration Log Co

3. To select a resource package to deploy:

llecto

llecto

Dashboard

Reports

INCIDENT NOTIFICATIONS

XK Package

Updated

2022-09-06 4:30 AM

2022-09-06 4:30 AM

2020-01-23 4:21 PM

2019-04-10 3:09 PM

2020-07-29 7:52 AM

2017-11-11 3:37 AM

2017-09-23 5:41 AM

2018-07-24 5:31 PM

2019-04-10 2:02 PM

2017-09-13 11:40 AM
2017-09-23 5:49 AM

2019-04-103:10 PM

2019-04-10 3:06 PM

2019-04-17 5:56 AM

2017-11-11 3:37 AM

2017-09-23 5:37 AM

2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

Review

Dependency of

ESA RULES

Type

Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule

NetWitness Report

Event Stream Anal...

NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector
Log Device

Log Collector
Application Rule

Log Device

Cancel

admin v

CUSTOM FEEDS

Description

This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool
Log Collector configuration cor
NWEL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remotc
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurIC
Detects files transported over ICA
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
»

Next

a. In the Live Search view - Matching Resources toolbar, select Package > Deploy .

The Package page of the Resource Package Deployment wizard is displayed.

Deploy Content
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next

b. Click Browse and select a package from your network (for example resourceBundle-
FeedsParsersContent.zip).

c. Click Open.

At this point, whether you are deploying a package or a group of resources, the Deployment
Wizard opens, and the Resources page is displayed.

4. Click Next.
The Services page displayed has two tabs, Services and Groups, which provide a list of services and

A
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

Note: The Live server is "smart" about deploying resources to Services. For example, it does not
deploy resources that have a Medium of packets to any Log Decoders. This means that only
applicable content resources are deployed to each Service.

5. Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

¢ Use the Services tab to select individual services, list of services, and service groups that are
QA
configured in the (Admin) > Services view.

¢ Use the Groups tab to select groups of services.

22 Deploy Content
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Deployment Wizard

Resources Services Review Deploy
||ﬁ' Mame ~ Type
[l # UlEndpoint Other

Cancel Previous MNext

6. Click Next.
The Review page is displayed.

Deployment Wizard

Resources Services Deploy
Service Service Type Resource Name Resource Type
Ul Endpoint MW Local Basic Rule Template R5A Event Stream Analy...

Cancel Previous Deploy

Make sure that you have selected correct resources and the services on which you want to deploy
them.

7. Click Deploy.

The Deploy page is displayed. The Progress bar turns green when you have successfully deployed
the resources to the selected services.

Deploy Content 23
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8.

Deployment Wizard

Resources Services Review

Live deployment task finished successfully

Service Name Resource Name Status Progress

U Endpoint Basic Rule Template 10f1 [ y

Close

If you try to deploy resources and services that are not compatible, NetWitness displays the Errors
and Retry buttons, which you can click to review the errors and re-attempt the deployment.

Package Resources Devices Review
Deployment in progress...
Device Name Resource Name Status Progress
Log Decoder4d  Malware Domains 3of3 e ———

Click Close.

Next steps

After deploying parsers to Decoders and Log Decoders, you must enable parsers on the individual
services. For more information, see the Decoder and Log Decoder Configuration Guide.
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Manage Live Resources

With a connection to the CMS server, you can search for, subscribe to, and deploy resources from Live
in accordance with your subscription level. Once you have found resources, you deploy them to services

QA
and service groups that have been configured in the the (Admin) > Services view.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

(Optional)
Configure Feedback
& Data Sharing

Search/Download
Live Content

There are several workflows for deploying resources to services and managing those deployments. These
include:

* Subscribe and deploy resources

* Deploy a resource bundle

* Remove deployments of resources
* Download resources

e Set up data feeds

Manage Subscription and Deployment

The subscription and deployment workflow takes advantage of the resource management tools available
in Live. By subscribing to resources, you agree to receive updated resources in accordance with the

A
synchronization configured in the (Admin) > System > Live Services panel.

By adding subscribed resources to the deployments list, you configure NetWitness to automatically push
those resources to the selected services at the configured synchronization intervals. This method requires
some planning of service groups and services where resources are deployed. In addition:

* You can remove a resource from the deployments list in the Deployments Tab.

* You can unsubscribe from a resource in the Subscriptions Tab and the Live Resource View.
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To manage subscriptions and deployment:

Q
1. Inthe (Admin) > System > Live Services panel, specify an interval at which NetWitness
checks for updates to subscribed resources in Live and specify the email addresses of people to
receive an email listing subscribed resources that have been updated.

2. Inthe (Configure) > Live Content search view, search for and subscribe to Live resources.

3. Inthe (Configure) > Subscriptions > Deployments tab, select subscribed resources and add
them to the deployment list for services groups.

* to deploy the

=

4. (Optional) In the (Configure) > Subscriptions > Deployments tab, click *
resources listed in the Deployments tab immediately.

5. In the (Configure) > Subscriptions > Deployments tab, select deployed resources from a
Group, and remove them from services.

6. Inthe (Configure) > Subscriptions tab, unsubscribe from resources.

Remove a Deployed Resource

Once deployed to a service, Live resources remain on the service until removed. It is a good practice to
remove unused resources from services on which they are deployed.

To remove deployed resources:

1. Go to the Live Resource View

2. Unsubscribe from a resource, and remove it from deployed services.

Deploy a Resource Bundle

To deploy a content package, use the Resource Package Deployment Wizard. You can deploy a content
package created in Live to one or more services. NetWitness accepts packages in .nwp files or .zip files.

Download Resources

To download resources to your local file system, use the Download button in the Live Resource view.

Set Up Data Feeds

In the Live > Feeds view, you can set up and maintain Custom and Identify feeds.

26 Deploy Content



Live Services Management Guide

Search and Download Content from NetWitness XDR Cloud Services Live

Administrators can search for live content using the Search Content panel in the NetWitness XDR Cloud

Services Live, which is similar to browsing the live CMS content in the (Configure) > Live Content
page on the NetWitness Platform XDR.

Note: If Admin server is not connected to the Live Services, you can use the NetWitness XDR Cloud
Services Live to search and download the required content.

Create Live Set up Live Find/Deploy Manage Live
Account Services Live Resources Services

Search/Download ‘(Optlonal)
i Configure Feedback
Live Content

& Data Sharing

Prerequisites

e Ensure that you have created the Live account. For more information, see Create Live Account.

Quick Search for Content

You can now select and view the content based on the Sources available in the Cloud Services Live. You
can select either NetWitness or Community from the Source drop-down list.

o NetWitness: Displays all the content provided by NetWitness.

¢ Community: Displays the content collected and retrieved from third party and open source
communities.

Note: The Only Opensource option will appear under the Search Content panel only when the

community is selected as the source. You can use this option to select and search open-source
related content.

You can also quickly select and view the available content types under Content section.

Clicking ) expands the Content section and displays the following options:
o New: Displays the content which is created in the last 21 days.

* Recently Updated: Displays the content which is created or updated in the last 21 days.
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Advanced Search for Content

You can search for the specific content in the Search Content view. For more information, see Live
Search Content View.

To search the content:

1. Click B to expand the Search Content section.

2. In the Search Content, specify the search criteria. Enter any or all of these: keyword, type of
resource, medium, tag, platform versions, meta keys, meta values, date when content was created,
date when content was modified, and (optional) discontinued content.

SOURCE: Community

Only Opensource

Content

Search Content

KEYWORDS

RESOURCE TYPES

MEDIUMS

TAGS
new

PLATFORM VERSIONS
11.5.0.0

REQUIRED META KEYS

GENERATED META VALUES

CREATED DATE

2022-08-16 2022-09-06

MODIFIED DATE

~ | Include Discontinued

Reset Filter

3. Click Search.
The matching results are displayed on the right panel.
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&) Content
View New, recently updated and community content deta
Showing Filtered Content (877) Timezone : GMT+0530 Asia/Calcutta
NAME 3 CREATED * UPDATED 4 TYPE 4 MIN PLATFORM VERSION * DESCRIPTION 4 DISCONTINUED *

11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains IP Address (IPv4 and IPvé) indicators that a... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.00 This dashboard provides information on various NetWitness P... No
26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.0.0 This dashboard provides information on NetWitness Platform... No
11-Sep-202001:2... 17-Jul-2022 10:01... Feed Al Versions This feed contains Non-IP Address, text based indicators like ... No
26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.00 Amount of Incoming UDP Packets Requested by Endpoint ser... No
26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11500 Capture is not started on this Decoder service, so packet data.... No
06-Aug-2020 20:5... 13-Aug-2020 00:4... Application Rule 11.5.0.0 Ahash mismatch may indicate a file has been altered fromits o... No
23-Dec-2020 16:4... 23-Dec-2020 16:4... Log Device 11.5.0.0 Log device content for event source AWS Route53 Resolver -...
19-Mar-202119:3... 19-Mar-2021 19:3... Log Device 11500 Log device content for event source Cisco Umbrella - cisco_um...
26-Nov-2020 16:2... 26-Nov-2020 16:2... Not found 11.5.00 Reporting Engine home directory /var/netwitness/re-server/r...

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 80% of the Contexthub Server's query response cache is in use.

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.0.0 Decoder is presently not capturing data.

You can sort the content using the name, created, updated, type, or any of the column.

Note: Clicking Reset Filter removes the existing filters applied from the Search Content, and
displays all the available content on the right panel.

Download Content

You can download the content from the results displayed in NetWitness XDR Cloud Services and upload
it to NetWitness Platform XDR Live. The content is downloaded as a package (tar.gz file) that contains
tag metadata, medium metadata, contents metadata, and raw contents.

For more information, see Quick Search for Content.

Note:
- NetWitness provides no assurance related to the quality and accuracy of the content provided by the
third parties and open source communities.

To download the raw content:

1. Click the name of the content that you want to download.

The Content Details dialog is displayed.

Deploy Content 29



Live Services Management Guide

© Large files may take longer time tostart the download.

2. Click Download.

The content file is downloaded.

To download the one or more content:

1. Log in to the NetWitness XDR Cloud Services using your Live account credentials.
URL: https://live.netwitness.com/registration.

2. Select one or more content you want to download and click Generate Content Package.
A Multiple Content Download dialog is displayed.

3. Ifrequired, select the Include Dependencies checkbox to include dependencies for the selected
content. You can change the default package name as required.

4. Click Generate Package Link.
NetWitness XDR Cloud Services begins the content package (tar.gz file) creation.

Multiple Content Download

The NetWitness Live will create a content package (tar.gz file) to include your selected
content.

Alink to download the content package will be available on the Package Downloads
page. The downloaded folder includes tag metadata, medium metadata, contents
metadata, and raw contents.

Include Dependencies

PACKAGE NAME
Package Name 17-Feb-2023 13:20:37

Change the package name if required.

Generate Package Link
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5. Go to the (Package Downloads) page and click Download to download the respective
package.

NETWITNESS

Downloa

generated links. Links upto 14days from date of creation.

PACKAGE CONTENT & TOTAL CONTENT 4 size 4 EXPIRY DATE 4 CREATED * STATUS 4

package-1675665045392 2.37MB 06-Feb-2023 (in 14 days) 06-Feb-2023 12:00:46

package-1675322481017 391KB 02-Feb-2023 (in 10 days) 02-Feb-202312:51:21

17.71KB 01-Feb-2023 (in 9 days) 01-Feb-2023 17:21:32

The downloaded folder includes tag metadata, medium metadata, contents metadata, and raw
contents. You must extract (unzip) the content package, select each of the raw content files and
upload it to the appropriate devices or services on NetWitness Platform XDR.
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Additional Procedures

This topic explains the additional procedures an administrator could choose to follow which are not
essential for the configuration or use of Live Services.

e Export Data to RSA

e Packaging Resources

e Manage Custom Feeds

e Creating a Custom Feed

e Create a STIX Custom Feed

e Creating and Managing an Identity Feed

Editing a Feed

e Removing a Feed

e Miscellaneous Live Services Procedures
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Export Data to RSA

A NetWitness administrator can export the metrics in NetWitness for Live Feedback.

About Live Feedback

In the Live Services Configuration panel, there is a Live Feedback Activity Log which enables you to
download the usage data required for Live Feedback. This is active regardless of the Live
Account configuration.

If the Live Account is not configured, you can manually upload the usage data to RSA. For more
information, see the "Configure Live Services Panel" topic in the System Configuration Guide.

You must first download the Live Feedback historical data, and then upload it to share with RSA.

Download Live Feedback Historical Data

To download the Live Feedback historical data:

QA
1. Goto (Admin) > System.
2. In the options panel, select Live Services.

The Live Account screen is displayed which consists of the RSA Live Status and Download Live
Feedback Activity Log.

3. Click Live Feedback Activity Log.

The Live Feedback Activity Log window opens which allows you to download the required Live
Feedback historical data.

Live Feedback Activity Logs

Download menthly anonymized activity logs and manually upload to BSA secure portal,

For use only when live account is not configured.

Ll pate Range v Last Download Date

] 2017, June30-18

| Page |1 | of1 | | C PageSize 10 ~ Displaying 1-1 of 1

Close

4. Select one or multiple entries by selecting the checkboxes and click Download.

Note: If you select multiple entries in the history table, the Live Feedback data is downloaded into
a ZIP archive, consisting of individual JSON files for each month.

Share Telemetry Data to NetWitness

After you download the Live Feedback data, you can then upload it using the following procedure.

Deploy Content 33



Live Services Management Guide

Note:

- To download the Live Feedback data, see topic Download Live Feedback Historical Data.

- You can share data through NetWitness XDR Cloud Services Live portal. For more information,
Create Live Account.

To share the data to NetWitness

1. Log in to the NetWitness XDR Cloud Services using your Live account credentials.

2. Click on the left panel.
The Telemetry Logs dialog is displayed.

L Telemetry Logs

Upload Live Feedback Activity Logs

Click or drag-and-drop the .zip file to upload.

Note:
- You can upload only .zip files.
- Filename must be 255 characters or less and file size must be less than 128 MB.

3. Click or drag-and-drop a file onto this area to upload.

34

Deploy Content




Live Services Management Guide

Packaging Resources

The primary use for creating and subsequently deploying a resource package is for customers using an
air gap network environment. In this case, you create a resource package on the network that is
connected to the internet, and then deploy the resource package on a more secure network.

Create and Deploy Resource Package Use Case

The basic steps are as follows:
1. Access NetWitness Live Services using an instance that is connected to the internet.
2. Create a Resource package as described below, adding whichever content items you need.

3. Copy the ZIP archive of the packages to your secure NetWitness instance, by using a thumb drive or
other manual copying process.

4. On the secure NetWitness instance, deploy the resource package. For more information, see Resource
Package Deployment Wizard.

Prerequisites to Create a Resource Package

A prerequisite for creating resource packages is configuration of the connection and synchronization
between the CMS server and NetWitness and the ability to search for resources in the User Interface.

Creating a Resource Package

The following procedure describes how to create a resource package, as a ZIP archive and save it to your
local file system.

To create a resource package:

1. Goto (Configure) > Live Content from the NetWitness UL

2. Select the resources that you want to package in the Matching Resources grid.

Deploy Content 35



Live Services Management Guide

NETWITNESS

LIVE CONTENT

Search Criteria

Keywords

Category
[ FEATURED
» CJTHREAT
» CJiDENTITY
» [ ASSURANCE
» [ OPERATIONS
[JsPecTRUM

[J MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date

Resource Modified Date:

End Date

Investigate

SUBSCRIPTIONS CAPT

v

Respond Users

URE POLICIES POLICIES

Matching Resources
Show Results |

Subscribed Name

663 Matching Resources

Hosts

INCIDENT RULES

"8 Deploy

no RSA OSINT IP Threat Intel F...
1 no RSA OSINT Non-IP Threat In...
I no Powershell Runs Command...
™ no Runs ACL Management T...
¥ no AWS Security Hub Log Col...
O no NWFL_fw:outbound-networ...
[0 no 15027002 - Compliance Rep...
no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...
no RSA Certificate Manager Lo..
no Top Outbound Source IP
no Runs Chained Command S...
no Enumerates Local Groups
no SecurlD Cloud Device Regis...
no File Transport over ICMP
J no fingerprint_job
J no Cisco Ironport ESA Log Coll...
[ no HyTrust
[ no Bit9 Log Collector Configur..
no Event Viewer Executes Unc..
no Microsoft Audit Collection S...

Files

A\ Subscribe

Created

2020-09-10 7:53 PM
2020-09-10 7:53 PM
2019-04-10 2:23 PM
2019-04-10 2:29 PM
2020-07-28 6:17 PM
2012-04-23 12:09 PM
2014-06-17 2:45 PM
2018-03-27 2:01 PM
2019-04-10 1:51 PM
2013-11-22 6:35 AM
2014-07-24 10:56 AM
2019-04-10 2:30 PM
2019-04-10 2:16 PM
2019-04-17 5:54 AM
2014-07-21 5:31 PM
2013-09-12 2:24 PM
2013-11-22 6:13 AM
2014-02-14 3:34 AM
2013-11-22 6:11 AM
2019-04-10 2:17 PM

2014-02-14 3:41 AM

Dashboard

Reports

INCIDENT NOTIFICATIONS

K Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

ESA RULES

Type
Feed

Feed

Application Rule
Application Rule
Log Collector
Application Rule
NetWitness Report
Event Stream Anal...
NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector

Log Device

Log Collector
Application Rule

Log Device

3. Select some or all the resources that are listed in the Matches Resources pane.

4. Select # Package

> Create.

admin v

CUSTOM FEEDS

Description
This feed contains IP Address (IP\
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool
Log Collector configuration con
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remott
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurlC
Detects files transported over IC\
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
>

NetWitness creates a .zip archive that contains the selected resources and downloads it to your default
download folder. NetWitness gives the package a generic name. You should rename it when you save it
so that it identifies the resources contained in the package.

Creating Threat Package

The following procedure describes how to create a resource package that contains all the content that is
categorized as Threat. Then we rename it, using the type of content and date.

1. Goto

(Configure) > Live Content.

2. From the Category section, select Threat.

3. Select all items returned by clicking on the checkbox in the column header row of the Matching

Resources pane.
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
Search Criteria Matching Resources
Keywords [ Show Results = | "8 Deploy | 3 Package
S Y Created Updated Type Description
Category ¥ Local or Guest User Acco... 2022-05-27 11:28 AM 2022-05-27 11:28 AM Application Rule This rule triggers when a Local or Guest us:
[CIFEATURED ¥ Cclears Application Event...  2021-10-11 2:41 PM 2021-10-11 2:41 PM Application Rule Tampering with windows event logging car
¥ Deletes Shadow Volume ... 2021-10-11 2:40 PM 2021-10-11 2:40 PM Application Rule Deleting shadow volume copies can be an i
» [ Attack Phase ¥ Runs Regsvcs or Regasm 2022-03-08 1:40 PM 2022-03-08 1:40 PM Application Rule Regsvcs and Regasm are digitally signed W
» O Malware ¥ Enumerates Network Co...  2022-06-02 8:11 AM 2022-06-02 8:11 AM Application Rule ion of network jons can t
» CJIDENTITY ¥ Potential Abuse of Net Ut... 2022-06-02 8:12 AM 2022-06-02 8:12 AM Application Rule Net has a great deal of functionality, much
» CJASSURANCE ¥ Follina Command Executi... 2022-06-02 9:33 AM 2022-08-16 11:18 AM Application Rule This rule looks for command line argumen
» 1 OPERATIONS [¥/ Ssuspicious MSDT Parent P... 2022-08-16 7:04 PM 2022-08-16 7:04 PM Application Rule During exploitation of CVE-2022-30190 (Foll
[ SPECTRUM ¥ Changes to GPO or Group...  2022-07-28 7:54 AM 2022-07-28 7:54 AM Application Rule This rule detects when any changes are me
[T MALWARE ANALYSIS ¥ Disables Windows Defend... 2019-04-10 2:15 PM 2021-10-11 2:37 PM Application Rule Disabling windows defender using powerst
¥ Domain User Account Cre...  2022-05-27 11:29 AM 2022-05-27 11:29 AM Application Rule This rule detects when a new domain user
Resource Types =
v/ Possible Impacket Host A...  2022-03-29 7:37 PM 2022-06-21 6:19 PM Application Rule Detect possible Impacket psexec usage on
- ¥ Potential Abuse of COM ... 2022-06-09 4:49 PM 2022-06-09 4:49 PM Application Rule Adversaries may establish persistence by €
Medium ¥/ [Community] Possible Qa...  2022-03-24 5:19 PM 2022-06-29 1:54 PM Application Rule Once on a victim host, Qakbot performs se
v ¥ [Community] Nerbian RA...  2022-06-30 1:34 PM 2022-06-30 1:34 PM Application Rule Following rule helps to detect known techr
v | ¥ Unexpected fodhelper.ex...  2022-08-25 11:15 AM 2022-08-25 11:15 AM Application Rule fodhelper (Features On Demand Helper) is ¥
»
320 Matching Resources

4. Select * Package * > Create.

A ZIP archive is saved to your Downloads folder. For example,
resourceBundle8740753704980701969.zip.

5. Rename the package to something meaningful. For example, in this case, you cold change the
package name to threatResourceBundle 2018 01 31.zip (assuming today's date is January 31,
2018).

The resource package is now available for later deployment.

Deploying a Threat Package

This procedure assumes that you saved a package named threatResourceBundle 2018 01 31.zip, as
described in the previous section. It describes how to deploy a saved resource package

1. Goto . (Configure) > Live Content.

2. In the Matching Resources pane, select A Package © > Deploy.
3. Click Browse and navigate to the threatResourceBundle 2018 01_31.zip file that were created

earlier.
Resource Package Deployment
Package Resources Services Review Deploy|
Resource Bundle | threatResourceBundle_2018_01_31.zip Browse

Cancel Next

4. Click Next.
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The Resources page displays details for the resources in the package.
Click Next.
The Services page displays two tabs, Services and Groups, which provide a list of services and

A
service groups that are configured in the (Admin) > Services view. The columns are a subset of
the columns available in the Services view.

Select the services on which you want to deploy the content. You can select any combination of
services and service groups.

Deployment Wizard

Rescurces Services Review Deploy

& Name ~ Type

# UlEndpoint Other

Cancel Previous Next

Click Next.
The Review page is displayed.

Note: Make sure that you have selected correct resources and the services to which you want to
deploy them.

Click Deploy to complete the deployment process. Alternatively, you can choose Cancel or Previous
to either cancel the deployment or go back to the previous screen.
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Manage Custom Feeds

The custom feed capability is implemented using the Custom Feed Wizard in NetWitness, allowing you
to quickly populate Decoders with custom and identity feeds.

Custom Feed Creation

You can use the Live > Custom Feeds > Setup Feed > Configure a Custom Feed wizard to create and
deploy Decoder feeds based on deterministic logic that offers the meta keys specific to the selected
Decoders and Log Decoders. Although the wizard guides you through the process to create both on-
demand and recurring feeds, you should understand the form and content of a feed file when you create a
feed.

Feed file names in NetWitness are in the form <filename>. feed. To create a feed, NetWitness
requires a feed data file in .csv or .xm1 (for STIX) format and a feed definition file in . xm1 format,
which describes the structure of a feed data file. The Configure a Custom Feed wizard can create the
feed definition file based on a feed data file, or based on a feed data file and the corresponding feed
definition file.

The files that you use to create an on-demand feed must be stored on your local file system. The files
used to create a recurring feed must be stored at an accessible URL, whence NetWitness can fetch the
most current version of the file for each recurrence. After a NetWitness feed is created, you can
download the feed to your local file system, edit the feed files, and edit the NetWitness feed to use the
updated feed files.

Sample Feed Definition File

This is an example of a feed definition file named dynamic_dns.xml, which NetWitness creates based
on your entries in the Feed wizards. It defines the structure of the feed data file named dynamic_
dns.csv.

Note: The feed file path should be . csv regardless of the Feed Type (Default or STIX).

Sample Feed Definition File

<FDF xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemaLocation="feed-definitions.xsd">
<FlatFileFeed name="Dynamic DNS Domain Feed"
path="dynamic_dns.csv"
separator=","
comment="4#"

version="1">

<MetaCallback
name="alias.host"
valuetype="Text"
apptype="0"
truncdomain="true"/>

<LanguageKeys>
<LanguageKey name="threat.source" valuetype="Text" />
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<LanguageKey name="threat.category" valuetype="Text" />
<LanguageKey name="threat.desc" valuetype="Text" />
</LanguageKeys>

<Fields>
<Field index="1" type="index" key="alias.host" />
<Field index="4" type="value" key="threat.desc" />
<Field index="2" type="value" key="threat.source" />
<Field index="3" type="value" key="threat.category" />
</Fields>

</FlatFileFeed>
</FDF>

Feed Definition Equivalents for Custom Feed Wizard Parameters

The NetWitness Feeds wizard provide options to define the structure of the data feed file. These
correspond directly to attributes in the feed definition (.xml) file.

NetWitness L . .
Feed Definition File Equivalent
Parameter
Define Feed tab
Feed Type Select: Default - to define a feed based on a .csv formatted feed data file.

STIX - to define a feed based on STIX formatted .xml file.

Feed Task Type Select: Adhoc - to create an on-demand feed. Recurring - to create a feed that
recurs automatically.

Name Enter a custom feed name in the feed data file that corresponds to the
flatfeedfile name attribute in the feed definition file; for example,
Dynamic DNS Test Feed,

File/ Browse Enter a name of the feed data file that corresponds to the flatfeedfile
path attribute in the feed definition file; for example, dynamic_dns.csv,

(STIX, Recurring) Select Trust All Certificate, if you do not want to validate the REST server
Trust All Certificate ccttificate. This option is enabled by default (checked).

(STIX, Recurring) For client authentication with the REST URL, in the Certificate field, click
Browse and select the self signed certificate. The supported certificate formats

Certificate/Browse " cer, .crt with Base64 & DER encoded files.

Define Feed tab - Advanced Options
XML Feed File Enter a name of the feed definition file, for example, dynamic_dns.xml,
Separator The separator character used to separate attributes in the feed data file. It

corresponds to the £latfeedfile separator in the feed definition file; for
example, a comma.
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NetWitness

Parameter

Feed Definition File Equivalent

Comment

Remove STIX data
older than

Select Services tab

(Define Columns tab,
Define Index) Type

(Define Columns tab,
Define Index) CIDR

(Define Columns tab,

Define Index)
Service Type

(Define Columns tab,
Define Index)
Truncate Domain

(Define Columns tab,
Define Index) Ignore
Case

(Define Columns tab,
Define Index)
Callback Keys

The character used to identify a comment in the feed data file. It corresponds
to the flatfeedfile comment attribute in the feed definition file; for
example, #.

The number of days for which the STIX packages downloaded from TAXII
server have to be stored. The STIX packages older than the specified number
of days are deleted automatically. The default value is 180 days, which is also
the maximum.

Select the services to which you want to send the data feed.

The type of lookup value in the index position of the feed data file.

IP means that each row in the feed data file contains an IP address in the
lookup value position. The IP value is in dotted-decimal format (for example,
10.5.187.42).

IP Range means that each row in the feed data file contains a range of IP
addresses in the lookup value position. The IP range is in CIDR format (for
example, 192.168.2.0/24). Non IP means that the each row in the feed data file
contains a metadata value other than IP address in the lookup value position.
The Service Type and Truncate Domain, and Callback Keys fields become
active for a Non IP index.

Specifies that the IP value in the lookup position is in CIDR format. The
CIDR attribute sets the IP address format in the field to Classless Inter-
Domain Routing (CIDR) notation.

For a Non IP index, the integer service type to filter meta lookups. It
corresponds to MetaCallback apptype attribute in the feed definition file. A
value of 0 indicates no filtering by service type.

For a Non IP index, for meta values that contain domain names (for example,
hostnames), the system can strip off the host specific element in the data.
Truncate Domain corresponds to the MetaCallback truncdomain attribute. If
the value is www.example.com, it is truncated to example.com. A value of
False selects no truncation, and True selects truncation.

If this option checked, the feed will ignore the case.

For a Non IP index, the available meta keys to match on instead of ip.src/ip.dst
(the defaults for IP index type) are selectable from the drop-down list.

The Callback Key corresponds to the MetaCallback name attribute, and

the index column of the csv file must contain data that can match the chosen
meta key. For example, if the username meta key is chosen, the index column
of the csv file needs to be populated with users to be matched.
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NetWitness

Feed Definition File Equivalent

Parameter

(Define Columns tab, Identifies the column in the feed data file that provides the lookup value for the

Define Index) row. Each position in each row of the feed data file is identified by a Field

Index Column index attribute in the feed definition file. A field with an index of 1 is the first
entry in a row, the second field has an index of 2, the third field has an index
of 3, and so on. You can select multiple index columns, if the Feed Type is
STIX and Index Type is Non IP, When you select multiple index columns the
values from all the selected columns are merged in the first index column that
you selected.

(DEFINE VALUES) The name of the LanguageKey, as defined in the feed definition file, for

Key which meta is created from this row of the feed data file. It corresponds to the
Field Kkey attribute in the feed definition file. A key applies only to a field
whose type is set to value, In the feed definition file, there is a list of
LanguageKeys from index.xml, or a summary name if Source Name and
Destination Name are used. For example, reputation is a summary name for
reputation.src and reputation.dst). This value is referenced by the Field key
attribute.
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Creating a Custom Feed

This topic provides instructions for creating a custom feed using a .csv or STIX formatted feed data file
in NetWitness. For more information about STIX and creating a STIX custom feed, see Create a STIX
Custom Feed.

You can easily create a custom feed using the Custom Feed wizard. To complete this procedure, you
need a feed data file in . csvor .xm1 format. If you also have an associated feed definition file

in .xml format, which describes the structure of the feed data file, you can use the feed definition file to
create a feed. The Custom Feed wizard can create the feed based on a feed data file, or based on a feed
data file and corresponding feed definition file.

After completing this procedure, you will have created a custom feed.

The feed data file (.csv or STIX (.xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

Note: Any feeds that are created in 11.2 release or prior will be automatically pushed to Context Hub
as Lists. The lists can be looked up in the context lookup panel of the Respond and Investigate pages.
If Context Hub is not configured or the service is down, then the feeds will be pushed to Context Hub
the next time the server is available.

To create a custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.

NETWITNESS Investigate ond Users osts Dashboard Reports admin v
VE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Once - 2019-07-1313:30:36  2019-07-13 13:30:36  Completed C——

O TEST2 Once - 2018-07-1313:50:33  2019-07-13 13:50:33  Completed C——

O e Once - 2018-07-14 04:16:51  2019-07-14 04:16:51  Completed C——

O onlydom Ongce - 2019-07-14 04:21:37  2019-07-1404:21:37  Completad C—

O PCAP Once - 2019-07-14 09:30:49  2019-07-14 09:30:49  Completed C——

2. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

) Identity Feed
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3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed form open.
(Configure a Custom Feed
Define Feed Select Services Define Columns Review
Feed Type ® sy O STIX
Feed Task Type @ Adhec Recurring
Name *
Hered !
File * Select File Browse
Advanced Options
Reset Cancel Next
4. To define a feed based on a . csv formatted feed data file, select CSV in the Feed Type field.
5. To define an on-demand feed task that executes once, select Adhoc in the Feed Task Type field and
do one of the following:
a. (Conditional) To define a feed based on a .csv formatted feed data file, type the feed Name.
b. Select the checkbox Upload As CSV File Feed, if required.
c. Select a .csv content File from the local file system, and click Next.
d. (Conditional) To define a feed based on an XML feed file, select Advanced Options.
The Advanced Options are displayed:
Configure a Custom Feed
Define Feed Select Services Define Columns Review
e. Select an XML feed file from the local file system, choose the Separator (default is comma), and
specify the Comment characters used in the feed data file (default is #), and click Next.
f. The Select Services form is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
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Define Columns tab is not needed.

Configure a Custom Feed

U o
L &
O
L &
O o
O
O o
L ##
O
08
O
Yy d
L &
0 &

Reset

Define Feed

Services Groups

O i Name ~

Select Services

Address

Define Columns

Type
Decoder
Decoder
Decoder

Log Decoder
Decoder

Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Cancel

6. To define a recurring feed task that executes repeatedly at specified intervals, during a specified date

range.

a. Select Recurring in the Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure a Custom Feed

Define Feed

Feed Type @ csv

Feed Task Type O Adhoc

Name * TestFeed

Upload As Csv
File Feed -

URL*
[ Authenticated

[ Use Proxy

Recur Every [

[ Date Range
) Advanced Options
XML Feed File | Select File
Separator

Comment #

Reset

Select Services

O sTX

@ Recurring

Define Columns Review

Verify

Browse

Cancel
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b. In the URL field, enter the URL where the feed data file is located, for example,
http://<hostname>/<feeddatafile>.csv, and click Verify.

NetWitness verifies the location where the file is stored, so that NetWitness can check for the
latest file automatically before each recurrence.

c. (Optional) If the URL has restricted access and requires authentication using your username and
password, select Authenticated.

NetWitness provides your user name and password for authentication to the URL.

d. If you want the NetWitness server to access the Feed URL through a proxy, select Use Proxy.
For more information on configuring a proxy, see the Configure Proxy for NetWitness topic in
the System Configuration Guide. By default, the Use Proxy checkbox is not selected.

NOTE:
If you are using an HTTPS based feed server, ensure that you import and install the certificates.
For more information, see Import Certificates for HTTPS Service

e. To define the interval for recurrence, do one of the following:
¢ Specify the number of minutes, hours, or days between recurrences of the feed.

¢ Specify recurrence every week, and select the days of the week.

f. To define the date range for the execution of the feed to recur, specify the Start Date and time
and the End Date and time.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Feed Type ® pefault STix

Feed Task Type O Adhoc ® Recurring

Name * TestFeed

URL* https://qasa2.netwitness local/live/feeds Verify
Authenticated

Use proxy

XML Feed File Browse
Separator

Comment

Reset Ccancel Next

7. (Conditional) If you want to define a feed based on an XML feed file:
o Type the feed Name, select Advanced Options.
The Advanced Options fields are displayed.

o Select an XML feed file from the local file system, choose the Separator (default is comma),
specify the Comment characters used in the feed data file (default is #) and click Next.
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The Select Services dialog is displayed.

Configure a Custom Feed

Define Feed

O] # | Mamme
="
Og
Op
Op
=)
=]
=)
=
=
=
=
O
=
O«

Select Services

Define Columns

Type
Decoder
Decoder
Decoder
Log Decoder
Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder
Log Decoder
Decoder
Decoder

Log Decoder

Review

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. Click the Groups tab and select a group. Click Next.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:

a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Conditional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Conditional) If the index type is Non IP, additional settings are displayed. Select the service
type and Callback Keys, and optionally select the Truncate Domain and Ignore Case option.
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Configure a Custom Feed

Define Feed Select Services

Type Qe _ IP Range

Index Column 1 v Service Type 0

CallbackKey (S) |
0s

Detine Values access.point

Column accesses

Key action
SRM_Sag alert
ANcesr| alertid
| alias.host
 alias.ip
< alias.ipvé
alias.mac
asn.dst

asn.src

PR Ry

Define Columns Review

® Non IP

~

o [¥ Truncate Domain Ignore Case

]

fPE

Reset

Cancel Prev Next

d. Select the language key to apply to the data in each column from the drop-down list. The meta

displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

Configure a Custom Feed

Define Feed Select Services Define Columns Review
Define Inde
Type ow O IP Range ® Non IP
Index Column 1 v ServiceType 0 O [¥ Truncate Domain Ignore Case
Callback Key (S) action @ v
Define Values
Column 2 3 4
Key threat.source v threat.category v threat.desc
SRM_SaaS_ES MXASSETInterface AddChange EN
ANCESTOR ASSETNUM ASSETTAG ASSETTYPE
cent45 9164
cent45 9164
Reset Cancel Prev Next
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Note: When a custom feed gets converted into a context hub list, you must map at least one
meta key with one or more meta types by mapping a column header with a meta. However, you
can add or edit the entity mapping of a list by clicking ¥ in the Lists tab. For more
information, see the Context Hub Configuration Guide.

e. Click Next.
The Review dialog is displayed.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Testing

AssetsimportCompleteSample.csv
Log Decoder, Decoder

Other
action
true

0

1 2 3 4

Index threatsource threat.category threat.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form)
11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were
successful.

Note: When you create a feed, and if there is no entity mapping done such as in case of custom meta,
then those columns in the List will not have entity mappings in Context Hub. You have to manually
map the entities from the List page.

Import Certificates for HTTPS Service

Import certificates to communicate with the HTTPS services:
1. SSH to the NW node and copy the CA certificate located in the following directory:
/etc/pki/ca-trust/source/

2. Execute the following command to update the certificates:
update-ca-trust
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3. Execute the following command to add the certificate to the java keystore:
keytool -list -keystore /etc/pki/java/cacerts -storepass changeit |& head

4. Restart the service on the NW node.

Note: Perform the procedure for all the HTTPS servers.
Example: HTTPS proxy server and HTTPS feed server.
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Create a STIX Custom Feed

You can create a custom feed using a .csv or STIX formatted feed data file in NetWitness.

Note: NetWitness supports Structured Threat Information Expression (STIX) 1.0, 1.1 and 1.2 versions
only.

Structured Threat Information Expression (STIX™) is a structured language for describing cyber threat
information so it can be shared, stored, and analyzed in a consistent manner. For more information about
STIX, see https://oasis-open.github.io/cti-documentation/.

Caution: If STIX recurring feed is configured and you update Security Analytics from 10.6.x to
NetWitness 11.0, you must re-configure the STIX recurring feed.

In NetWitness Platform XDR, STIX feeds are supported. STIX content (with version 11.x) can be
uploaded in an ".xml" format. The constructs such as Indicator Title and Description, Observable Title
and Description, and Indicator Sightings information are parsed from STIX and pushed to the decoders
or log decoders that are selected during feed configuration. Information such as IP addresses, File hashes,
Domain names, URIs, and Email addresses are extracted from the STIX observable to be included in the
feed.

Make sure the following criteria are met before you upload the STIX file:
1. Only STIX Observables with property values in the "Equals" operator
2. The uploaded STIX xml file must have only one STIX Package

TAXII (Trusted Automated eXchange of Indicator Information) is the main transport mechanism for
cyber threat information represented in STIX. Using the TAXII services, organizations can share cyber
threat information in a secure and automated manner.

The STIX and TAXII communities work closely together to ensure that they continue to provide a full
stack for sharing threat intelligence.

Apart from TAXII server, STIX data can also reside on REST server and you can fetch STIX file from
the REST server by providing the URL of the REST server. For example,
http://stixrestserver.internal.com.

The feed data file (. csv or STIX (. xm1)) and optionally the feed definition file (. xm1) must be
available on the local file system for an on-demand custom feed. For a recurring custom feed, the files
must be available at a URL that is accessible to the NetWitness server.

In NetWitness Platform XDR, STIX (.xml) feed of type Indicators or Observable which contains the
properties such as the IP addresses, File hashes, Domain names, URIs and Email addresses are
supported. The properties values in the Equals operator is only supported. The STIX constructs that are
parsed are Indicator Title and Description, Observable Title and description and Indicator Sightings
information. The STIX (.xml ) with a single STIX Package is only supported.”

To create a STIX custom feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds view is displayed.
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NETWITNE vestigate Respond Users Hosts Dashboard Reports admin w
SUBSCRIPTIONS CAPTURE POLICIES NCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
+ \
O Mame Trigger Disk Usage Created Last Run Time Status Progress
O TEST Once Completed E—
O TEST2 Once Completed E—
O te Once Completed ————————
O onlydom Once Completed E—
O PCAP Once Completed E—

2. In the toolbar, click +
The Setup Feed dialog is displayed.
Setup Feed

® Custom Feed

_) Identity Feed

3. To select the feed type, click Custom Feed and Next.
The Configure a Custom Feed wizard is displayed, with the Define Feed dialog open.

Configure a Custom Feed

Define Feed Select Services Define Columns Review

Recur Every 5 ¢ Minute(s) v
[] Date Range
Advanced Options
XML Feed File  Select File Browse

Separator -~

Comment #

Reset Cancel Next

4. Enter the following details:

a. Feed Type: Select STIX, to define a feed based on a STIX formatted . xm1 file.

=3

Name: type the feed name, to define a feed based on STIX formatted . xm1 file.
¢. STIX Source:Select a STIX data source from the drop-down which is added in Context Hub.

d. Recur Every: Specify a recurring feed task that executes repeatedly at specified intervals.

Note: NetWitness verifies the connection to the server, so that NetWitness can check for the latest
file automatically before each recurrence.

e. Date Range: Select the checkbox and specify the date range for the feed task to recur.
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5. (Optional) Select Advanced Options,to define a feed based on an XML feed file.
a. XML Feed file: Browse and select an XML feed file from the local file system.
b. Separator: Choose a separator (default is comma).
c. Comment: Specify the comment characters used in the feed data file (default is #).

6. Click Next.

7. The Select Services dialog is displayed. This is an example of the form for a feed based on a feed
data file with no feed definition file. If you are defining a feed based on a feed definition file, the
Define Columns tab is not needed.

[Configure a Custom Feed

Define Feed Select Services Define Columns Review

Services Groups

¥ & Nam Addi Type

Y 4 Log Decoder
~ & Decoder

8. To identify services on which to deploy the feed, do one of the following:

a. Select one or more Decoders and Log Decoders, and click Next.

b. In case of STIX feed, Context Hub will be selected by default and you are not allowed to deselect
it. In addition, you can select one or more Decoders and Log Decoders and click Next or Click
the Groups tab and select a group. Click Next.

If the data from the STIX server is large, the following message is displayed:

Fetching sample data is taking longer than expected.
Choose one of the following options

Continue to Wait Map without Sample data

e If you click Continue to Wait, it continues to wait till the sample data is fetched or timeout
(10 minutes) whichever is sooner. In case of timeout no sample data is retrieved even after 10
minutes.

¢ If you click Map Without Sample data, the mapping column is displayed without any sample
data.

The Define Columns dialog is displayed.

9. To map columns in the Define Columns form:
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a. Define the Index type: IP, IP Range, or Non IP, and select the index column.

b. (Optional) If the index type is IP or IP Range and the IP address is in CIDR notation, select

CIDR.

c. (Optional) If the index type is Non IP, additional settings are displayed. Select the service type

and Callback Keys, and optionally select the Truncate Domain option.

Configure a Custom Feed

Column
Key

Header

Reset

Define Feed
Type ®p
Index Column(S) 10

1

Indicator Title

Some Indicator
Some Indicator
indicator-domain

Another Indicator

Select Services

Indicator Description

<p>Some Indicator</p>
<p>Some Indicator</p>
auto domain test

<p>Another Indicator...

Define Columns Review
B 4
v

Observable Title Observable Description
domain:domaint.exa.. ~ domain:domaini.exa...
domain:domain2.exa... ~ domain:domain2.exa...
domain test domain desc
domain:domain3.exa...  domain:domain3.exa...

Cancel

Prev

Next

Note:

columns.

- If the Index Type is Non IP, you can select multiple index columns in the Index Column(S).
The values from all the selected columns are merged in the first index column that you selected
and the merged values are pushed to the Log Decoder for parsing. For example, in the Index
Column(S) if you select 2,4,7 as index columns the values from the 2,4 and 7 columns are
merged in the column 2 and the values are pushed to Log Decoder for parsing.

- Indexing cannot be done for the columns such as Indicator Title, Indicator Description,
Observable Title, Observable Description, as the look up cannot be performed for those

d. Select the language key to apply to the data in each column from the drop-down list. The meta
displayed in the drop-down list is based on the meta available for the service define values. You
can also add other meta based on advanced expertise.

e. Click Next.

The Review dialog is displayed.
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Configure a Custom Feed

Define Feed Select Services Define Columns Review

FILESTIX
FILESTIX-stix.xml

PH - Decoder, LH - Log Decoder

false

10 24

Index event.desc

Reset Cancel Prev Finish

10. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your feed definition.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next dialog (if not viewing the last form).

e Click Prev to display the previous dialog (if not viewing the first form)

11. Review the feed information, and if correct, click Finish.

12. Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can
expand or collapse the entry to see how many services are included, and which services were

NETWITNESS \Z Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT  SUBSCRIPTIONS CAPTURE POLICIES NCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES
Feeds
+
Name Trigger Feed Size Created Last Run Time Status Progress
FILEHASH Fetches STIX feeds from 2020-May-19 03:16, running every 5 minutes Obytes 202005-19 03:25:23 2020-05-22 05:16:01 Completed — Eo———
FILESTIX Fetches STIX feeds from 2020-May-19 D3:32, running every 5 minutes 0bytes 202005-19 03:32:08 2020-05-22 05:12:09 Completed o
AllindieatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0bytes 202005-19 05:03:52 2020-05-22 05:13:26 Completed o
ALLIndEdited Fetches STIX feeds from 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-18 05:13:54 2020-05-22 05:13:54 Completed oeEmm————
TAXIIServer Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 202005-19 05:44:38 2020-05-22 05:14:38 Completed ~— co——

Note: Health and Wellness raises alerts when the available heap memory of Context Hub server is
critically low and the status displays as unhealthy due to low memory. For more information on how to
troubleshoot the OutOfMemoryError on the Context Hub Server, see "Troubleshooting” in the Live
Services Management Guide.
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MetaCallback Feeds using CIDR Index Range for IPv4 and IPv6

You can use CIDR index ranges for IPv4 and IPv6 in custom MetaCallback feeds. As with other custom
feeds, you must create feed data file in .csv format, and a feed definition file in .xml format.

Note: Using MetaCallback feeds with CIDR index ranges is supported only through the Advanced
Configuration wizard or the REST interface.

The following example shows the content of both a .csv file and an .xml file for a MetaCallback feed
using CIDR index ranges for [IPv4 or IPvo6.

CSV File Content

192.168.0.0/24, Sydney
192.168.1.0/24, Melbourne

XML File Content

<?xml version="1.0" encoding="UTF-8"?><FDF
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="feed-definitions.xsd">

<FlatFileFeed name="ip_ test" path="ip_test.csv" separator="," comment="#">
<MetaCallback name="DstIP" valuetype="IPv4" apptype="0" truncdomain="false">
<Meta name="ip.dst"/>

</MetaCallback>

<LanguageKeys>

<LanguageKey name="alert" valuetype="Text" />

</LanguageKeys>

<Fields>

<Field index="1" type="index" range="cidr"/>

<Field index="2" type="value" key="alert" />

</Fields>

</FlatFileFeed>

</FDF>

Note: To configure a CIDR index range for feeds with single or multiple MetaCallbacks of value type
[Pv4 or IPv6, the field of type index MUST contain a range attribute with range="cidr". Also,
configuring "cidr" index ranges for feeds with MetaCallbacks of multiple different value types is not
supported.
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Creating and Managing an Identity Feed

You can easily create an Identity feed and populate it to selected Decoders and Log Decoders. After
completing this procedure, you will have created an Identity feed.

To create an identity feed:

1. Add a destination for the feed.
4
a. Goto (Admin) > Services and in the Services.

b. In the list of services, select a Log Collector service, and select ﬁ ~ View > Config.

Select the Event Destinations tab.

d. In the Select Event Destinations field, select Identity Feed.

-+ Change Service . : Config

General Remote Collectors Files AU (-3 Event Destinations Settings

SEIE:.: EMENE ‘ Identity Feed w
Destinations

| Log Decoder
|dentity Feed  |identity Feed

+
e. Click and enter a unique name for the feed.
The Queue name identifies the feed within the Log Collector. Use the name of the feed for the
Queue.
Add Identity Feed
Name * infonetd_domain
Queue |infonetd_domain| |
Rollover Interval 3
Update Interval 1

Event Source Filter

Start Processor On 4
Service Startup

Cancel OK

f. Click OK.

2. Test generation of messages.

a. Have users log into Windows boxes on the domain to generate the appropriate log messages on
the domain controllers for testing.
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b. Verify that data is written to the feed files. SSH to the Log Decoder/Collector or Virtual Log
Collector being configured. Navigate to
/var/netwitness/logcollector/runtime/identity-feed and verify that the
Identity deploy files are getting populated with data.

[root@tps-reports identity-feed]# pwd
/var/netwitness/logcollector/runtime/identity-feed
[root@tps-reports identity-feed]# 1s -lah

total 20K

drwxr-xr-x. root root 109 Nov & 18:06 .

2
drwxr-xr-x. 8 root root 4 0K Nov 12 23:14
1

=MWN=F==r==, root root 106 Nov 13 15:24 identity.deploy.csv

. 1 root root| 408 Npv 13 15:24 identity_deploy.feed
-Mw=-r--r--, 1 root root _S9al Nov B 09:00 identity_deploy.xml
-rw-r--r--. 1 root root | 158 llov 13 15:17 identitycache.csv
[root@tps-reports identity-feed]# |

c. Open up a web browser (Non-Internet Explorer browsers preferred) and log in to the REST
interface of the Log Collector. Use administrative credentials when logging in. For example, if
the IP address of your Log Collector is 192.168.99.66, the URL would be:

* SSL not enabled: http://192.168.99.66:50101/event-processors
e SSL enabled: https://192.168.99.66:50101/event-processors

The browser screen should look like this:

800D Response 3
[al> | (2] + O 192.168.99.66:5010 ¢ | Q)
[I] & RSAT™ Wikiand eRoom ¥ RSALink ™ SA Y Personal ¥ J"—:

™)

)

The screen contains the name of the identity feed you created earlier (infonetd domain, in this
example).

For the identity feed to function correctly, port 50101 must be active on the Log Collector, and
you must determine whether SSL encryption is active.
2 -
d. Goto (Admin) > Services > <Log Collector being setup> {5 > View > Explore.

e. In the left pane, expand rest > config.

58 Deploy Content



Live Services Management Guide

& Change service | endpointloghybrid - Log Collector | Explore &
~— P ) . frest/config endpointloghybrid - Log Collector
Z endpointloghybrid - L... =
allow.missing.user.agent true
H k8l endpointloghybrid - Log Collector (LOG_C... .
allow.websockets false
B[ Jconnections ;
enabled 1
B[ deviczappliance port s0101
B[] event-broker - off

B[] event-processors useragentwhiteliss

B[] logcollection

B[ Jlogs

B rest
[Jeenfig
[ stats

B[] sdk

For REST to be active, enabled must be set to 1.

f. Note the value for ssl. If SSL should be enabled for your environment, this must be set to on.

Note: If you changed the setting for either the enabled or ssl option you must restart the Log
Collector service before moving forward.

3. Goto (Configure) > Custom Feeds.
The Feeds dialog is displayed.

NETWITNESS Investigate R d Users Hosts Files )as rC Reports admin v
VE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIOMNS SA RULES CUSTOM FEEDS

+ |

O Mame Trigger Disk Usage Created Last Run Time Status Progress

O TEST Ongce Completed O

O TEST2 Ongce Completed O

O = Crice Completad e

O Ongce Completed C—

O Ongce Completed C—

4. In the toolbar, click +
The Setup Feed dialog is displayed.

Setup Feed

Custom Feed

(@) Identity Feed

Cancel

5. Make sure Identity Feed is sclected and click Next.

Deploy Content 59



Live Services Management Guide

The Configure Identity Feed panel opens with the Define Feed tab displayed.

6. (Conditional) You can create an on-demand or recurring feed.

¢ To define an on-demand Identity feed task that executes once, select Adhoc in the Feed Task

Type field, type the feed Name, and browse for and open the feed.

o To define a recurring Identity Feed task that executes on a recurring basis, select Recurring in the

Feed Task Type field.

The Define Feed dialog includes the fields for a recurring feed.

Configure Identity Feed

Select Services Review

Define Feed

Feed Task Type Adhoc @® Recurring

Name *

[ Authenticated  User Name admin Password esessssses

[ Use proxy
Recur Every 5 & Minute(s)

Date Range

Start Date 2015-12-1419:10:25 (i End Date  2025-12-1413:11:27

Reset Cancel

URL * >r name]?msg=getfile&force-content-type=application/octet-stream&expiry=600 || Verify

Note: NetWitness verifies the location where the file is stored, so that NetWitness can check for
the latest file automatically before each recurrence.

7. Enter a value and verify the URL field.

a. In the URL field, enter the URL where the feed data file is located. This is the REST API
interface that was setup earlier. Make sure you have the following information to construct the

URL:

e The IP address of the Log Collector being used to construct the Identity Feed file.

¢ The identity queue name, as set in step 2c.

e Whether or not SSL is enabled on the Log Collector REST port, as set in step 2f.

You can construct this value as follows:

e SSL enabled: https://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

e SSL not enabled: http://<LogCollector>:50101/event-processors/<ID Event
processor name>?mnsg=getFile&force-content-type=application/octet-

stream&expiry=600

So, using the example from earlier, the complete value that you would enter into this field is as

follows:

http://192.168.99.66:50101/event-processors/infonetd
domain?msg=getFile&force-content-type=application/octet-

stream&expiry=600?msg=getFile&force-content-type=application/octet-

stream&expiry=600
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b. For the URL verification to work correctly, it is important that the NetWitness Ul server can
access the Log Collector’s REST API port (50101). This can be tested by going to the
NetWitness Ul server via SSH. Once there, run the following command:

e SSL enabled: curl -vk https://<ip of log collector>:50101

¢ SSL not enabled: curl -v http://<ip of log collector>:50101

If the curl command does not connect then there may be a network firewall or routing issue
between the NetWitness Ul server and the Log Collector.

Example of a bad connection:

* About to connect() to 192.168.99.66 port 50105 (#0)
* Trying 192.168.99.66... No route to host

* couldn't connect to host

* Closing connection #0

curl: (7) couldn't connect to host

Example of a good connection:

About to connect () to 192.168.99.66 port 50105 (#0)

Trying 192.168.99.66... connected

Connected to 192.168.99.66 (192.168.99.66) port 50105 (#0)

GET / HTTP/1.1

User-Agent: curl/7.19.7 (x86 64-redhat-linux-gnu) libcurl/7.19.7
SS/3.19.1 Basic ECC zlib/1.2.3 1libidn/1.18 libssh2/1.4.2

Host: 192.168.99.66:50105

Accept: */*

HTTP/1.1 401 Unauthorized

Content-Length: 71

Connection: Keep-Alive

Pragma: no-cache

Expires: -1

Cache-Control: no-cache, no-store, must-revalidate
WWW-Authenticate: Basic realm="NetWitness"

*
*
*
>
>
N
>
>
>
<
<
<
<
<
<
<
< Content-Type: text/xml; charset=utf-8

<

<?xml version="1.0" encoding="utf-8"?>

<error>401 Unauthorized</error>

* Connection #0 to host 192.168.99.66 left intact
* Closing connection #0

8. The REST API requires a username and password when attempting to pull the identity
deploy.csv file from the Log Collector. This can be any username and password that is available
on the service itself. For more information, see the "Services Security View" topic in the Hosts and
Services Guide.

Q
To see which accounts are available, go to (Admin) > Services > <log collector being setup>
> Actions > View > Security.

Under the Users table, you see all the users that can be used in this step. It is suggested that a
separate user account is created specifically for this setup, and is used nowhere else in the
environment, for added security. For details, see "Add a User and Assign a Role" in the System
Security and User Management Guide. (Go to the NetWitness All Versions Documents page and find
NetWitness Platform guides to troubleshoot issues.)

9. To define the recurrence interval, do one of the following:
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10.

11.

12.

13.

14.

¢ Specify the number of minutes, hours, or days between recurrences of the feed.
¢ Enter the date range for the execution of the feed to recur, specify the Start Date and time and the
End Date and time.

If using SSL encryption, you need to install the REST API SSL certificate for the Log Collector into
the NetWitness Ul server. For more information, see Import the SSL Certificate.

If, after importing the SSL certificate, the verification of the URL still fails, see Cannot Verify
Identity Feed URL.

Click Verify to verify your identity feed configuration before you proceed to the Select Services
dialog.

Click Next.

The Select Services dialog is displayed.

Configure Identity Feed

Define Feed Celect Services Review
L ﬁ( Name ~ Address Type
O & ' Decoder Decoder
] 55( Log Decoder Log Decoder
Reset Cancel Prev Mext

To identify services on which to deploy the feed, select one or more Decoders and Log Decoders
and click Next.

Click the Groups tab, select a group, and click Next.
The Review dialog is displayed.

62
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Configure Identity Feed

Define Feed Select Services
eed Details
Mame Testing
Feed File zip sample.zip
Service Details
Sery Decoder

Cancel

Note: If a group of devices with Decoders and Log Decoders is used to create recurring or custom
feeds and this group is deleted, you can edit the feed and add a new group to the feed.

15. Anytime before you click Finish, you can:
¢ Click Cancel to close the wizard without saving your feed definition.
¢ Click Reset to clear the data in the wizard.
¢ Click Next to display the next form (if not viewing the last form).
¢ Click Prev to display the previous form (if not viewing the first form).
16. Review the feed information, and if correct, click Finish.

Upon successful creation of the feed definition file, the Create Feed wizard closes, and the feed and
corresponding token file are listed in the Feed grid and progress bar tracks completion. You can expand
or collapse the entry to see how many services are included, and which services were successful.

NETWITNESS v nd Hosts Files Dashboard Reports

admin w

LIVE CONTENT SUBSCRIPTIONS ES INCIDENT RULES INCIDENT NOTIFIC

Feeds

+

0 Name Trigger Feed Size Created Last Run Time Status Progress
B FILEHASH Fetches STIX feeds from 2020-May-19 03:16, running every 5 minutes 0 bytes 2020-05-19 03:25:23 2020-05-22 05:16:01 Completed CEE—
B FILESTIX Fetches STIX feeds from 2020-May-19 03:32, running every 5 minutes 0 bytes 2020-05-15 03:32:08 2020-05-22 05:12:08 Completed e
B AllindicatorsREST Fetches STIX feeds from 2020-May-19 04:48, running every 5 minutes 0 bytes 2020-05-19 05:03:52 2020-05-22 05:13:26 Completed e
B AlLindEdited Fetches STIX feeds fram 2020-May-19 05:13, running every 5 minutes 0 bytes 2020-05-19 0511354 2020-05-22 0511354 Completed C——
B TAXIIServert Fetches STIX feeds from 2020-May-19 05:44, running every 5 minutes 288 bytes 2020-05-19 05:44:38 2020-05-22 05:14:38 Completed aEmmm———
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Import the SSL Certificate

If SSL is configured on the Identity feed’s Log Collector, follow these steps to import the Log
Collector’s SSL certificate into the NetWitness Ul server key store. If this certificate is not imported, the
NetWitness Ul server will be unable to pull the Identify feed file from the Log Collector.

1. To pull the SSL certificate off the Log Collector, SSH into the NetWitness Ul server and run the
following command:

echo -n | openssl s client -connect <HOST>:<PORT> | sed -ne '/-BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p' > /tmp/<SERVERNAME>.cert

This command saves the SSL certificate to /tmp/<SERVERNAME>. cert. For example:

echo -n | openssl s client -connect 192.168.99.66:50101 | sed -ne '/-BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p' > /tmp/logcollector.cert

2. To import the SSL certificate into the NetWitness Ul server, SSH into the UI server and run the
following command:

keytool -importcert -alias <name an alias for the cert> -file <the cert
file pathname> -keystore /etc/pki/java/cacerts

For example:

keytool -importcert -alias logcollector0l -file /tmp/logcollector.cert -
keystore /etc/pki/java/cacerts

3. The system requests a password. Enter the password for the keystore on the NetWitness Ul server,
not for the jetty keystore. The default password is changeit.

4. Restart jettysrv to allow jetty to read the new certificate in the store.
Cannot Verify Identity Feed URL

If the Identity feed URL cannot be verified, and you are using SSL, make sure you followed the steps in
Import the SSL Certificate.

If there are issues, it is possible that the internal name of the certificate does not match the hostname of
the Log Collector. The following procedure checks this.

1. SSH to the NetWitness Ul server.

2. Run the following command to output the CN name of the SSL cert:

echo -n | openssl s client -connect <log decoder>:50101 | sed -ne '/BEGIN
CERTIFICATE-/, /-END CERTIFICATE—/p'

For example:

echo -n | openssl s client -connect salogdecoder01:50101 | sed -ne '/BEGIN
CERTIFICATE-/, /-END CERTIFICATE-/p'

3. Retrieve the CN name of the SSL certificate.
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4. Edit the /etc/hosts file and add the IP address and CN name to the file.

5. Restart the network service on the appliance.

6. Confirm that the name placed in the /etc/hosts file is used instead of the FQDN or IP address in the
Identity feed URL.

7. Re-verify the Identity feed URL.
Investigating an Identity Feed
An identity feed tracks interactive log on events from the Windows operating system. Identity feeds do

not track interactive log off events.

In order for an identity feed to process events and tag them, the events need to be collected using
a Windows Log Collection module where an Active Domain Controller or non-Domain Controller is
configured. Note that identity feeds can only be processed via an Identity Feed Event Processor.

Note: An identity feed only tracks one log in at a time. If two users log in to a system at the same
time, the second user will overwrite the first user's data in the identity feed.

Once you have created an identity feed, you can view the results by investigating the feed.

To investigate a configured identity feed:

1. Go to Investigate > Navigate.

If no default service is selected, the Investigate dialog is displayed.

Investigate

Services Collections

M Default Service

Name ~ Address Type

Eroker 10.31.125.243 Eroker
Broker 10.31.125.245 Broker
Broker 10.31.125.240 Broker
Cancentrater (Default) 10.31.125.244 Cancentratcr
Decoder 10.31.125.245 Decoder

Log Decoder 10.31.125.246 Log Decoder

Cancel Mavigate
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2. Select a service, usually a Concentrator, and click Navigate.

3. Select Load Values to retrieve meta data.

In the Values panel, scroll down to find the Meta Keys:

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin w
NAVIGATE  EVENTS WARE ANA

& endpointloghybrid - Concentrator ¥ Query @ [ Profile @ {]Meta @ | ETotal ® (= Descending @ &§ Event Count @ | Save Events

08 . . 07 50 . Q

2012 | 37 | 15:35:00 (+00:00) All Data 2017 | 49 | 14:50:59 (+00:00) =

el

>

pat

—

o

Q

=~

[

o

£ Options | Hide

) R

.. Decoder Source (2 v

!
nwappliance23912 (100,000 - 5%) - nwappliance11639 (182)
@« Alerts (131 L
test dom (=100, 5%) - gw match (>100,000 - 38%) - ipv4 horizontal port scan 5 (6,458) - tele test (5,773) - address : 161.253.11.233 (4,948) - ip alert for 29.1 (3,581) - sky
test (3,095) - ipv4 potential web sweep 10(2,280) - ipv4 vertical tcp port scan 5 (2,204) - ipvd vertical udp port scan 5(210) - ipv4 bulk data transfer 20 mb (76) - ipsrc test 176 (37)
- ipv4 bulk data transfer S0 mb (17)
Risk: Informational (20 of 20+ values) 2
'y
http1.1 without referer header (67.513) - unknown service over http port (51.581) - unknown service over smtp port (43,798) - http1.1 without server header (39,937) - http1.0

unsupported cache header (34,360) - http1.0 unsupported connection header (32.546) - http1.0 unsupported host header (21,538) - http1.1 server location redirect (21,090) - only
ack flag in session (18,655) - unknown service over ssl port (15,679) - http1.0 without server header (12,163) - http over non-standard port (11.872) - http1.1 without accept

_httn1 N uncuinnarted etag headar (£ GG7) _ httn1 1 withaut cannactinn

header 11 129 _httn1 1 hich headar ranunt (10 @A _ httn1 Dwithaut refarar headar (7 SNAY

The identity feed provides information to selected Decoders and Log Decoders. It associates the Host IP
data from the Windows operating system to the user logging into that Host in order to tag all logs

associated with that IP and investigate.
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Editing a Feed

This topic provides instructions for editing a custom feed using the Custom Feed Wizard.

After you edit a feed:

* The feed (.zip format) or the file used to create the feed (.csv or .xml) has been downloaded and
edited.

e The feed has been recreated with the updated file and new feed specifications.

To edit an existing feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS Investigate R d Users Hosts Files )as rC Reports admin v
OMTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS SA RULES CUSTOM FEEDS
+ |
O Mame Trigger Disk Usage Created Last Run Time Status Progress
O TEST Crice Completad e
O TEST2 Crice Completad e
O = Crice Completad e
O onlydom Crice Completad e
O PCAP Crice Completad e

4

2. In the toolbar, select a feed and click =,

The Configure Custom Feed or Configure Identity Feed panel opens in the Custom Feed wizard.

Configure a Custom Feed

Define Feed Select Services Define Columns

Feed Type C5v = STIX
Feed Task Type @ Adhoc _} Regurring
W ame * TEST

Upload &s Csw

File Feed
File * TEST-2tix. xrm Browse
download file
\dvanced Options
Reset Cancel Mext
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3. If you want to edit the feed file:
a. Click download file.

For an Identity feed, the .zip file is downloaded. For a custom feed, the .csv or .xml file is
downloaded to your local file system.

b. Edit and save the file.
c. In the Define Feed tab, browse for and open the edited file.

4. Edit any other parameters in the Define Feed tab, Select Services tab, and Define Columns tab that
apply to the type of feed.

5. Anytime before you click Finish, you can:

¢ Click Cancel to close the wizard without saving your changes.

¢ Click Reset to clear the data in the wizard.

¢ Click Next to display the next form (if not viewing the last form).

e Click Prev to display the previous dialog (if not viewing the first form).
6. In the Review tab, review the feed information, and if correct, click Finish.

The feed is added to the feeds list and progress bar tracks completion. Upon successful creation of the
feed definition file, the Create Feed wizard closes, and the feed and corresponding token file is listed in
the Feeds list. You can expand or collapse the entry to see how many services are included, and which
services are successful.
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Removing a Feed

This topic provides instructions for removing a feed. You might want to remove a feed when some or all
of the information in the feed is no longer useful for your organization.

To remove a feed:

1. Goto (Configure) > CUSTOM FEEDS.
The Custom Feeds dialog is displayed.

NETWITNESS Investigate Respond Users Hosts iles Dashboard Reports

admin v
VE CONTENT SUBSCRIPTIONS CAPTURE POLICIES INCIDENT RULES NCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS
+ |
O Mame Trigger Disk Usage Created Last Run Time Status Progress
O TEST Once - 2019-07-1313:30:36  2019-07-13 13:30:36  Completed C——
O TEST2 Once - 2018-07-1313:50:33  2019-07-13 13:50:33  Completed C——
O e Once - 2019-07-14 04:16:531  2019-07-14 04:1€:51  Completed C——
O onlydom Ongce - 2019-07-14 04:21:37  2019-07-1404:21:37  Completad C—
O PCAP Once - 2019-07-14 09:30:4%  2019-07-14 02:30:49  Completed C——

2. In the toolbar, select a feed and click ~— .

The Delete Custom Feeds dialog is displayed.
Delete Custom Feeds

Local DB and Service

® Local DB Only

Service Only

Cancel Delete

You can select one of the following options to delete the feed:

¢ If you choose to delete the feed from Local DB and Service, the feed is deleted from both
the service and the local NetWitness box. The deleted feed will no longer seen on
the NetWitness user interface.

¢ If you choose to delete the feed from Local DB Only, the feed is deleted from the local
NetWitness box. The deleted feed will not be seen on the NetWitness user interface; however, the

last deployed version of the feeds will be present on the service. The undeployed feeds will be
deleted forever.

o If you choose to delete the feed from Service Only, the feed is deleted from the service. The
deleted feed will appear on the NetWitness user interface and can be deployed again
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3. Select which feed you want to delete and click Delete.
A warning dialog is displayed.

4. Click yes to confirm that you want to delete the feed from the selected areas.

Delete Custom Feeds

Service Status Progress

Decoder FAILURE
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Subscribing to Live Resources

This section describes subscriptions in Live.

Threats and the corporate landscape change over time. NetWitness periodically reviews existing content
to determine whether it needs to be updated based upon current campaigns, or has become irrelevant due
to changes in technology or attack techniques and tools.

You can discover new content by using the What’s New dashlet within the Default Dashboard, or by
searching through NetWitness Live by data range since last deployed. Be sure to subscribe to any content
for which you want to receive update notifications.

Subscription Updates

When you view resources in the Matching Resources panel of the Live Content view, there is a column
named Updated:

Matching Resources

= Show Results | | % Package
Subscribed | Wame Created Updated Type Description
na Advanced Windows Execut..  2012-02-09 4:50 PM 2014-03-20 353 FM FlexParser Legacy: Intenc
no Fingerprint Windows M5l 2012-02-09 4:51 FM 2012-02-09 4:51 FM FlexParser Legacy: Intenc
no Microsoft Windows 2018-03-27 148 FM 2018-03-27 147 FM Log Device Log device cor
yes windows_executable 2013-10-18 1:53 FM 2017-11-13 235 FM Lua Farser dentifies winc
no Windows Cormnmand Shell 2012-02-09 4:51 FM 2013-08-27 7:08 AM FlexParser Legacy: Intenc
yes Lateral Movernent Indicato...  2018-03-09 12:34 AM 2018-07-31 7539 FM Met\Witness Report Report display
yes windows_command_shell_|... 20161114 6:40 PM Lua Parser dentifies Micr
yes Windows Credential Harves._.. 2016-03-09 12:54 AM NerwWitness Rule This rule moni
o Windows Process Parent C.. 2018-05-11 734 FM MetWitness Rule There are sets
yes Windows NTLM Newwork La...  2016-03-09 12:54 AM 2016-03-09 12:54 AM NerWitness Rule ndicates a po
no Autoruns and Scheduled Ta...  2018-05-11 733 FPM 2018-05-11 7:33 FM NerwWitness Rule Attackers will
no Windows Events (ER) 2014-02-14 354 AM 2018-03-27 830 AM Log Device Log device cor
na Windows Events (NIC) 2014-02-14 3:55 AM 2018-09-0312:11 PM Log Device Log device cor _

E 4
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This value is also displayed when you select the detailed view for a resource. Every time a resource
changes, its Updated value changes to match the specific update. If you are subscribed to a resource, and
it gets updated, your system is automatically updated with the latest version, and you receive a

notification. You can view your notifications by clicking the Notification icon, 8 from anywhere in
the NetWitness Ul
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SUBSCRIPTIONS

LIVE CONTENT

Ve

NETWITNESS Inv

CAPTURE POLICIES

INCIDENT RULES

igate Respond Users Hosts Dashboard Reports

INCIDENT NOTIFICATIONS  [Notifications

Service Added

viatchin Test - Log Collector service has been added to Test 1 hour
== Show Resulis 3 kage
Keywords B Show Resulis @ | | % Package Entitlement Expiration
Subscribed | Name Created Updated D 11 hours
Category o 2017-11-21 715 PM
[Treaturen o 201805
» CITHREAT yes 201512~
45 DENTITY no Wuitiple Login Failures Due... 2016 View All
Authentication no Multiple Failed Logins to 5 2016 £V
Authorization no WM Clone After Muitiple Ro. 201812, Eu 104 or higher_ Alert if there
Accounting 0 W 2016 Ewt Detects 4 failed login attemp
¥ [ ASSURANCE no Remaote Data Harvesting 2016 Ew Detects a successful Juniper
ASSURAN
b [ OPERATIONS yes ountlogon-failure 20714-08-1 Application Rule NWFL App Rule to support I
OPERA s
[ sPECTRUM yes ountlogin-and-lo... 2014-08-1 Application Rule NWFL App Rule to support I
SPE M
yes ountlogon-success 2014-08-1 Application Rule NWFL App Rule to support I
[ MALWARE ANALYSIS - =
yes ountlogout 2014-08-1 Application Rule NWFL App Rule to support It
Resource Types . R I _ ~
no Malicious Account Crestion...  2014-02 201612 3 Event Stream Anal...
no NTLMSSP_lua 2013-09-16 3:086 AM 2015-05-30 5:06 &AM Lua Parser
3
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You can also get email notifications when subscribed resources are updated. System Administrators can

a
add email addresses in the (Admin) > SYSTEM > Live Services view. For more information, see
the "Live Services Configuration Panel" topic in the System Configuration Guide.

Adding Subscribed Resources for Deployment to Services

—

Go to (Configure) > Subscriptions > Deployments.

2. In the Groups panel, select a group.
Subscribed resources, if any, are listed in the Deployments tab Subscriptions panel.

3. In the Subscriptions panel, click +
The Add Subscription dialog, which lists subscriptions available for deployment, is displayed.

4. Select the subscribed resources that you want to deploy to the services group.
Click Save.

The dialog closes and the subscriptions are added to the listing in the Deployments tab, Subscriptions
panel. This stages the resources for deployment at the next synchronization.

6. You can click the Synchronize icon, B, , to immediately synchronize your changes.

Deleting a Subscription

When you delete a subscription to a resource, deployed instances of the resource are not deleted. The
deployed resource remains on services until explicitly removed, but the resource is no longer
synchronized with the resource in NetWitness Live.
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To delete a subscription:

. Goto (Configure) > Subscriptions.

In the Subscriptions tab, select the subscriptions you want to delete.

Click =, then choose Delete to delete your selected resources or Delete All delete all subscriptions.
A dialog asks for confirmation that you want to delete the subscription.
To confirm removal, click Yes.

Your selected subscriptions are deleted from the subscriptions list, but any deployed instances of the
subscribed resource remain on the services.

Removing Subscribed Resources from the Deployments Subscriptions Grid

Subscriptions that are selected for deployment to a service group are deployed during synchronization.

You can remove subscriptions from the Live (Configure) > Subscriptions > Deployments panel, but
any that have actually been deployed to services remain deployed until someone removes them.

To remove resources from the Deployments tab Subscriptions panel:

1.
2.

Go to (Configure) > Subscriptions > Deployments

In the Groups panel, select a group.

Subscribed resources, if any, are listed in the Subscriptions panel.
In the Subscriptions panel, click =.

A dialog requests confirmation that you want to delete the resource from the service group. The
resource is removed from the Deployments tab Subscriptions panel, but is not removed from services
on which it is deployed.

Subscribe and Unsubscribe to a Resource

When you subscribe to resources, you will receive notification when new versions of the resources are
available.

To subscribe to a resource:

—_

. Goto (Configure) > Live Content.

In the Search Criteria panel, specify search criteria and click Search.

Select one or more resources and click ™ Subscribe |

A confirmation dialog is displayed: By subscribing to these resources, you are indicating that you
wish to receive notification when new versions are available.

To confirm that you want to subscribe to the resource, click OK.

The resource is added to the subscriptions managed in the Subscriptions tab and is available for
deployment in the Deployments tab.
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When unsubscribing from a resource, you have the option to leave the resource on services on which it is
deployed or to remove it from services.

To unsubscribe from a resource:

1. Open a detailed view of a resource in one of the following ways:

Perform a search, - (Configure) > Live Content > enter search criteria, then select the
resource in the Matching Resources panel, then click =/ Details

View subscriptions, (Configure) > Subscriptions, select the resource from the Subscriptions
list, then click =/ Details

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

3. Download A\ Subscribe B, Deploy

AWS Security Hub Log Collector Configuration

type Log Collector
2020-07-28 6:17 PM
dated 2020-07-29 7:52 AM
Log Collector configuration content for event source AWS Security Hub

1.2

2. With the detailed view of a resource displayed. click % Unsubscribe .

A confirmation dialog is displayed.
Unsubscribe Resource?

You will no longer be notified of new updates to this
resource.

Resource will still be installed unless you manually remove it.

Cancel Unsubscribe Unsubscribe and Remove

3. Do one of the following:

¢ To confirm that you want to unsubscribe from the resource and leave it on the services where it is
deployed, click Unsubscribe.

¢ To confirm that you want to unsubscribe from the resource and remove it from the services where
it is deployed, click Unsubscribe and Remove from Services.

e To close the dialog without unsubscribing, click Cancel.

The selected action is applied.
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Viewing Subscribed Resources Selected to Deploy on Services

In the (Configure) > Subscriptions > Deployments tab you can view subscribed resources that
have been selected for deployment on services.

To view subscribed resources that have been selected for deployment on services:

In the Groups panel, select a group, and expand it to view services in the group. The resource
subscriptions selected for deployment are listed in the Deployments tab Subscriptions panel.
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Miscellaneous Live Services Procedures

This section describes several other procedures.

Displaying Resource Details in Live Resource View

After you select a resource (in the Live Resource View), you can view its detailed information.

To open a separate tab in the Live Resource view with details of a selected resource, do one of the

following:

o If you are viewing the results in Show Results > Detailed view, click the resource type icon or the

resource name.

NETWITNESS

LIVE CONTENT SUBSCRIPTIONS

Search Criteria

Keywords

Category

[ FEATURED

Investigate

Respond Users

CAPTURE POLICIES POLICIES

Matching Resources

&5 Show Results |

Hosts Files

INCIDENT RULES

Dashboard Reports

INCIDENT NOTIFICATIONS

» CITHREAT

» CJiDENTITY

» CJASSURANCE

» [JOPERATIONS
[JspPeEcTRUM

[ MALWARE ANALYS|

Resource Types

Malware Rules @

Medium

Required Meta Keys

Log Collector @ v

IS

| 3 Package
==y RSA Malware PE Artifacts
' pe Malware Rules updated 2018-05-04 11:11 PM sion 0.2 size 74.5 KB subs
Yara 10Cs which statically analyze Windows PE file artifacts for signs of malware.
RSA Malware PE Packers
e Malware Rules updated 2013-11-21 9:07 PM version 0.1 ©93.97 KB s
Yara 10Cs which statically analyze Windows PE files to identify Common Packers
RSA Malware PDF Artifacts
pe Malware Rules lated 2013-11-21 9:07 PM sion 0.1 size 587 B subsc no
Yara I0Cs which statically analyze PDF file artifacts for signs of malware
McKesson HPF Log Collector Configuration
e Log Collector 2d 2017-09-13 5:09 PM version 0.2 size 1.42 KB, no
Log Collector configuration content for event source McKesson HPF
@ event analysis, operations, log analysis
SAP ERP Central Component Log Collector Configuration
pe Log Collector updated 2017-09-13 5:10 PM on 0.2 size 1.24 KB subs no

Log Collector configuration content for event source SAP ERP Central Component
™ auan + analucic Anara tianc Ing anal hicie

191 Matching Resources

ESA RULES

admin v

CUSTOM FEEDS LOG PARSER RULES

o If you are viewing the results in Show Results > Grid view, double-click a resource or select a
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resource and click Details.

NETWITNESS

LIVE CONTENT

Investigate

IPTIONS

CAPTURE POLICIES

Respo Users

POLICIES

Hosts

INCIDENT RULES

Files Dashboard Reports

INCIDENT NOTIFICATIO

ESA RULES

CUSTOM FEEDS

Search Criteria

Keywords

Category
["J FEATURED
» [ THREAT
» CJIDENTITY
» [JASSURANCE
» [ OPERATIONS
[JsPecTRUM

[ MALWARE ANALYSIS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date End Date

Resource Modified Date:

Downloading a Resource

Matching Resources

[E5] Show Results |

Subscribed Name

[ no RSA OSINT IP Threat Intel F...

[0 no RSA OSINT Non-IP Threat In..

0 no Powershell Runs Command...

I no Runs ACL Management Tool
no AWS Security Hub Log Colle...
no NWFL_fw:outbound-networ...

[ no 15027002 - Compliance Rep..
no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...

[ no RSA Certificate Manager Lo...

[ no Top Outbound Source IP

[ no Runs Chained Command s...
no Enumerates Local Groups

[ no SecurlD Cloud Device Regis...
no File Transport over ICMP

[ no fingerprint_job

0 no Cisco Ironport ESA Log Coll...
no HyTrust
no Bit9 Log Collector Configur...

[ no Event Viewer Executes Unc...
no Microsoft Audit Collection S...

663 Matching Resources

| 3§ Package

Created Updated

2020-09-10 7:53 PM 2022-09-06 4:30 AM
2020-09-10 7:53 PM 2022-09-06 4:30 AM
2019-04-10 2:23 PM 2020-01-23 4:21 PM
2019-04-10 2:29 PM 2019-04-10 3:09 PM
2020-07-28 6:17 PM 2020-07-29 7:52 AM
2012-04-23 12:09 PM 2017-11-11 3:37 AM
2014-06-17 2:45 PM 2017-09-23 5:41 AM
2018-03-27 2:01 PM 2018-07-24 5:31 PM
2019-04-10 1:51 PM 2019-04-10 2:02 PM
2013-11-22 6:35 AM 2017-09-13 11:40 AM
2014-07-24 10:56 AM 2017-09-23 5:49 AM
2019-04-10 2:30 PM 2019-04-10 3:10 PM
2019-04-10 2:16 PM 2019-04-10 3:06 PM
2019-04-17 5:54 AM 2019-04-17 5:56 AM
2014-07-21 5:31 PM 2017-11-11 3:37 AM
2013-09-12 2:24 PM 2017-09-23 5:37 AM
2013-11-22 6:13 AM 2017-09-13 11:37 AM
2014-02-14 3:34 AM 2017-09-13 11:07 AM
2013-11-226:11 AM 2017-09-13 11:37 AM
2019-04-10 2:17 PM 2019-04-10 3:07 PM

2014-02-14 3:41 AM 2020-05-04 2:06 PM

You can download a single resource from the Live Resource View.

To download a resource:

1. Goto

(Configure) > Live Content.

Type
Feed

Feed
Application Rule
Application Rule
Log Collector
Application Rule

NetWitness Report

Event Stream Anal...

NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector
Log Device

Log Collector
Application Rule

Log Device

Description

This feed contains IP Address (IP\v
This feed contains Non-IP Addres
Powershell running command pr
Running ACL management tool c:
Log Collector configuration conte
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associe
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurlC
Detects files transported over ICA
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
>

2. In the Search Criteria panel, enter the criteria needed to return the resource you want to download.

3. Select a single resource, then click =/ Details

4. Click .L Download

The resource is saved as a ZIP archive to your local Downloads folder.

Locating and Removing a Deployed Resource from Services

You can locate and remove a deployed resource from services from the Live Resource View.

To view a list of services on which a resource is deployed:

1. With a resource displayed in the Resource View, click @ Service Locator -

The Service Locator dialog is displayed.
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= Remaove

Services
O ;S{ Name ~
O

Type

ppliance19848 - Log Decoder Log Decoder

Cancel

2. Select one or more services in the Services list.
3. Click =.

The resource is removed from the selected services.

Showing Results as a List or in Detail

1. Select Show Results > Grid to change to grid results when viewing detailed results.

NETWITNESS (VET Hosts Files Dashboard admin v

Investigate

Respond Reports

LIVE CONTENT SUBSCRIPTIONS

Search Criteria

Required Meta Keys

CAPTURE POLICIES

POLICIES

Matching Resources

File Transport over ICMP

663 Matching Resources

INCIDENT RULES

2014-07-21 5:31 PM

INCIDENT NOTIFICATIONS

2017-11-11 3:37 AM

ESA RULES

Application Rule

CUSTOM FEEDS

Keywords Show Results = | | 3 Package
] subscribed Name Created Updated Type Description
Category L) no RSA OSINT IP Threat Intel F...  2020-09-10 7:53 PM 2022-09-06 4:30 AM Feed This feed contains IP Address (IP\
[ FEATURED no RSA OSINT Non-IP Threat In...  2020-09-10 7:53 PM 2022-09-06 4:30 AM Feed This feed contains Non-IP Addres’
» [ THREAT Ll no Powershell Runs Command...  2019-04-10 2:23 PM 2020-01-23 4:21 PM Application Rule Powershell running command pr.
» CJIDENTITY O no Runs ACL Management Tool  2019-04-10 2:29 PM 2019-04-10 3:09 PM Application Rule Running ACL management tool c:
» [ ASSURANCE [ no AWS Security Hub Log Colle...  2020-07-28 6:17 PM 2020-07-29 7:52 AM Log Collector Log Collector configuration conte
» ] OPERATIONS 0 no NWFL_fw:outbound-networ... 2012-04-23 12:09 PM 2017-11-11 3:37 AM Application Rule NWFL App Rule to support Inforn
[ SPECTRUM [ no 15027002 - Compliance Rep...  2014-06-17 2:45 PM 2017-09-23 5:41 AM NetWitness Report  ISO 27002 establishes guidelines
[ MALWARE ANALYSIS Ll no Direct Login By A Watchlist ... 2018-03-27 2:01 PM 2018-07-24 5:31 PM Event Stream Anal.. A successful interactive or remote
no 11.3 Endpoint Indicators by...  2019-04-10 1:51 PM 2019-04-10 2:02 PM NetWitness Rule Number of risk indicators associe
Resource Types
no RSA Certificate Manager Lo... 2013-11-22 6:35 AM 2017-09-13 11:40 AM Log Collector Log Collector configuration conte
[J no Top Outbound Source IP 2014-07-24 10:56 AM 2017-09-23 5:49 AM NetWitness Rule Summarizes a list of outbound sc
Medium no Runs Chained Command S... 2019-04-10 2:30 PM 2019-04-10 3:10 PM Application Rule Running chained command shell
no Enumerates Local Groups 2019-04-10 2:16 PM 2019-04-10 3:06 PM Application Rule Enumeration of local groups can
[J no SecurlD Cloud Device Regis...  2019-04-17 5:54 AM 2019-04-17 5:56 AM Application Rule Raises an alert when RSA SecurlC

Detects files transported over ICA

no fingerprint_job 2013-09-12 2:24 PM 2017-09-23 5:37 AM Lua Parser Identifies windows job task schec
Generated Meta Values -
no Cisco Ironport ESA Log Coll...  2013-11-22 6:13 AM 2017-09-13 11:37 AM Log Collector Log Collector configuration conte
[0 no HyTrust 2014-02-14 3:34 AM 2017-09-13 11:07 AM Log Device Log device content for event sour
Resource Created Date: —
. no Bit9 Log Collector Configur..  2013-11-22 6:11 AM 2017-09-13 11:37 AM Log Collector Log Collector configuration conte
Start Date End Date -
no Event Viewer Executes Unc...  2019-04-10 2:17 PM 2019-04-10 3:07 PM Application Rule Event viewer executing uncomme
Resource Modified Date: 7 no Microsoft Audit Collection S...  2014-02-14 3:41 AM 2020-05-04 2:06 PM Log Device

Log device content for event sour ¥
>

78

Deploy Content



Live Services Management Guide

2. Select Show Results > Detailed to change to detailed results when viewing grid results.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES
Search Criteria Matching Resources
Keywords Show Results = | | 3 Package

== RSA Malware PE Artifacts
A ]
Category B type Malware Rules updated 2018-05-04 11:11 PM version 0.2 size 74.5 KB su edno
[ FEATURED Yara 10Cs which statically analyze Windows PE file artifacts for signs of malware.
» [ THREAT
» D IDENTITY === RSA Malware PE Packers
NS S pe Malware Rules updated 2013-11-21 9:07 PM vers 0.1 size 93.97 KB no
ASSURANCE
Yara 10Cs which statically analyze Windows PE files to identify Common Packers
» [ OPERATIONS
[ISPECTRUM =8¢ RSA Malware PDF Artifacts
"] MALWARE ANALYSIS ol e Malware Rules updated 2013-11-21 9:07 PM version 0.1 size 587 B cribed no
Yara |0Cs which statically analyze PDF file artifacts for signs of malware
Resource Types
Malware Rules @  Log Collector @ e 4y, McKesson HPF Log Collector Configuration
5 pe Log Collector updated 2017-09-13 5:09 PM version 0.2 size 1.42 KB subsc no
Medium Log Collector configuration content for event source McKesson HPF
v @ event analysis, operations, log analysis
Required Meta Keys 4y SAP ERP Central Component Log Collector Configuration
& Log Collector updated 2017-09-13 5:10 PM s 0.2 size 1.24 KB subscribed no
> Log Collector configuration content for event source SAP ERP Central Component
B ovont analucic nnaratinne Ino analucic %
191 Matching Resources

Viewing Resource Details

You can display detailed information about a subscribed resource in the Resource View.

To view details:

1. In the Subscriptions tab, select a single subscription.

2. Click =/ Details
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The details of the resource are displayed in the Resource View.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports 2 ; admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

. Download 3\ Subscribe  [B] Deploy € Service Locator

Runs ACL Management Tool

Application Rule
2019-04-10 2:29 PM
2019-04-10 3:09 PM

Running ACL management tool can be an indication of someone trying
to run multiple malicious commands needed to perform multi-stage
attack to exploit the system, which can be further used to gain access,
to do lateral movement or to gain elevated privileges.

VERSIONS SUPPORTED
* NetWitness Platform 11.3 and higher

DEPENDENCIES
* NetWitness Endpoint Server

GENERATED META KEYS
* analysis.file = runs acl management tool

0.1

199 bytes
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References

This topic is a collection of references, which describe the user interface and more detailed information
about how Live works in NetWitness. These topics are presented in alphabetical order.
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Live Configure View

In the Live Configure view, NetWitness provides integrated tools for managing Live resources. You can
manage resource subscriptions, deployments to services and discontinued resources. The required role to
access this view is Configure Live Resources. For a high-level description of how to use the different
views in NetWitness Live, please read Live Services Management.

To access this view, navigate to (Configure) > Subscriptions. The view has three tabs:
Deployments Tab, Subscriptions Tab, and Discontinued Resources Tab.
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Deployments Tab

The Deployments tab provides a user interface in the Live Configure view for:

e Viewing subscribed resources that are selected for deployment on services in a service group.

» Selecting subscribed resources to deploy to services in a service group.

* Removing resources that are selected for deployment on services in a service group.

The resources listed here are not deployed immediately after adding to a service group. Instead the

subscribed resources are pushed to the services when NetWitness synchronizes with NetWitness Live.
The synchronization schedule is configured in the Live Configuration panel. Additionally, you can

synchronize immediately in the (Configure) > Subscriptions > Deployments tab.

Likewise, resources deleted from the Deployments panel are not deleted from service where they have
been deployed. To delete resources from services, delete them in the Live Resource View.

The required permission to access this view is Manage Live Resources.
To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.
2. Click the Deployments tab.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

Subscriptions EEJlnlheM Discontinued Resources

Groups Subscriptions
Name Address Type | 8

LA

[0 Name Created Updated Discontinued Type Description

The Deployments tab has two panels: Groups and Subscriptions.
Groups Panel

The Groups panel is a static display of configured service groups that were created in the Administration
Services view. Selecting a group in the Groups panel populates the Subscriptions panel with a list of
subscriptions that are selected for deployment on the services in the service group.

e N

Name Displays the service group name. Clicking the plus sign displays a nested list of services in the group.

Address Displays the IP address of each service in the group.
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e Jowmn

Type

Displays the type of service.

Subscriptions Panel

The following table describes the features in the Subscriptions panel.

e e

Click + to open a dialog that lists subscriptions that were added in the Live Search view or in the
Live Resource view and are available for deployment.

Click = to delete the selected subscriptions from the deployment list for service group.

B, Click =~ to synchronize your resources to the latest versions available on Live.
Name Displays name of the resource.
Created Displays date and time that the resource was created.
Updated Displays date and time that the resource was last updated.
Type Displays type of resource.
Description Displays description of the resource.
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Subscriptions Tab

Subscriptions are NetWitness Live resources to which you subscribed in the Live Search view or Live
Resource view. When you subscribe to a resource, you agree to receive updates on a regular basis from
NetWitness Live. The choices made in the Live Configuration panel determine the synchronization
frequency and also whether you receive update notifications through email. In addition, if you don't want
to wait for the next update, you can force an immediate synchronization.

The Subscriptions tab provides a way to manage subscriptions. Each resource to which NetWitness is
subscribed is listed in this tab.

In the Subscriptions tab, you can:
e View all resources to which this NetWitness instance is subscribed.
e Open a detailed view of a subscription in the Live Resource View.

¢ Delete a subscription.

Note: Subscribing to a resource does not deploy the resource to any services. To deploy one or more
subscribed resources, go to the Deployments tab. To deploy a single resource manually, use the
Deploy option in the Resource View.

The required permission to access this view is Manage Live Resources.

To access this view, in the main menu, selec (Configure) > Subscriptions. The Subscriptions tab
is displayed.

NETWITNESS

LIVE CONTENT SUEBSCRIPTIONS CAPTURE POLICIES MCIDENT RULES MCIDENT NOTIFICA

LG IVIGLEE Deployments  Discontinued Resources

- | :@:
[ Mame Type Version Discontinued Updated Description
yp P p
O CIMalware IP List Decoder Feed 0.1567 no 2017-07-17 12:45 AM List of ip addresses commaonly associated ...
[0 [CJMalware Domains Decoder Feed 0.869 no 2017-07-19 1:02 AM List of domains associates with malware so...

The Subscriptions tab has a toolbar and a grid.
Toolbar

This table describes the options available in the toolbar.

e Towmn

Deletes the selected subscriptions.

Details  Displays the details of a single subscribed resource in the Resource View.
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o Jowamn

Grid

Check the Live Server for the latest discontinued resources.

™

Name
Type
Version

Discontinued

Selects subscribed resources to view in detail or delete. You can view details for a single
resource. You can delete one or more resources from the subscribed resources, in effect
unsubscribing.

Displays name of the subscribed resource.
Displays type of subscribed resource.
Displays version of the subscribed resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - Resource is discontinued.

No - Resource is not discontinued.

--- The Live Server is not checked for the discontinued resources.

Updated Displays date and time when the subscribed resource was last updated.
Description Displays description of the subscribed resource.
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Discontinued Resources Tab

The Discontinued Resources tab provides a user interface in the Live Configure view:

e Scan the services for the discontinued resources.

o Remove the discontinued resources from any service or service group.

Note: Discontinued content still appears. With discontinued content there just won’t be any updates,
and users won’t see these items when they search in Live, unless they check the Include Discontinued
Resources box while searching.

In the RSA Content space on NetWitness Community, you can view the complete, up-to-date list of
discontinued resources (Discontinued Content). For each resource, there is a description of why it was
discontinued. Use these details to determine whether or not to remove a discontinued resource from your
installation. .

The required permission to access this view is Manage Live Resources.

To access this view:

1. Goto (Configure) > Subscriptions.
The Subscriptions tab is displayed.

2. Click the Discontinued Resources tab.
The Discontinued Resources tab is displayed.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES

NV Hegleliloly SR ell Il Discontinued Resources

Groups Discontinued Resources on Service

) ~ -

Name Address Type L1 Name Type Version Discontinued Updated Description

No Service was found to have
discontinued resources

The Discontinued tab has two panels: Groups and Discontinued Resources on Service.

Groups Panel

The Groups panel is a static display of configured service groups that were created in the Admin
Services view. Selecting a group in the Groups panel populates the Discontinued Resources panel with a
list of discontinued resources which are deployed on the selected service or service group.
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e Lo

B

-~y
s

Name

Address

Type

Click the button to scan the services for a discontinued resource.

Displays the current status of the discontinued resources on a service.

Note: The status of a service may change while the services are being scanned.

Displays service group name. Clicking the plus sign displays a nested list of services in the group.
Displays IP address of each service in the group.

Displays type of service.

Discontinued Resources on Service Panel

The following table describes the features in the Discontinued Resources on Service panel.

N N

Name
Type
Version

Discontinued

Click the button to delete the selected resources from the service or service group.

This is the name of the resource.
This is the type of resource.
Version of the discontinued resource.

Indicates the status of the discontinued resources for the subscribed resource.
Yes - The resource is discontinued.
No - The resource is not discontinued.

-- - The Live Server is not checked for the discontinued resources.

Updated Displays date and time that the resource was last updated.
Description Displays description of the resource.
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Live Feeds View

Use the Live Feeds View to:
e Create custom feeds.

e Create identity feeds.

e Edit feeds.

The required role to access this view is Manage Devices.

To access this view, navigate to (Configure) > Custom Feeds.

This is an example of the Feeds view.

NETWITNE

admin

LIVE COMTENT 5 CRIPTIONS CAPTURE POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS 5 CUSTOM FEEDS
+ [

O Name Trigger Disk Usage Created Last Run Time Status Progress

| TEST Once - 2019-07-1313:30:36  2019-07-13 12:30:36  Completed CE—

| TEST2 Once - 2019-07-1313:50:33  2019-07-13 13:50:32  Completed CE—

O te Once - 2019-07-14 04:16:31 2018-07-14 04:16:51 Completed CEE——

| onlydom Once - 2018-07-1404:21:27  2019-07-1404:21:37  Completed e

| PCAP Once - 2019-07-1409:30:42  2019-07-14 09:30:49  Completed CE—

The Feeds tab has a toolbar and a grid.
Toolbar

This table describes the options in the toolbar.
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e oo

=%

» @ N

Feeds Grid

Initiates the creation of a custom or identify feed by displaying the Setup Feed dialog is displayed.

Setup Feed

(® Custom Feed

() Identity Feed

Cancel
o Custom Feed opens the Configure a Custom Feed wizard.
o |dentity Feed opens the Configure Identity Feeds wizard.

Deletes the feed that you selected.

Opens the Configure Custom Feed or Configure Identity Feed wizard for the feed that you selected

(see Editing a Feed.

Start or resume data feed.

Stop or pause data feed.

This table describes the columns in the grid.

T

Selects a feed.

Name Name of the feed.
Note: You can now use special characters to define the name of the custom feed.
Trigger Displays how often the feed runs which is determined by what you defined in Feed Task Type when
the feed was created.

Created Displays date and time when the feed was created.

Disk Usage Displays the MongoDB storage size used by the TAXII feed.

Last Run Displays date and time when the feed was last run.

Time

Status The status of the feed.

Progress Progress bar.
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Live Resource View

The Live Resource View shows a detailed view of a selected resource, and has the following options:
e Download the resource.

* Subscribe or unsubscribe the resource.

* Deploy the resource to services.

» Locate services on which the resource is deployed and remove the resource from services.

The required permission to access this view is View Live Resource Details.

To access this view, do one of the following:
1. Goto (Configure) > LIVE CONTENT > Search Criteria.

2. In the Live Search view, Detailed Results, click the resource type icon or the resource name.

3. In the Live Search view, Grid Results, double-click a resource or select a resource and click Details.

This is an example of the Resource view.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports 4} admin v

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES BPOEICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS

&, Download 3\ Subscribe ] Deploy € Service Locator

Runs ACL Management Tool

Application Rule
2019-04-10 2:29 PM
2019-04-10 3:09 PM

Running ACL management tool can be an indication of someone trying
to run multiple malicious commands needed to perform multi-stage
attack to exploit the system, which can be further used to gain access,
to do lateral movement or to gain elevated privileges.

VERSIONS SUPPORTED
* NetWitness Platform 11.3 and higher

DEPENDENCIES
* NetWitness Endpoint Server

GENERATED META KEYS
* analysis.file = runs acl management tool

0.1

199 bytes

The Live Resource View has a detailed view of a single resource and a toolbar.

Resource Details

The following table describes the elements in the Resource Details section.
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e Jomen

Resource
Type Icon

Name

Type
Created
Updated
Description
Version in
production
Size

Required
Resources

Tagged as

L

Required
Meta Keys

Generates
Meta Values

Permissions

A graphic representation of the resource type, for example 1y

The name of the resource, for example, fingerprint_office lua,

The type of resource, for example, RSA Lua Parser,

The date the resource was created, for example, 2013-09-15 02:16 PM.
The date the resource was last updated, for example, 2013-09-15 02:16 PM

The description of the resource, for example, Identifies Microsoft Office 95, 2007 Word, Excel, and
PowerPoint documents,

The version of the resource, for example, 0.1.

The size of the resource, for example, 9-079 KB,

A list of resources on which this resource depends, for example, NetWitness Lua Library. Clicking a
resource replaces the currently displayed details with the details of the one you clicked.

The tags that apply to the resource. In the example, the tags are featured, informational. Clicking a
tag opens the Live Search View with the search narrowed to match resources with that tag.

The meta keys 49 that apply to the resource. In the example, there are no meta keys required. Clicking a

meta key opens the Live Search View with the search narrowed to match resources with that meta key.

The meta values E that the resource generates. In the example, there are no meta values generated.

Clicking a meta value opens the Live Search View with the search narrowed to match resources with that
meta value.

The permissions required for the resource.

Resource View Toolbar

This table describes the Live Resource view toolbar options.

T

Download

This option downloads the resource currently displayed in the Resource
.L Download View_p y cispiay

92
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o o

Subscribe or ; This option subscribes to or unsubscribes from the resource currently
Unsubscribe :-'l-“'i Subscribe displayed in the Resource View.

3 Unsubscribe Clicking Subscribe opens a dialog notifying that you are agreeing to

receive notification when the selected resources are updated. You can
cancel or click OK.

¢ Clicking Unsubscribe asks for confirmation that you want to stop
receiving notification when the selected resources are updated. You
can then choose to cancel or you can click Unsubscribe or
Unsubscribe and Remove, which also removes the resource from
services on which it is deployed.

Deploy @’ Deploy This option provjdes away to deploy the resource currently displayed in
the Resource View. Clicking Deploy opens the Manual Resource
Deployment dialog.

Service Locator ¢ seryice Locator 1 Nis Option displays a list of services on which the currently displayed
resource is deployed. You can remove the resource from all services or
selected services.
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Live Search View

The Live Search view provides the ability to browse the configured Live CMS for resources. Once
matching resources are found, you can view details, subscribe to resources, and deploy resources to

services and service groups.
This is an example of the Search view.

NETWITNESS Respond Users Hosts Files

Investigate

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES

Search Criteria Matching Resources

Keywords Show Results |
Subscribed Name Created
Category no RSA OSINT IP Threat Intel F...
[ FEATURED ] no RSA OSINT Non-IP Threat In...
» CITHREAT 0 no Powershell Runs Command..
» CJIDENTITY no Runs ACL Management Tool
» [JASSURANCE [ no AWS Security Hub Log Colle...
» [ OPERATIONS [ no NWFL_fw:outbound-networ...
[CISPECTRUM no 15027002 - Compliance Rep...
[ MALWARE ANALYSIS [ no Direct Login By A Watchlist ...
no 11.3 Endpoint Indicators by...
Resource Types
no RSA Certificate Manager Lo...
[ no Top Outbound Source IP
Medium no Runs Chained Command S...
v no Enumerates Local Groups
J no SecurlD Cloud Device Regis...
Required Meta Keys
[ no File Transport over ICMP
no fingerprint_job
Generated Meta Values -
no Cisco Ironport ESA Log Coll...
[ no HyTrust
Resource Created Date:
. . no Bit9 Log Collector Configur...
Start Date End Date -
no Event Viewer Executes Unc...
Resource Modified Date: % no Microsoft Audit Collection S..

663 Matching Resources

2020-09-10 7:53 PM

2020-09-10 7:53 PM

2019-04-10 2:23 PM

2019-04-10 2:29 PM

2020-07-28 6:17 PM

2012-04-23 12:09 PM

2014-06-17 2:45 PM

2018-03-27 2:01 PM

2019-04-10 1:51 PM

2013-11-22 6:35 AM

2014-07-24 10:56 AM

2019-04-10 2:30 PM

2019-04-10 2:16 PM

2019-04-17 5:54 AM

2014-07-21 5:31 PM

2013-09-12 2:24 PM

2013-11-22 6:13 AM

2014-02-14 3:34 AM

2013-11-226:11 AM

2019-04-10 2:17 PM

2014-02-14 3:41 AM

Dashboard Reports

INCIDENT NOTIFICATIONS

| 3 Package

Updated

2022-09-06 4:30 AM
2022-09-06 4:30 AM
2020-01-23 4:21 PM
2019-04-10 3:09 PM
2020-07-29 7:52 AM
2017-11-11 3:37 AM
2017-09-23 5:41 AM
2018-07-24 5:31 PM
2019-04-10 2:02 PM
2017-09-13 11:40 AM
2017-09-23 5:49 AM
2019-04-10 3:10 PM
2019-04-10 3:06 PM
2019-04-17 5:56 AM
2017-11-11 3:37 AM
2017-09-23 5:37 AM
2017-09-13 11:37 AM
2017-09-13 11:07 AM
2017-09-13 11:37 AM
2019-04-10 3:07 PM

2020-05-04 2:06 PM

ESA RULES

Type

Feed

Feed
Application Rule
Application Rule
Log Collector
Application Rule

NetWitness Report

Event Stream Anal...

NetWitness Rule
Log Collector
NetWitness Rule
Application Rule
Application Rule
Application Rule
Application Rule
Lua Parser

Log Collector
Log Device

Log Collector
Application Rule

Log Device

admin v

OM FEEDS

Description
This feed contains IP Address (IPv
This feed contains Non-IP Addres
Powershell running command pr:
Running ACL management tool c:
Log Collector configuration conte
NWFL App Rule to support Inforn
1SO 27002 establishes guidelines
A successful interactive or remote
Number of risk indicators associz
Log Collector configuration conte
Summarizes a list of outbound sc
Running chained command shell
Enumeration of local groups can
Raises an alert when RSA SecurIC
Detects files transported over ICh
Identifies windows job task schec
Log Collector configuration conte
Log device content for event sour
Log Collector configuration conte
Event viewer executing uncommc

Log device content for event sour ¥
»

The Live Search view has a panel for specifying search criteria and a panel that displays matching
resources. The Search Criteria panel is collapsible to provide more width for viewing the Matching

Resources panel.

Search Criteria Panel

This is an example of the Search Criteria panel.
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Search Criteria

Keywords

Category
[ FEATURED
» CJTHREAT
» [ IDENTITY
» CJASSURANCE

» (] OPERATIONS

Resource Types

Medium

Required Meta Keys

Generated Meta Values

Resource Created Date:

Start Date End Date

Resource Madified Date:

The following table provides descriptions of the Search Criteria panel features.

Keyword(s)

Category

Description

Enter a keyword or keywords to browse for resources that have the keyword in the resource
name or the resource description. You can use wildcards when you enter a keyword.

The categories mirror the hierarchical Investigation Model that NetWitness uses to organize
resources. The purpose of the Investigation model is to deliver an accurate path to information

security incident response. For more information, see the [nvestigation Model topic in the
NetWitness Content space on NetWitness Community.

Deploy Content
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Resource Types Select resources types from the drop-down list to filter resources by type of resource. Possible
values are:

¢ Advanced Analytics (Warehouse)
e Application Rule

* Bundle

e Correlation Rule

¢ Event Stream Analysis Rule
e Feed

e FlexParser

¢ Investigation Column Group
¢ Investigation Meta Group

* Investigation Profile

e Log Collector

¢ Log Device

* Lua Parser

e Malware Rules

e NetWitness List

¢ NetWitness Report

¢ NetWitness Rule

e (Version 11.5 and later) Health and Wellness Dashboards

e (Version 11.5 and later) Health and Wellness Monitors

Note: Some rules that have been deployed to an earlier version of NetWitness may not deploy or
execute on NetWitness 11.x. For more information, see the Troubleshooting Live Services.

Medium Select one or more mediums from the drop-down list to search for content based on the meta
data source.

Available values for medium are as follows:

* endpoint: for NetWitness 11.3 and later): applied to content that uses meta
derived from endpoint agent and endpoint server data

¢ log: applied to content that uses meta derived from log data
» packet: applied to content that uses meta derived from network packets

* log and packet: applied to content that correlates meta derived across log and
packet data
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Tags Select meta tags from the drop-down list to browse based on how the meta is tagged. For example, to
browse resources for a Log Decoder, select the netwitness for logs tag. Alternatively, you can click a
tag in the Matching Resources panel to insert that tag in this field.

Required Meta Enter a specific meta key; for example, threat.source, Alternatively, you can click a meta key in the
Key(s) Matching Resources panel to insert that tag in this field.

Generated Meta  Enter a generated meta value; for example, netwitness, Alternatively, you can click a generated meta
Value(s) key in the Matching Resources panel to insert that tag in this field.

Research Specify a date range during which resources were created. For example, to browse resources that were
Created Date created between January 1 and January 4, you select January 1 as the start date and January 4 as the

end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a calendar.

Research Specify a date range during which resources were modified. For example, to browse resources that

Modified Date were modified between January 1 and January 4, you select January 1 as the start date and January 4 as
the end date. You must enter dates in mm/dd/yyyy format or you click and pick dates from a
calendar.

Search Click Search to send the search request to the Live server. More specific search criteria return
matching resources more quickly.

Cancel Click Cancel to cancel the search in progress.

Include Check Include Discontinued Resources to include the discontinued resources in the search

Discontinued result. For an up-to-date list of resources that have been discontinued, see the Discontinued

Resources Content topic.

Matching Resources Panel

The Matching Resources panel displays search results based on the selections made in the Search
Criteria panel. Results are initially displayed in a grid, but you can switch between two Show Results
options: Detailed or Grid.

Detailed Results

In the detailed results, you can click a tag, meta key, or resource meta value to auto fill the Search
Criteria panel and pivot the search results.

The following table describes the elements in the detailed results.

roan ommn

Resource |
Type Icon A graphic representation of the resource type. For example :
Name The name of the resource, for example, Group Management.

Note: (Discontinued) is displayed next to the resource name if a resource is discontinued.
Type The type of the resource, for example, Rule.
Updated The date when the resource was last updated, for example, 2015-09-15 4:27 PM.
Version The version of the resource, for example, 0.1.
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Size

Subscribed

Description

Tags

Meta Keys

Resource
Meta Values

Grid Results

The size of the resource, for example, 153 B.

Subscription status:

¢ yes: This NetWitness instance is subscribed to this content resource.

¢ no: This NetWitness instance has not subscribed to this content resource.
The description of the resource, for example, Compliance Rule-Group Management.

The tags that apply to the resource. Clicking a tag narrows the search to resources with that tag. For

L

example, .

The meta keys that apply to the resource. Clicking a meta key narrows the search to resources with

that meta key. For example, f

The meta values generated by the resource. Clicking a meta value narrows the search to resources

that generated the meta value. For example, E .

In the grid view, you can select one or more resources and use additional options in the toolbar to view
the details of a single resource, subscribe to resources, and deploy resources.

The following table describes the elements in the grid results.

e

Subscribed

Name

Created
Updated

Type

Discontinued

Description

Subscription status:

¢ yes: This NetWitness instance is subscribed to this content resource.

e no: This NetWitness instance has not subscribed to this content resource.

The name of the resource, for example, Group Management.

Note: The resource name is displayed in red color if it is discontinued.

The date when the resource was created, for example, 2015-08-12 3:11 PM,
The date when the resource was last updated, for example, 2015-09-15 4:27 PM,
The type of the resource, for example, Rule,

The status of the discontinued resources:

e yes: The resource that matches the search criteria is discontinued
e no: The resource is not discontinued
e --: The Live Server is not checked for the discontinued resources

The description of the resource, for example, Compliance Rule-Group Management.

Toolbar
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Show Result This menu offers two ways to view search results: Detailed and Grid,

Details This option applies to a single selected resource. Clicking Details opens the selected resource in the Live
Resource view.

:El: Deploy This option applies to one or more selected resources.

N Subscribe This option applies to one or more selected resources. Clicking Subscribe opens a dialog that
: asks for confirmation that you want to receive notification when the selected resources are
updated.

= Package ~ This menu offers two packaging functions for the selected resources:

e Create: creates a resourceBundle.zip file that contains the selected resources and opens a
dialog in which you can either:

e open the file, or
o save the file for subsequent deployment.

¢ Deploy: opens the Deployment Wizard, in which you can choose a resourceBundle.zip file
and deploy it.

See Also

* For more information on Deployment ( E. Deploy), see Find and Deploy Live Resources.

For more information on Deploying a Package (;{ Package ), see the Resource Package
Deployment Wizard,.
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Live Search Content View

The Live Search Content view provides the ability to search the configured Live CMS for content. Once
matching content are found, you can view the details, and download the content.

This is an example of the Search Content view.

NETWITNESS

& Content

View New, recently updated and community content details here.

SOURCE

NetWitness

Content Showing New Content (12) Timezone : GMT+0530 Asia/Calcutta

NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION

O New

Recently Updated 07-Sep-2022 18:... 07-Sep-2022 18:... Application Rule LG Detects a Windows command and scripting interpreter exe.

30-Aug-202218:..  30-Aug-202223..  Application Rule 115 Identifies User Account Control (UAC) bypass attempts usi..
Search Content
26-Aug-202219...  26-Aug-202219..  EventStreamAn... 115 When attempting to access 0365 environments, actors ma.
25-Aug-202222:..  25-Aug-202222..  Application Rule Al Versions In environments where admin privileges have already been. |
25-Aug202222:..  25-Aug-202222..  ApplicationRule Al Versions C2 communication for Quasar RAT uses a common SSL Cer..
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions This rule helps to detect regsvr32.exe, rundii32.exe, and diIl.
25-Aug-202216...  25-Aug-202216..  Application Rule All Versions fodhelper (Features On Demand Helper) is an executable u..
25-Aug-202216....  25-Aug-202216:..  Application Rule All Versions Raspberry Robin, the LNK Worm, is commonly known tod...
25-Aug-202216:...  25-Aug-202216..  Application Rule Al Versions Adversaries can use the command prompt feature cmd/R <.
19-Aug-202222..  19-Aug-202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ...

19-Aug-2022 22... 19-Aug-2022 22-... Application Rule Al Versions Towards it's final execution steps, WhisperGate, the data w..

19-Aug202222...  19-Aug202222..  Application Rule Al Versions WhisperGate, a type of data wiping malware, is commonly ..

NETWITNESS

&) Content

SOURCE: | Community View , recently updated and community content details here.

Only Opensource
Showing Filtered Content (2) Timezone : GMT+0530 Asia/Calcutta
Content
NAME } CREATED * UPDATED & TYPE & MIN PLATFORM VERSION 4 DESCRIPTION }
New

O Recently Updated v 19-Aug202222..  19-Aug-202222..  ApplicationRule NA Data Wiping Malwares may partially or completely overwr...

Search Content 18-Aug-2022 21:... 18-Aug-2022 21.... Application Rule Detects a successful ProxyShell exploitation attack (CVE-2...|

The Live Search Content view has a panel for selecting the source and specifying search content. The
matching content are displayed on the right panel.

The following table provides descriptions of the Live Search Content panel features.

Description

NetWitness Select NetWitness from the Source drop-down menu to search for the content that is
provided by NetWitness Platform XDR Live.

Community  Select Community from the Source drop-down menu to search for the content
collected and retrieved from third party and open source communities.
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Only Select the Only Opensource checkbox to retrieve the content from the open-source
Opensource  communities.

Note: When the community is selected as the source, the Only Opensource option
will be displayed under the Search Content Panel to select and search for open
source-related content.

New Select New to retrieve the content which is created in the last 21 days.
Recently Select Recently Updated to retrieve the content which is updated in the last 21 days.
Updated

Search Content Panel

This is an example of the Search Content panel.

The following table provides descriptions of the Search Content panel features.

N

Keywords Enter a keyword or keywords to browse for content that have the keyword in the
resource name or the resource description. You can use wildcards when you enter a
keyword.
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Resource Select resources types from the drop-down list to filter resources by type of resource.
Types Possible values are:

* Application Rule

e Feed

e Log Device

e Correlation Rule

e NetWitness Rule

e NetWitness Report

e Lua Parser

e Log Collector

e NetWitness List

e Malware Rules

» Event Stream Analysis Rule

e Advanced Analytics (Warehouse)
e Bundle

e Health and Wellness Dashboards
» Health and Wellness Monitors

* Investigate Profile

e Investigate Column Group

» Investigate Meta Group
Mediums Select one or more mediums from the drop-down list to search for content based on
the meta data source.
Available values for medium are as follows:
» endpoint: for 11.3 and higher): applied to content that uses meta derived from
endpoint agent and endpoint server data

» log: applied to content that uses meta derived from log data
o packet: applied to content that uses meta derived from network packets

 log and packet: applied to content that correlates meta derived across log and
packet data.

Tags Select meta tags from the drop-down list to browse based on how the meta is tagged.
For example, to browse content for a Log Decoder, select the netwitness for logs
tag.
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Platform Select one or more platform versions from the drop-down list to search for content
Versions based on the versions. For example, 11.5.

Required Enter a specific meta key. For example, threat.source,

Meta Keys

Generated Enter a generated meta value. For example, rsa-firstwatch.

Meta Values

Created Date  Specify a date range during which content were created. For example, to browse
content that were created between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click B and pick dates from a calendar.

Modified Date Specify a date range during which content were modified. For example, to browse
content that were modified between January 1 and January 4, you select January 1 as
the start date and January 4 as the end date. You must enter dates in yyyy/mm/dd
format or you click [ and pick dates from a calendar.

Search Click Search to send the search request to the Live server. More specific search
criteria return matching content more quickly.

Reset Filter Click Reset Filter to reset the existing search results and displays all the content on
the right panel.

Include Check Include Discontinued to include the discontinued content in the search result.

Discontinued  For an up-to-date list of content that have been discontinued, see the Discontinued
Content topic.

Search Results Panel

The Search Results panel displays search results based on the selections made in the Search Content
panel.

This is an example of the Search Results panel.
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&) Content

View New, recently updated and community content details here.

Showing Filtered Content (877) Timezone : GMT+0530 Asia/Calcutta

NAME # CREATED 4 UPDATED 4 TYPE § MIN PLATFORM VERSION % DESCRIPTION 4 DISCONTINUED %

11-Sep-202001:2... 17-Jul-2022 10:01... Feed All Versions This feed contains IP Address (IPv4 and IPv6) indicators that a... No

26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.0.0 This dashboard provides information on various NetWitness P... No

26-Nov-2020 16:5... 26-Nov-2020 16:5... Not found 11.5.0.0 This dashboard provides information on NetWitness Platform ... No

11-Sep-202001:2... 17-Jul-2022 10:01... Feed All Versions This feed contains Non-IP Address, text based indicators like ... No

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.0.0 Amount of Incoming UDP Packets Requested by Endpoint ser... No

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.0.0 Capture is not started on this Decoder service, so packet data... No

06-Aug-2020 20:5... 13-Aug-2020 00:4... Application Rule 11.5.0.0 A hash mismatch may indicate a file has been altered fromiits o... No

23-Dec-2020 16:4... 23-Dec-2020 16:4... Log Device 11.5.00 Log device content for event source AWS Route53 Resolver - ... No

19-Mar-2021 19:3... 19-Mar-202119:3... Log Device 11.5.00 Log device content for event source Cisco Umbrella - cisco_um... No

26-Nov-2020 16:2... 26-Nov-2020 16:2... Not found 11.5.00 Reporting Engine home directory /var/netwitness/re-server/r... No

26-Nov-2020 16:4... 26-Nov-2020 16:4... Not found 11.5.00 80% of the Contexthub Server's query response cache is in use. No

26-Nov-2020 16:3... 26-Nov-2020 16:3... Not found 11.5.00 Decoder is presently not capturing data. No

The following table describes the elements in the search results panel.

Description

Name The name of the content. For example, Log Parser Pack.

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,

Updated The date when the content was last updated. For example, 29-Sep-
2020 20:27:14.
Type The type of the content. For example, Bundle,
Min Platform Platform version that the content supports. For example, 11.5 and higher.
Version

Note: Min Platform Version is not applicable for Community content.

Description The description of the content. For example, Contains all parser files and log
collection files.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

e No: The content is not discontinued

Content Details Panel

In the Search Results panel, you can select any content titles to view the details in the pop-up window
and download the content.

Note: NetWitness provides no assurance related to the quality and accuracy of the content provided by
the third parties and open source communities.
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This is an example of the Content Details panel.

Content Details

NOTE: The following content is collected and derived from third-party, open sources. RSA
[NetWitness] at no times makes claims to the quality and/or efficacy above and beyond the
attestations of the authors of the content itself.

[Community] Malware, Malicious Code and APT Open Source YARA
Rules

ME

Malware Rules

UPDATED

16-Feb-2022 21:40:00

DESCRIPTION

The following corpus of YARA rules focus on the detection, identification, and analysis of various forms and
types of malicious code & content (malware) and in some cases those threat actors/adversaries associated
with their use and proliferation. These YARA rules have been collected from the open-source community and
are being made available to our customers via our NetWitness Live Community capability.

Mediums

None

@ Large files may take longer time to start the download. Close Download

The following table describes the elements in the Content Details section.

Name The name of the content. For example, Log Parser Pack.

Type The type of the content. For example, Bundle,

Created The date when the content was created. For example, 04-Aug-2017 15:19:06,
Updated The date when the content was last updated. For example, 29-Sep-2020 20:27:14.
Description The description of the content. For example, Contains all parser files and log

collection files.

Version on The version of the content. For example, 0.5.

Production

Size The size of the content. For example, 14.96 KB.

Required A list of resources on which this resource depends. For example, NetWitness Lua
Resources Library. Clicking a resource replaces the currently displayed details with the details

of the one you clicked in the pop-up window.
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Tags The tags that apply to the content. For example, threat. Clicking a tag opens the
Live Search Content view with the search narrowed to match content with that tag.

Required The meta keys that apply to the content. For example, Threat Category. Clicking a
Meta Keys meta key opens the Live Search Content view with the search narrowed to match
content with that meta key.

Generated The meta values that the content generates. For example, rsa-firstwatch. Clicking a
Meta Values meta value opens the Live Search Content view with the search narrowed to match
content with that meta value.

Discontinued The status of the discontinued content:
¢ Yes: The content that matches the search criteria is discontinued

¢ No: The content is not discontinued
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Resource Package Deployment Wizard

If you have created a package of resources and saved it on a network drive, you can use the Resource
Package Deployment Wizard to deploy the resources manually to a service or a service group without
subscribing to the resources. NetWitness accepts packages in .nwp files or .zip files.

Deploying resources manually deploys them directly to the services without taking advantage of the
powerful resource management capabilities of NetWitness.

If you want to receive notification and updates for updated resources and be able to easily remove
resources from a service, you must subscribe to resources in the Live Search view and deploy the
resources in the Live Configure view.

Note: Use NetWitness Live to create resource bundles; this is a different application that is not part of
NetWitness. Selecting Package > Create in the Live Search - Matching Resources toolbar displays
the Content Package Tool window. You can choose resources to include in a package and save the
package as a NetWitness Package File.

The required permission to access this view is Deploy Live Resources.

To access this view:

1. Goto (Configure) > Live Content.

& Package ~

2. In the Live Search - Matching Resources toolbar, select > Deploy.

The Resource Package Deployment wizard is displayed.

Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle Browse

Cancel Next.

Features

The Deployment Wizard has five tabs: Package, Resources, Services, Review and Deploy.
Use Close to exit before you complete the wizard.

When you complete the wizard, NetWitness returns to the Live Resources View.

Package Tab

You use this tab to select a resource bundle from your network in this page.

This is an example of the Package tab, with a resource bundle already selected.
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Resource Package Deployment

Package Resources Services Review Deploy

Resource Bundle  resourceBundle3866217298122437775.zip Browse

Cancel Next

The following table describes the elements in the Package tab.

Resource The input field to specify a resource bundle. You can type a path in this field or search using the

Bundle rows
. < button.

Command Buttons

Browse This button opens a File Upload dialog in which you can browse the local file system and select a
bundle.

Cancel Cancels the deployment and closes the wizard.

Next Displays the next tab of the wizard.

Resources Tab

This tab displays the resources contained in the bundle.

The following figure shows an example of the Resources tab.

Resource Package Deployment
Package Resources Services Review Deploy
Total resources : 2

Resource Names Resource Type Dependency Of
suspicious php put long query RSA Application Rule

APT Domain Intelligence RSA Application Rule

Cancel Next

The following table describes elements in the Resources tab.

Resource Name Displays the name of the resources in the bundle (for example, NetWitness Lua Library),
Resource Type Displays the resource types for the resources in the bundle (for example, RSA Lua Parser)
Dependency Of Displays Resources on which the selected resource depends (for example, AIM lua),

Services Tab

You select the services on which you want to deploy the resources in the bundle.
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The Services tab has two tabs, Services and Groups. These provide a list of services and service groups

4
that are configured in the (Admin) > Services view. The columns are a subset of the columns
available in the Services view. You can select the services or the service groups on which you want to
deploy the resources in the bundle.

This is an example of the Services tab.

Resource Package Deployment

Package Resources Services Review Deploy

O # Name ~ Type

Decoder
Decoder
Decoder

Log Decoder

O

Decoder
Log Decoder
Decoder
Decoder
Decoder
Log Decoder

Log Decoder

O O
W NN RN RN W WY

Decoder

Cancel Previous Next

The following table describes the elements in the Services tab.

Services
D Selects services on which you want to deploy the content. You can select any combination of services and
service groups.
Name Displays the services in your environment on which you can deploy the content.
Host Displays the name of the resource host.
Type Displays the type of NetWitness service.
Groups

D Selects service groups (if you have service groups defined in your environment).

Name Displays the names of the service groups.
Review Tab

Displays the resources and services on which the resources will be deployed.

In this tab, you can do the following:
e Review the content and services before you deploy.

* Initiate the deployment of the resources.

The following figure shows an example of the Review tab.
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Resource Package Deployment

Package Resources Services Review Deploy
Service Service Type Resource Name Resource Type
Decoder suspicious php put long query RSA Application Rule
APT Domain Intelligence RSA Application Rule
Cancel Previous Deploy

The following table describes the elements in the Review tab.

Service Information
Service Displays the services in your environment on which you can deploy the content.
Service Type Displays the type of each NetWitness service (type of host or service).
Resource Information

Resource Name  Displays the name of the resources you have selected (for example, NetWitness Lua Library),

Resource Type Displays the resource types for the resources you have selected (for example, RSA Lua Parser),
Deploy Initiates the deployment of the resources and displays the Deploy page (final page of the wizard).
Deploy Tab

This tab allows you to do the following:
¢ View the progress of the job
¢ Cancel the job

This is an example of the Deploy tab.

Resource Package Deployment

Package Resources Services Review

Service Name Resource Name Status Progress

0of2

Cancel

The following table describes the elements in the Deploy tab.

N

Service Name of the services to which resources are deployed.
Name

Resource Name of the resources.

Name
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o Jowamn

Status

Progress

Close
Errors

Retry

Status of the manual deployment.

Progress of the manual deployment in a progress bar. When complete, the bar turns solid green.
Command Buttons

Closes the wizard.

Only displays if NetWitness encountered any errors. Click to display the errors.

Only displays if NetWitness encountered any errors. Click this button to try to deploy the resources
again using the wizard.
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NetWitness Live Registration Portal

The NetWitness Live Registration Portal is a self-service wizard in which customers can set up a Live
account and change or reset the password. A Live account is required to get access to the feeds, parsers,
rules, and other content in NetWitness Live library. To access the portal, go to the following

URL: https://live.netwitness.com/registration.

NETWITNESS

Welcome to RSA Live Registration Portal

Thank you for using RSA NetWitness.
Please sign up here for your RSA Live account to access your subscription content.

Sign Up for Netwitness Live Account @
End User License Agreement

First Name

Last Name

THIS SOFTWARE CONTAINS COMPUTER PROGRAMS AND OTHER PROPRIETARY
MATERIAL AND INFORMATION, THE USE OF WHICH IS SUBJECT TO AND EXPRESSLY
CONDITIONED UPON ACCEPTANCE OF THIS END USER LICENSE AGREEMENT (THE
“AGREEMENT").

THIS AGREEMENT IS A LEGALLY BINDING DOCUMENT BETWEEN YOU (MEANING
THE INDIVIDUAL PERSON OR THE ENTITY THAT THE INDIVIDUAL REPRESENTS
THAT HAS OBTAINED THE SOFTWARE AND HARDWARE FOR ITS INTERNAL
PRODUCTIVE USE AND NOT FOR OUTRIGHT RESALE) (THE “CUSTOMER") AND
NETWITNESS (WHICH MEANS (1) RSA SECURITY LLC, IF CUSTOMER IS LOCATED IN
THE UNITED STATES, MEXICO OR SOUTH AMERICA; (Il) THE LOCAL NETWITNESS
SALES AFFILIATE, IF CUSTOMER IS LOCATED OUTSIDE THE UNITED STATES, MEXICO
OR SOUTH AMERICA AND IN A COUNTRY IN WHICH NETWITNESS HAS A LOCAL
SALES AFFILIATE; OR (lll) RSA SECURITY & RISK IRELAND LIMITED OR OTHER
AUTHORIZED NETWITNESS ENTITY AS IDENTIFIED ON THE NETWITNESS QUOTE
OR OTHER NETWITNESS ORDERING DOCUMENT, IF CUSTOMER IS LOCATED
OUTSIDE THE UNITED STATES, MEXICO OR SOUTH AMERICA AND IN A COUNTRY IN
WHICH NETWITNESS DOES NOT HAVE A LOCAL SALES AFFILIATE). Unless
NetWitness agrees otherwise in writing, this Agreement governs Customer's use of the
Software and Hardware, except to the extent all or any portion of the Software or

Hardware is: (a) the subject of a separate written agreement set forth in a quotation CREATE ACCOUNT

ACCEPT

Click Sign Up For Live. The License Agreement page is displayed, once you agree to the Terms and
Conditions, click Accept: the fields for setting up an account are displayed. These include Contact
Information, and License ID.

The following table lists the contact information section fields and its descriptions:

Parameter Description

First Name Your first name.

Last Name Your last name.

Company The name of your
company.

Email The email address

where you want to
receive notifications
related to the Live
account.
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License ID

Username

Password

This is the License ID

on the (Admin)

> System > Info
page.

Caution:

The license ID on
the NetWitness
must be valid and
must be registered
on the Flexera
Server. If not,
contact NetWitness
Customer Support.

The username used to
sign in to Cloud
Services Live
account. The
username must
contain a minimum of
four characters and a
maximum of 16
characters.

The password for the
Cloud Services Live
account. The
password must
contain minimum of
eight characters and
the maximum length
is 24, with at least
one uppercase, one
lowercase, one
number, and one
special character.
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NetWitness Feedback and Data Sharing

The Live Feedback Activity Log enables you to download the usage data required for Live Feedback.
After you download the Live Feedback data, you can then upload it to share with NetWitness.

QA
The settings for these features are available in (Admin) > System > Live Services view,

in the Additional Live Services section.

Additional Live Services

4
Participation in the Additional Live Services is configured in the (Admin) > System > Live
Services view.

Live Feedback

Note: For NetWitness 11.4.1 and later, this section in the UI has been removed. As of 11.4.1,
NetWitness has created the Customer Experience Improvement Program. For details, see "Configure
the Customer Experience Improvement Program" in the NetWitness System Configuration Guide.

Live Feedback is intended to help improve NetWitness.

Aaoditional Live Services
Live Feedback

R5A collects details about the services you use in your deployment for new features and other improvements to the

platform. Informaticn collected is securely sent to RSA.
[+ Additional Feedback Insights
B

Send additional information to improve feature usage, Learn maore

Once you set up and configure a Live account, usage data is automatically shared with NetWitness and is
protected in accordance with the applicable license agreement. All such data shall be anonymized and
shall not have any Personally Identifiable Information.

Before data is sent to NetWitness, all Personally Identifiable Information is removed. Thus, only
anonymous usage data gets transferred to NetWitness.

For more information, see the "Live Feedback Overview" topic in the System Configuration Guide.

File Reputation

File Reputation service provides instant access to the latest signatures using the RSA Live feed so data is
more relevant, with fewer false positives. With this service, users always have reliable data about the
reputation of files in their NetWitness Endpoint system. In addition to the whitelisting service, it
provides blacklisting information as well.
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File Reputation

[+ Enahle File Reputation ) Mot Connected
This option is used to view reputation status of files. The File Hash information from NetWitness Platform is sent to
R5A Live to get the reputation status. Reputation status is leveraged by analysts during investigation of files,.Learn
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Troubleshooting Live Services

This section provides troubleshooting instructions for issues faced when using the Live Services module
in NetWitness.

Some Rules Are Invalid for Version 11.x

The rules "NetWitness Incident Management - Alert Details" and "NetWitness Incident Management -
Incident Summary" are not valid for NetWitness version 11.x. Do not deploy these rules to an 11.x
system.

Note: Rules are updated frequently, and the documentation for them is available in the Content space
on NetWitness Community. For the latest information on Rules, see RSA NetWitness Rules.

OutOfMemoryError on Context Hub Server

You may encounter an OutOfMemoryError on Context Hub server, and the service becomes
unresponsive.

If there are any TAXII feeds configured, Health and Wellness raises alerts when the available heap
memory of Context Hub server is critically low. If the status of Context Hub server is Unhealthy because
of low memory, perform the following steps:

1. Make sure that the feeds Start Date is within 180 days.

2. Check if any TAXII feed is consuming too much disk space. A TAXII feed can consume maximum
of 300 MB. If it consumes more disk space, you must reduce the value in the Remove STIX data
older than field under Advanced Options in the Custom Feed Creation Wizard when you edit a
TAXII feeds.

Note: If the issue still persists, you must execute step 3.

3. To decrease the number of parallel threads available for processing STIX:

a. Goto K& (Admin) > Services > Context Hub service > View > Explore.
b. In the tree panel, navigate to enrichment/stix/ config.

c. In the right panel, set the stix-query-scheduler-pool-size field value to 2. By default the value is
5. This setting controls how many number of threads are allowed to process queries for STIX
data at the same time.

d. Set the taxii-poll-scheduler-pool-size field value to 2. By default the value is 5. This setting
controls how many number of threads are allowed to poll TAXII servers at the same time.

e. Restart the Context Hub server.

Troubleshooting Live Connect Threat Data Sharing
This section discusses troubleshooting Live Connect Threat Data Sharing.


https://community.netwitness.com/t5/netwitness-platform-threat/rsa-netwitness-rules/ta-p/677889
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Query Log Retrieval Sample

To retrieve a sample of threat intelligence data sent to Live Connect, you must construct a URL by
setting the following parameters:

¢ sendReport: value is true or false: true to send this report to the Live Connect server. False to
just create the report for viewing. The value defaults to false.

¢ hashValues: value is true or false: true to hash the values as md5/sha256. False to show values in
clear text — should use only for manual viewing. Defaults to false.

o startDate / endDate: Dates for time boundaries for log entries. Format: YYYY-MM-DD
HH:mm:ss

The following is an example of the URL used to retrieve query logs:

https://<server>/admin/liveconnect/force aggregation?startDate=2016-01-
18%2000:00:00&endDate=2016-01-19%2010:10:00&sendReport=false&hashValues=true

System Logging: Debug

To access debug information:

a4
1. Goto (Admin) > System > System Logging.
2. Select the Settings tab.

3. In the Package Configuration section, select com > netwitness > platform > server >
liveconnect > service (DEBUG).
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Info

System Logging

Updates -
Realtime Historical setings

Licensing
Ernail Package Configuration

Global Motifications @[ investigation

Legacy Motifications B[ list
B ]lve

B 5 liveconnect

I System Logging

Global Auditing

B service (DEBUG)
Jobs

U LiveConnectClient

Live Services

i LiveConnectloghggregatarService

URL Integration i LiveConnectLogParserService
Context Menu Actions ¥ LiveConnectlogRetrievalService
B malware

Investigation

HTTP Proxy Settings

Package com.rsasmecsaliveconnectservice
NTP Settings Log Level DEBUG v
Dashboard Settings [[] Reset recursively

2 admin | @B English (United States) | GMT+00:00
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Policy-based Centralized Content Management

This chapter covers different topics that lets you configure Policy-based Centralized Content
Management.

e About Policy-based Centralized Content Management (CCM)
e Enable or Disable CCM for All or Individual Services

e Manage Content Library

B Migrate Content from Core Services to Content Library

B Import Content to Content Library

B Create an Application Rule

B Clone Application Rule

B Edit Application Rule

B Delete Application Rule

B View Application Rule Details

B (Create a Network Rule
® Clone Network Rule

® Edit Network Rule

B Delete Network Rule

® View Network Rule Details
B Create an ESA Rule

® Edit an ESA Rule

B Delete an ESA Rule

B Filter Content Rules

* Manage Groups
B Create a Group
® View a Group
® Delete a Group
® Edit a Group
® Filter Groups
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e Manage Policies

B (Create and Publish Policies

® Clone a Policy
® Delete a Policy
® Edit a Policy

® View a Policy
B Enable Content for a Policy

® Disable Content for a Policy

B Filter Policies

B Filter Policy Content Details

B Merge Policy with ESA Content

e Manage ESA Datasources

B View an ESA Datasource
B Add an ESA Datasource
B Edit an ESA Datasource

B Delete an ESA Datasource

e Manage Deployments

® View a Deployment

® (Create a Deployment

® Edit a Deployment

® Start a Deployment

B Remove a Deployment

= Stop a Deployment

® Migrate ESA Deployments to Policies and Groups

¢ Appendix B: Position Tracking Information

e References

B Content Library Tab

®  Groups Tab

® Policies Tab

B Data Sources Tab

B Deployments Tab

* Appendix A: Endpoint Risk Scoring Rules
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e Appendix B: Position Tracking Information
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About Policy-based Centralized Content Management (CCM)

Legacy content management involves deploying and managing content in multiple places in the UL

o Live Content UI: Located under the Configuration interface, this allows a “push” deployment of Live
content to one or more services, but does not provide any management of content once it is deployed

» Service Config Ul: Located under Admin > Services > View Config, this Ul enables you to view,
edit or delete content on individual services.

Policy-based Centralized Content Management (CCM) is a unified approach to find, deploy, and manage
content through the entire life cycle based on policies that can be assigned to groups of devices. It is a
single location to view, modify and manage the content deployed across all services in the environment.

This approach consists of three elements:

e Groups: A collection of NetWitness services (such as Decoders, Log Decoders, and Correlation
Servers etc.) to assign and manage content.

» Content Policies: A container of content and subscription settings used to assign and manage content
within a Group.

o Content Library: A local repository of content which resides on the Admin Server and is used to
assign content to policies. This includes both Live and Custom content.

The Content Library contains Live content (synchronized with the Live CMS) and any custom content
you create or import. To deploy, remove or manage content on your services, content is assigned from
the Content Library to a Content Policy. Once that content policy is assigned to a group and Published,
the content changes are put into effect on the services within the group.
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Workflow
Content Policy Flow Diagram
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Benefits of Policy-based Centralized Content Management:
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* Add or remove content without repeating the process on each service.

e Add content from RSA Live or add your custom content into a single content repository. You can add
content from this repository to a policy.

e Add a new service to an existing group to automatically deploy all necessary content.
e One-click management of subscriptions and automatic updates

* Provides highly responsive and updated Ul for browsing RSA Live content that can help you with the
following:

® View Live content along with your content policies and click B 6 add content from Live.
® Seamlessly view Live content along with your custom content.
e Create and upload content to the Content Library easily by:
® [mporting log parsers as a zip file instead of converting to ".envision" format.
® Cloning existing Application Rules and Network Rules.

o Switch services between legacy Content Management Ul and the new Centralized Content
Management via Groups and Policies using the "toggle" feature. This can prevent content being
mistakenly added or modified outside of a Policy, causing an out-of-sync issue.

 Create, modify and publish policies and manage custom content in the Content Library even without
an internet connection.

» Find content, policies or groups of interest easily by using the Filtering capability of the UL

o Receives meta key and operator suggestions while creating Application Rule and Network Rule
conditions. This eases the creation of error-free rules.

o Manage ESA content and handle multiple deployments seamlessly using Policy.
o Seamlessly view ESA Live content along with your own custom content.
e Add and manage ESA Correlation servers as part of groups.

e Manage all the data sources for the ESA Correlation servers from the Settings > Event Stream
Analysis > Data Sources page seamlessly.

IMPORTANT: It is recommended not to use the Centralized Content Management and Service
Config page or Live Content page simultaneously for managing the content. Using the Service Config
UI to add or modify content can cause the content to become out-of-sync with the Content Policy.

Note: If Policy-based Centralized Content Management is enabled for a service, then the Policy-based
Centralized Content Management enabled services will be disabled in Live content UI and user will
not be able to manage content of these services from Service Config page as Service Config page
becomes read only and no actions except 'export' can be performed from Service Config page.
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Enable or Disable CCM for All or Individual Services

Prior to 12.1 version, content of the core services could be managed simultaneously either via Policy-
based Central Content Management (CCM) or Service Config page/Live content Ul. Managing content
in this way could cause policies to go out of sync with the actual content of the services.

From 12.1 version, by default, CCM is enabled to manage all services.

From 12.1.1 version onwards, single CCM toggle is introduced to enable or disable CCM for all 12.0+
Decoders and Log Decoders.

The toggle button is available via backend of source-server. Through the backend server, you can disable
or enable Policy-based Centralized Content Management (CCM) for an individual service.

When CCM is Enabled:

The service config page is read-only. Only Export button is enabled in service config page to export
content.

Content cannot be deployed to CCM enabled services through the Live Content UL

Content for all CCM enabled services can be managed through the Content Policies and the Content
Library.

Content subscription from CCM overrides content subscription from (CONFIGURE)
> Subscriptions page.

When CCM is Disabled:

Content can be deployed from Live Content UL

The content of the service can be managed from service config page. Any changes made through the
Service Config page does not reflect in the content policy.

The service is disabled in the Policy or Group page of CCM and the policy status changes to Partial.
The policy can be published with a disabled service. However, the policy state always remains
Partial. Publishing a policy will affect only the services that are enabled for CCM.

Note: When a service, which is part of a group, is added back to CCM, the policy status changes to
“Unpublished”.

How to Enable or Disable CCM for All Services

1.
2.

Connect through SSH to NW server node.

Run the following commands:

a. nw-shell

b. connect --service source-server
C. cd /rsa/central/service/

d. cd set-all-managed-by-legacy

€. invoke true
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Returns the message “Content of all Decoders & Log Decoders is centrally managed: No". This
message indicates that the CCM is disabled for all Decoder services.

f. invoke false

Returns the message “Content of all Decoders & Log Decoders is centrally managed: Yes". This
message indicates that the CCM is enabled for all Decoder services.

How to Enable or Disable CCM for Individual Services
Follow these steps to enable or disable CCM for individual services:

1. Connect through SSH to NW server node.

2. Run the following commands:

a. nw-shell

b. connect --service source-server
C. cd /rsa/central/service/

d. cd toggle-managed-by-legacy

€. invoke '<service name>'

example: invoke 'NWAPPLIANCE18845 - Log Decoder'’

Manage Content Library

This section contains:

» Migrate Content from Core Services to Content Library

e Import Content to Content Library

e Create an Application Rule

e Clone Application Rule

e Edit Application Rule

e Delete Application Rule

e View Application Rule Details

¢ (Create a Network Rule

e Edit Network Rule

¢ Delete Network Rule

* View Network Rule Details
* Create an ESA Rule

e Edit an ESA Rule

e Delete an ESA Rule

¢ Filter Content Rules
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Migrate Content from Core Services to Content Library

The customers who want to use Centralized Content Management, and if their content is already
deployed, a migration process is required.

Note:
- Existing Live content does not need to be exported or imported. All Live content will be available in
the Content Library and will only need to be added to one or more policies and published as needed.

- When the user upgrades a Decoder or Log Decoder from 11.x, 12.0 or 12.1 version to 12.1.1 version,
a back up of all the content is created automatically. Backup file will be available on Core Services'
host under the following path:

For Log Decoder - /var/netwitness/logdecoder/logdecoder backupcontent ccm.tar
For Network Decoder - /var/netwitness/decoder/decoder backupcontent ccm.tar

This process includes the following steps:

Make sure that the necessary Live content has been selected and applied to one or more Policies.
Enable subscriptions for Live content as desired.

Export any custom content, including Application Rules, Network Rules, Lua Parsers and Log
Parsers.

Import custom content into the Content Library.
Apply custom content to one or more Policies.

Create Groups to which Policies will be assigned.

Publish Policies to their assigned Groups.

Warning: Initially, when a Policy is published to a Group , all the content which are not included in
the policy will be removed from the services in that Group.

To migrate Application Rules or Network Rules

1.
2.

Q
Go to (Admin) > Services.
Go to Config view of the service where application rule or network rule is deployed.

Click either the Application Rule or the Network Rule tab.

Note: The Network Rule tab is only available for Network Decoder services.

Select the content to migrate.
Click Export to export the selected content or click All to export all the content.

Type a file name which contains exported content and import the content to Content Library.

For details on importing content to content library, view Import Content to Content Library topic.

The following table lists the supported file types and file extensions for Application Rules and Network
Rules:
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Supported File Types Supported File Extensions

Application Rules NWR NA

Network Rules NWR NA

To migrate Feeds, LUA Parsers, or Log Devices

The content file locations are as given below:
e Feeds content file location: /etc/netwitness/ng/feeds
e Lua Parsers content file location: /etc/netwitness/ng/parsers

¢ Log Devices content file location: /etc/netwitness/ng/envision/etc/devices

You can upload the files which are copied locally from these locations and import these files to Content
Library.

For details on importing content to content library, view Import Content to Content Library topic.

The following table lists the supported file types and file extensions for Log Devices, LUA Parsers and
Feeds:

Supported
Content | Supported File Types File
Extensions
Feeds .Zip feed and .token
Log .envision, .zip NA
Devices

Note: The zip file should have a root folder. The root folder should
contain the ‘N’ folders for ‘N’ number of content. The 'N' folder
names should be the content names. The ‘N’ folders, will contain
the respective xml files.

LUA .zip Juax, .lua and
Parsers flextoken

Note: Any imported content will be treated as custom content. If imported content has the same name
as existing Live content, then it must be renamed upon import. Custom content with the same name
can be overwritten.

To create .envision files

1. Keep all the Log Devices in a root folder in your local drive. For example, "logDevices".

2. From the command prompt, run the python script specified in the NetWitness Community portal with
input argument as the path of the above folder.

Note: The command to run the python script is "python3 pythonscriptname.py inputArg".
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3.

Once you run the script, a new zip named "nw_content_logDevices.zip" is created. This zip file will
contain all the envision files.

IMPORTANT: All actions except ‘Export’ are disabled for Application Rules, Network Rules, Feeds,
LUA Parsers and Log Devices from Service Config page for all core services if the service is managed
by Policy-based Centralized Content Management.

Import Content to Content Library

Before the custom content can be used in policies, it must be imported to the Content Library.

To view the list of supported file types and file extensions for different content types, refer Migrate
Content from Core Services to Content Library topic.

To import content to Content Library

1.

Go to IBl (CONFIGURE) > Policies.

. In the policies panel, click Content.

2
3.
4

In the left panel, click Content Library.

. Depending upon the type of content to be imported, click the following tabs:

o Application Rule
* Network Rule

+ LUA Parser

o Feeds

o Log Devices

Note: Log Devices content should be converted to .envision files before importing.

In the respective content panel, click Import.
In the Import panel, click or drag the file to upload.

Click Overwrite to overwrite content. This is applicable only in case of overriding an already
imported content.

Note: You can overwrite the content if the content name is the same as the custom content.
However, overwriting is not supported if the content name is the same as existing content of the
same type from the live server.

Select the medium types.

Click Import to complete the import process.

Create an Application Rule

This topic describes the steps to create an application rule.
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To create a new Application Rule
1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.
3. In the left panel, click Content Library.
The available rules are displayed.
4. In the application rule panel, click + Create Rule to add an application rule.
5. In the New Create Rule panel, do the following:

e Enter a unique rule name. If the name of that application rule is the same as an existing rule, an
error message is displayed.

o Enter the rule value. This is the value written to the alert meta. While creating a new rule, the rule
value is defaulted with the rule name. However, you can modify the same.

Note: This field is applicable only for 12.1.1 version.

¢ Enter the condition for the rule. You can apply two types of conditions for the rule.

® Normal mode:

o [t gives suggestions for supported metas (ip, host and so on) and operators (“=", “Not Equal
To”, “Contains”, “Exists” and so on).

o The entered condition will be enclosed in a ‘Pill’. When you enter multiple conditions, the
conditions are automatically joined by an ‘AND’ operator. On clicking the ‘AND’ operator,
you can toggle between ‘AND’ and ‘OR’ operators.

®  Advanced: You can customize the conditions as a free form text.

¢ Select the medium to be applied for the rule.

¢ Enter the description for the rule.

¢ Select the session data to be applied for the rule.

¢ Select the session options to be applied for the rule.

¢ Enter the meta value for the alert on. This is a mandatory field.

¢ Click Save to save the new application rule.

Clone Application Rule

This topic describes the steps to clone an application rule.

To clone an Application Rule

1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4

. The list of application rules is displayed. From the available list of rules, select the rule to be cloned.
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5. Click Clone Rule.
6. For 12.1 version, in the Clone Rule panel, do any of the following:

« Enter the name for cloned rule and click Clone to clone the rule.

o Click Cancel to cancel the operation.

7. For 12.1.1 version, in the Clone Rule panel, do any of the following:

o Enter a unique rule name. If the name of that application rule is same as an existing rule, an error
message is displayed.

Note: The rule value cannot be modified. You can clone existing rules to generate cloned rules
with different rule names but with same rule value.

« Enter the condition for the rule.

¢ Select the medium to be applied for the rule.

o Enter the description for the rule.

» Select the session data to be applied for the rule.

¢ Select the session options to be applied for the rule.

¢ Enter the meta value for the alert on. This is a mandatory field.
¢ Click Clone to clone the rule.

¢ Click Cancel to cancel the operation.

Edit Application Rule

When you edit the application rule, follow these guidelines:

e You can only edit the custom rules.
e The rule name cannot be edited if the custom rule is assigned to a policy.

 If the custom rule assigned to a policy is edited, then the customer must republish the policy for the
changes to take effect in the service.

To edit an Application Rule

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.

4. Select an application rule to edit.

5. Click Edit Rule to edit the application rule.

Delete Application Rule

When you delete the application rule, follow these guidelines:
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e You can delete only the custom application rules.

e You cannot delete the application rule if it is associated to a policy. You should first disassociate the
application rule from the policy and then delete it.

To delete an Application Rule

1. Go to IBl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Select an application rule to delete.
5

. Click Delete to permanently delete the selected application rule.

View Application Rule Details

This topic describes the steps to view the application rule details.

To view Application Rule details

[a——

. Goto (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
The list of application rules is displayed.

4. Click a row to view details about the selected application rule in the right panel.

The various details of the application rule are displayed.

Create a Network Rule

This topic describes the steps to create a network rule.

To create a Network Rule

1. Goto (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.

4. Click the Network Rule tab.

5. In the network rule panel, click + Create Rule to add a network rule.
6. In the New Create Rule panel, do the following:

e Enter a unique rule name. If the name of that network rule is the same as an existing rule, an error
message is displayed.

o Enter the rule value. This is the value written to the alert meta. While creating a new rule, the rule
value is defaulted with the rule name. However, you can modify the same.
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Note: This field is applicable only for 12.1.1 version.

¢ Enter the condition for the rule. You can apply two types of conditions for the rule.

® Normal mode:

o It gives suggestions for supported metas (ip, host and so on) and operators (“=", “Not Equal
To”, “Contains”, “Exists” and so on).

° The entered condition will be enclosed in a ‘Pill’. When you enter multiple conditions, the
conditions are automatically joined by an ‘AND’ operator. On clicking the ‘AND’ operator,
you can toggle between ‘AND’ and ‘OR’ operators.

®  Advanced: You can customize the conditions as a free form text.

Note: The medium is selected as Packet by default, and it cannot be modified.

¢ Enter the description for the rule.

¢ Seclect the session data to be applied for the rule.

¢ Select the session options to be applied for the rule.
¢ Click Cancel to cancel the operation.

¢ Click Reset to reset the data.

¢ Click Save to save the new network rule.

Clone Network Rule

This topic describes the steps to clone an application rule.

To clone an Application Rule

1.

Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3.
4. Click Network Rule tab.

In the left panel, click Content Library.

5. The list of application rules is displayed. From the available list of rules, select the rule to be cloned.

Click Clone Rule.

For 12.1 version, in the Clone Rule panel, do any of the following:

¢ Enter the name for cloned rule and click Clone to clone the rule.
¢ Click Cancel to cancel the operation.

For 12.1.1 version, in the Clone Rule panel, do any of the following:

o Enter a unique rule name. If the name of that network rule is same as an existing rule, an error
message is displayed.
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Note: The rule value cannot be modified. You can clone existing rules to generate cloned rules
with different rule names but with same rule value.

« Enter the condition for the rule.

Note: The medium is selected as Packet by default, and it cannot be modified.

o Enter the description for the rule.

¢ Select the session data to be applied for the rule.
¢ Select the session options to be applied for the rule.
¢ Click Clone to clone the rule.

¢ Click Cancel to cancel the operation.

Edit Network Rule

When you edit the network rule, follow these guidelines:

e You can only edit the custom rules.
e The rule name cannot be edited if the custom rule is assigned to a policy.

« If the custom rule assigned to a policy is edited, then you must republish the policy for the changes to
take effect in the service.

To edit a Network Rule

1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Click the Network Rule tab.

5. Select the network rule to edit.

6. Click Edit Rule to edit the network rule.

Delete Network Rule
When you delete the network rule, follow these guidelines:

e You can delete only the custom network rules.

» You cannot delete the network rule if it is associated to a policy. You should first disassociate the
network rule from the policy and then delete it.

To delete a Network Rule
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.
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4. Click Network Rule tab.
5. Select a network rule to delete.

6. Click Delete to permanently delete the selected network rule.

View Network Rule Details

This topic describes the steps to view the network rule details.

To view Network Rule details

1. Go to IBl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
4. Click the Network Rule tab.
5

. The list of network rules is displayed.

6. Click a row to view details about the selected network rule in the right panel.

The various details of the network rule are displayed.

Create an ESA Rule

This topic describes the steps to create an ESA rule.

To create an ESA Rule
1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Content Library.
The available rules are displayed.

4. Click Event Stream Analysis Rule.
5. In the ESA rule panel, click + Create Rule to add an ESA rule.

It navigates to ESA Rules > Rules view. For more information on creating new rules, see the section
Add a Rule Builder Rule.

Note: Analysts must have appropriate permissions to view the ESA rules under
(CONFIGURE) > ESA Rules and El (CONFIGURE) > Policies pages. For more information,
see the Source-server section in the "Role Permissions" topic in the System Security and User
Management Guide.

Edit an ESA Rule

This topic provides instructions to edit an Event Stream Analysis (ESA) rule. When you edit a rule, ESA
applies the updated criteria going forward. No changes are made to previously generated alerts.

For more information on editing an ESA rule, see Edit, Duplicate or Delete a Rule.
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Delete an ESA Rule

You can delete one or more ESA rules. Once the ESA rule is deleted, the ESA rule will be removed
from the available list.

To delete an ESA Rule
1. Go to IBl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. In the left panel, click Content Library.
The available rules are displayed.

4. Click Event Stream Analysis Rule.
The available ESA rules are displayed.

Note: Only Custom ESA rules that are not assigned to a policy will be available for deletion.

5. Select one or more custom ESA rules and click Delete.
A confirmation pop-up is displayed.
6. Click Delete.

Filter Content Rules

The Filters panel allows you to filter the list of displayed contents under the content library based on the
name, medium, date range, and source type.

This applies to the following content rule types:

e Feed

Application Rule

Log Device

Lua Parser

Network Rule

Event Steam Analysis Rule

Bundle

To filter the content rules
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. Click Content Library.
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4. By default, the filters panel is hidden, click the Bl (Filters) icon in the toolbar to expand the filters
panel.

NETWITNESS nve ¢ Files yashboard ports S =) % Q) dmin
LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES SERVICE TOPOLOGY
CONFIGURATION CONTENT

FEED  APPLICATION RULE  LOG DEVICE LUA PARSER ~ NETWORK RULE EVENT STREAM ANALYSIS RULE BUNDLE

X -+ CreateRule &, Import
POLICY NAME O NAME MEDIUM LAST UPDATED POLICIES
Equals I
0Test1 |Custom endpoint 07/26/202205:08:19 am TestADa.

MEDIUM 0Test2 | custom endpoint 07/26/2022 05:08:46 am TestADa

AWS - Critical changes to logging 09/14/202106:43:17 am TestADa.

LAST UPDATED DATE AWS - Network route modified 02/03/202204:26:14 pm TestADa... (+3)

AWS - Security group or network acl modified 02/03/202204:26:08 pm TestADadmin
AWS - VPC flow logs modified 02/03/202204:26:22 pm TestADadmin

PRI AWS - VPC modified log 02/03/202204:26:15 pm TestADadmin
Accesses Administrative Share Using Command Shell endpoint 04/10/2019 03:04:53 pm TestADa... (v

Activates BITS Job endpoint 04/10/2019 03:04:54 pm TestADa.

Adds Files To BITS Download Job endpoint 04/10/2019 03:04:55 pm TestADa... (+1)
Show next 50 content

Showing 50 out of 759 items | O selected

5. To search by policy name:

o Set the filter option to Contains operator from the drop-down list and start typing the name of the
policy. Type one character and a list of policies that contain that character is displayed, as you
continue to type the list is filtered to match.

o Set the filter option to Equals operator from the drop-down list and enter the full name. The
particular content type will be displayed.

6. To filter by medium, select one or more mediums from the Medium drop-down list. The options are
listed below:

« endpoint

* log

* log and packet
* packet

7. To filter by date range, under the Last Update date, select the start date and end date from the date
fields.

For example, to filter policies that were updated between July 1 and July 30, you select July 1 as the
start date and July 30 as the end date. You must enter dates in mm/dd/yyyy format or you click and
pick dates from a calendar.

8. To filter by source type, select one or more sources from the Source Type drop-down list. The
options are listed below:

¢ Custom

o Live

9. To hide, click the B icon at the top-right of the panel.
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The contents are displayed in the right panel according to the filter you selected. Click Reset to clear
the existing filter results.

Manage Groups
This section contains:

e Create a Group
* View a Group
e Delete a Group
» Edit a Group

* Filter Groups

Create a Group

You can create a group with one or more services and assign one policy to it. Groups may be created
without any assigned policy; however, a policy must be assigned to a group and Published in order for
any content changes to take effect.

To create a Group

1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Groups.

4. In the tool bar, click + Create New.

5. In the New Group panel, do the following:
¢ Enter the name of the group.
¢ Enter the description for the group.

6. Click Next.

7. In the Define Group, click + to assign services to the group.

Note:

- A service is disabled if it is assigned to another group.

- A service is disabled if it is not managed by Policy-based Centralized Content Management.

- ESA Services are not disabled when assigned to a group, as the ESA services can be assigned to
more than one group.

8. Click Next.

9. In the Assign Policies, click + to assign policies to a group. You can assign only one policy to any
particular group.
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10. Do any one of the following:
¢ Click Save and Publish to save and publish the settings.
° To publish all the content, click Publish All.
° To publish only the content that is not published on the service, click Publish Changes.
° To cancel the publish content dialog, click Cancel.

¢ Click Save and Close to save the settings.

View a Group

This topic describes the steps to view the properties of Group.

To view the properties of the selected Group

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Groups. The available groups are displayed.
4

Click a row to view details about the selected group in the right panel.

Caution: An icon ‘' is displayed in the Groups View indicating policy status unpublished, if any
services are part of the selected group and do not have any deployment then some of the associated
correlation services require ESA deployments.

NETWITNESS

4 Edit || (5 Publish || @ Delete

uire ESA Deployments
ESA Correlation

Delete a Group

You can delete one or more groups. Once the group is deleted, all services will be removed from the
group and all the policy content will be deleted from the services.
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To delete a Group
1. Go to IBl (CONFIGURE) > Policies.
2. In the policies panel, click Content.
3. Click Groups. The available groups are displayed.
4. Select one or more Groups and click Delete.
The Delete Groups dialog is displayed.

5. To delete the deployed content from the services upon deleting the group, select the option Delete
deployed content from the services on group removal. For ESA service, the content will be
deleted upon deleting the group.

6. Click Delete to permanently delete the selected group.

The confirmation message is displayed.

Note:

- For a group with multiple services, even if we fail to delete a particular service under the group,
the other services will get deleted. The service which is not deleted will be in Failed state.

- The group status changes to Failed if group deletion fails for any particular reason.

Edit a Group

You can edit the properties of the group at any point in time. The status of the updated group is
unpublished if you change the service or policies in a group. If you just change the group name and
description, then the status remains published (if it is already published).

To edit the selected Group
1. Go to Bl (CONFIGURE) > Policies.
. In the policies panel, click Content.

. In the left panel, click Group. The available groups are displayed.

2

3

4. Select a group to edit and click Edit.

5. Make the required changes in the group.
6

. Do any one of the following:

¢ Click Save and Publish to save and publish the policy.

Note:

- While removing a service from the group, you can opt to either delete the content of the
service and remove the service or just remove the service from the group.

- While removing the group from the policy, the ESA content will be deleted by default.

* The policy will be listed under the Unpublished category.

¢ Click Save and Close to save the settings and return to the Policies view.
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Filter Groups

The Filters panel allows you to filter the list of displayed groups based on the group name, policy status,
services, and policies.

To filter the groups
Go to Bl (CONFIGURE) > Policies.

—_

2. In the policies panel, click Content.
Click Groups.

4. By default, the filters panel is hidden, click the B#l (Filters) icon in the toolbar to expand the filters
panel.

NETWITNESS Investig ! 0s )ashbo: Repot
LIVE CONTENT SUBSCRIPTIONS ~ CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS
CONFIGURATION ~ CONTENT

¢ t X + Create New
GROUP NAME GROUP NAME *  DESCRIPTION SERVICES POLICIES POLICY STATUS
Equals
ESAGrp esaaprimary - ESA Correlation Unpublished
POLICY STATUS G1 esaaprimary - ESA Correlation Unpublished
G2 esaaprimary - ESA Correl...
G3 esaaprimary - ESA Correlation
both-esa esaaprimary - ESA Correl...

POLICIES core-decoder packethybrid - Decoder policy-4 Published

core-logdecoder endpointloghybrid1 - Log De... (+1) None N/A

esa-1 esaaprimary - ESA Correlation Failed
esa2 esasecondary - ESA Correlation Published
833 esasecondary - ESA Correlation N/A

newEsaGroup esaaprimary - ESA Correl... (+1) N/A

Showing 11 out of 11 items | Oselected
5. To search by group name:

« Set the filter option to Contains operator from the drop-down list and start typing the name of the
group. Type one character and a list of groups that contain that character is displayed, as you
continue to type the list is filtered to match.

o Set the filter option to Equals operator from the drop-down list and enter the full name. The
particular group will be displayed.

6. To filter by policy status, select one or more statuses from the Policy Status drop-down list. The
options are listed below:

o Published: Policies that are published to use.

o Unpublished: Policies that are saved but not published.

o Failed: Policies that are failed to publish.

* N/A: Policies for which publication status is not applicable.

7. To filter by services, select one or more services from the Services drop-down list. For example, Log
Decoder.
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8. To filter by policies, select one or more policies from the Policies drop-down list. You can also
search for the name of the policies from this list.

9. To hide, click the H icon at the top-right of the panel.

The groups are displayed in the right panel according to the filter you selected. Click Reset to clear
the existing filter results.

Manage Policies

Policies contain content and subscription settings used to assign and manage content within a Group.

IMPORTANT: The customers should note that, while publishing the first policy to a service, all
previous content except custom feeds, will be deleted. Ensure that all custom content are migrated to
Content Library before publishing the first policy.

This section contains:

e (Create and Publish Policies

* Clone a Policy
* Delete a Policy
» Edit a Policy

* View a Policy
e Enable Content for a Policy

e Disable Content for a Policy

e Subscribe Content for a Policy

¢ Unsubscribe Content for a Policy

e Filter Policies

¢ Filter Policy Content Details

e Merge Policy with ESA Content

Create and Publish Policies

You can create a policy and assign it to one or more groups.

To create a Policy

—_—

. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.

3. Click Policies.

The available policies are displayed.

4. Click + Create New to add a new policy.

142


../../../../../../Content/2-Configuration/Live/CCM/Subscribe Content for a Policy.htm
../../../../../../Content/2-Configuration/Live/CCM/UnsubscribeContentforaPolicy.htm

Live Services Management Guide

. In the New Policy panel, do the following:
¢ Enter a unique policy name.

¢ Enter a description for the policy.

. Click Next.

. In the Available Content, select the content type and click + to add the content to the policy. After
you add the content, you can enable subscription (if required) by clicking subscribed toggle. Once the
content is subscribed the updates are pushed automatically.

Note: Subscription is not allowed for custom content.

METWITHESS

Note:

- All the dependencies are added automatically for the selected content. You can click on the
content name highlighted in blue and look for details such as content description, content type,
resources and dependencies and so on. You can also add and subscribe the resource from the
details view.
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A caution icon is displayed to create a deployment on three scenarios.

o To implement the Event Stream Analysis Rule content type, you must have a deployment.

NETWITNESS Investig, ] I Dashboard 2epor

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES

demoPolicy Define Policy - demoPolicy

@ For an Event Stream Analysis Rule content type, deployments are required.
To know more about how to create deployments

Available Content Selected Content

< Filters All the dependencies are added automatically for the selectec

am Analysis Rule €
MEDIUM  CREATED LASTUPDATED  SUBSCRIPTION (AL

log 06/16/2015...  04/10/201904.. @ ®

log 08/12/2015...  07/22/201908.. @) ®

Previous Next Save and Close Save and Publish Cancel

o All groups that have correlation server service must have a deployment.
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LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES ~ POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  SERVICE TOPOLOGY

demoPolicy Assign to Groups - demoPolicy

ups to the policy. A group s d
All groups that have Correaltion Server service require deployments.

‘ - To know more about how to create deployments
entify Policy

roup Lis Selected Groups
Gi List Selected G
Define Policy
GROUP NAME POLICIES SERVICES ACTION

demoGroup © demoPolicy ESAPrimary - ESA Correlation ®

Previous ‘ ‘ Save and Close Save and Publish Cancel

o For any selected policy with an ESA rule, deployment are must be created.

NETWITNESS

LIVE CONTENT 10NS 5 POLICIES > v s SARULES  CUSTOM FEEDS

rolden-test Assign Policy
) For aselected policy with an Event Stream Analysis rule, deployments must be created.

To know more about how to create deployments

DESCRIPTION GRoups AcTioN ESCRIPTION GrouPs

rolden-test

Previous Saveand Close Saveand Publish Cancel

To create and manage deployments, refer to feature.

8. In the Group List, click + to assign groups to the policy.

Note: A group is disabled if another policy of the same type is already assigned to this group.

9. Click Save and Publish to save and publish the settings.

IMPORTANT: Once the publish is successful, you can view only the published content on the
service while publishing the policy for the first time.
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Note:

- While publishing the first policy to a service, all previous content except custom feeds, will be
deleted. Ensure that all custom content are migrated to content library before publishing the first
policy.

- You can also publish a policy from Policy Details screen. For more information on publishing a
policy from Policy Details screen, refer View a Policy feature.

10. Click Cancel to cancel the publish content dialog.

11. Click Save and Close to save the settings.

IMPORTANT:

When first applying a Content Policy to manage content, the existing Live and custom content on the
service (excluding Custom Feeds) will be removed and replaced with the Policy content. You should
compare the existing service content with the policy before applying to ensure required content is
added to the policy. Endpoint risk scoring requires certain application rules. Refer Endpoint Risk
Scoring Rules to view the list of these application rules.

Clone a Policy

When you clone a policy, all the content from the old policy is copied to the new policy. The cloned
policy can be assigned to a new group. You can clone only one policy at a time.

To clone a Policy

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies. The available policies are displayed.
4

. Select a policy to clone and in the More actions drop-down list in the tool bar, click Clone.

The policy is cloned successfully.

Delete a Policy

Deleting a policy removes all content from the associated group.

To delete a Policy

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies. The available policies are displayed.

4. Select one or more policies and in the More actions drop-down list in the tool bar, click Delete.
The Delete Policies dialog is displayed.

5. To delete the deployed content from the group’s services upon deleting the policy, select the option
Delete deployed content from the group's services on policy removal. For ESA service, the
content will be deleted upon deleting the policy.

6. Click Delete to permanently delete the selected policy.
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Deletion will take immediate effect and the policy will no longer be available in any group.

Note:

- The services associated with this policy still require a restart if the restart is pending.

- You can also delete a policy from Policy Details screen. For more information on deleting a
policy from Policy Details screen, refer View a Policy feature.

- The policy status changes to Failed if policy deletion fails for any particular reason.

Edit a Policy

You can edit the content and settings of the policies. Once the policy is edited, the changes in the policy
are reflected upon saving the policy. The changes are applied to the service once published. After saving
and before publishing, the publication status of the changed policy is set to Unpublished if any settings

are changed.

To edit a Policy
1. Go to Bl (CONFIGURE) > Policies.

. In the policies panel, click Content.

. Click Policies. The available policies are displayed.

2
3
4. Select a policy to edit and click Edit.
5. Make the required changes in policy.
6. Do any one of the following:

¢ Click Save and Publish to save and publish the policy. The policy will be listed under the
Unpublished category.

Note:

- While removing a group from the policy, you can either delete the content of the service and
remove the group or just remove the group from the policy.

- While removing the group from the policy, the ESA content will be deleted by default.

¢ Click Save and Close to save the settings and return to the Policies view.

Note: You can also edit a policy from Policy Details screen. For more information on editing a policy
from Policy Details screen, see View a Policy feature.

View a Policy
This topic describes the steps to view the properties of a Policy.
To view properties of the selected Policy

1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
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3. Click Policies. The available policies are displayed.

Caution: An icon ! is displayed in the Policy View indicating policy status unpublished, if any
services are part of the selected policy and do not have any deployment then some of the associated
correlation services require ESA deployments.

NETWITNESS

© Edit (5 Publish $ MoreActions v/ ABCD

& PublishPolicy || (£ EditPolicy || @ ViewDetails
A8cD

& Settings ] rolden-test

Event Stream Analysis

4. From the policy listing page, you can perform the following actions:

o Select a policy and click Edit to edit the policy. For more information on editing a policy, seeEdit
a Policy feature.

o Select the policy and click Publish to publish the policy if the policy is unpublished.
o Select the policy and click More Actions > Assign to Groups to assign policy to available group.

o Select the policy and click More Actions > Clone to clone the policy. For more information on
cloning a policy, seeEdit a PolicyClone a Policy feature.

» Select the policy and click More Actions > Delete to delete the policy. For more information on
deleting a policy, see Delete a Policy feature.

o Select the policy and click More Actions > Force Publish to force publish the policy. This action
allows you republish all the content irrespective of the policy status.

5. Click a row to view details about the selected policy.

6. To change the order of application rule assigned to the policy, do the following:

1. To move the application rule or network down the order, click B in the Order column.

2. To move the application rule up the order, click BN in the Order column.

3. You can also manually enter the order number in the Order column.
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7. To change the order of network rule assigned to the policy, do the following:

1. Click Network Rules tab.

2. To move the network rule or network down the order, click ™ in the Order column.

3. To move the network rule up the order, click B in the Order column.

4. You can also manually enter the order number in the Order column.

IMPORTANT: It is recommended not to order application rules or network rules deployed on the
service from Service Config page if the service is part of Centralized Content Management.

From the policy details page, you can perform the following actions:

o To edit the policy, click Edit Policy. For more information on editing a policy, see Edit a Policy
feature.

o To delete the policy, click Delete Policy. For more information on deleting a policy, see Delete a
Policy feature.

o To publish the policy, click Publish Policy. For more information on creating and publishing a
policy, see Create and Publish Policies feature.

o To force publish a policy, click Force Publish. This action allows you republish all the content
irrespective of the policy status.

e To enable or disable subscription, click Subscribe or Unsubscribe respectively.

Note:

- Subscription is not allowed for custom content.

- The Subscribe and Unsubscribe button is disabled if any one of the content selected is
custom.

Enable Content for a Policy

This topic describes the steps to enable the content for a Policy.

To enable content

1.

Go tolBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. In the left panel, click Policies.

4.
5

Click the policy name to view the policy details.

. In the Application Rule, Network Rule, Feed, Log Device or LUA Parser panel, click the row to

select the content to be enabled. You can either select all content or select any specific content to be
enabled.

Click Enable.

Disable Content for a Policy

This topic describes the steps to disable the content for a Policy.
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To disable content

1. Go tolBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. In the left panel, click Policies.

4. Click the policy name to view the policy details.
5

In the Application Rule, Network Rule, Feed, Log Device or LUA Parser panel, click the row to

select the content to be disabled. You can either select all content or select any specific content to be
disabled.

6. Click Disable.

Filter Policies

The Filters panel allows you to filter the list of displayed policies based on the name, policy status, date
range, and groups.

To filter the policies

1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

3. Click Policies.

4. By default, the filters panel is hidden, click the kil (Filters) icon in the toolbar to expand the filters

panel.

NETWITNESS v g F ] Hosf Files yashboard por
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CONFIGURATION ~ CONTENT

+ DESCRIPTION GRrOUPS POLICY STATUS  LAST UPDATED UPDATED BY
Equals
esa-1 Failed 2022/08/29 11:28:49...  admin

PoL TATUS EsAGrp ( E Published 2022/08/24 12:36:02 ..

Unpublished 2022/08/22 06:05:54 ..

Published 2022/08/30 08:00:09

5. To search by name:

» Set the filter option to Contains operator from the drop-down list and start typing the name of the
policy. Type one character and a list of policies that contain that character is displayed, as you
continue to type the list is filtered to match.
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o Set the filter option to Equals operator from the drop-down list and enter the full name. The
particular policy will be displayed.

6. To filter by policy status, select one or more statuses from the Policy Status drop-down list. The
options are listed below:

o Published: Policies that are published to use.

o Unpublished: Policies that are saved but not published.

o Failed: Policies that are failed to publish.

» N/A: Policies for which publication status is not applicable.

7. To filter by date range, under the Last Update date, select the start date and end date from the date
fields.

For example, to filter contents that were updated between July 1 and July 30, you select July 1 as the
start date and July 30 as the end date. You must enter dates in mm/dd/yyyy format or you click and
pick dates from a calendar.

8. To filter by groups, select one or more groups from the Groups drop-down list. You can also search
for the name of the groups from this list.

9. To hide, click the E icon at the top-right of the panel.

The groups are displayed in the right panel according to the filter you selected. Click Reset to clear
the existing filter results.

Filter Policy Content Details

The Filters panel allows you to filter the list of displayed content in the policy details view based on the
name, medium, source type, enabled/disabled status, subscription status, a resource created date, and last
updated date.

This applies to the following content types:
o Feed

e Application Rule

e Log Device

o Lua Parser

» Network Rule

» Event Steam Analysis Rule

e Bundle
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To filter policy content details
Go to Bl (CONFIGURE) > Policies.

—

In the policies panel, click Content.

Click Policies. The available policies are displayed.

Sl

Do one of the following:
o Click a policy name.
o Click a row to view details about the selected policy and click View Details.

The policy details view is displayed.

NETWITNESS v g eSpon( € € Dashboard por

LIVE CONTENT  SUBSCRIPTIONS ~ CAPTURE POLICIES ~ POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  SERVICE TOP

< TestADadmin

DESCRIPTION ~ GROUPS POLICYSTATUS  LASTUPDATED CREATEDON CREATEDBY
- TestADGRp Published 08/03/2022 09:06:27 pm 08/03/202209:06:27 pm  jrice

& Publish Policy 4 EditPolicy @ Delete Policy Force Publish

FEED (1)  APPLICATION RULE (12)  LOG DEVICE (0)  LUA PARSER (3)  NETWORK RULE (0)  EVENT STREAM ANALYSIS RULE (15)  BUNDLE (0)

NAME
Contains NAME MEDIUM LAST UPDATED SUBSCRIPTION STATUS
OTest1 Custom endpoint 07/26/2022 05:08:19 am Unsubscribed Enabled
MEDIUM
OTest2 | custom endpoint 07/26/2022 05:08:46 am Unsubscribed Enabled
AWS - Network route modified log 02/03/2022 04:26:14 pm Unsubscribed Enabled
AWS - Security group or network acl modified 02/03/2022 04:26:08 pm Unsubscribed Enabled
AWS - VPC flow logs modified log 02/03/2022 04:26:22 pm Unsubscribed Enabled
ENABLED/DISABLED STATUS
AWS - VPC modified log 02/03/2022 04:26:15 pm Unsubscribed Enabled

Accesses Administrative Share Using Command Shell  endpoint 04/10/2019 03:04:53 pm Unsubscribed Enabled

Activates BITS Job endpoint 04/10/2019 03:04:54 pm Unsubscribed Enabled

Showing 12 out of 12 items | O selected

5. By default, the filters panel is hidden, click the Bl (Filters) icon in the toolbar to expand the filters
panel.

6. To search by name:

o Set the filter option to Contains operator from the drop-down list and start typing the name of the
content rules. Type one character and a list of content rules that contain that character is displayed,
as you continue to type the list is filtered to match.

o Set the filter option to Equals operator from the drop-down list and enter the full name. The
particular content type will be displayed.

7. To filter by medium, select one or more mediums from the Medium drop-down list. The options are
listed below:

o endpoint

* log

* log and packet
+ packet
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10.

11.

12.

13.

To filter by source type, select one or more sources from the Source Type drop-down list. The
options are listed below:

¢ Custom
e Live

To filter by enabled/disabled status, select one or more statuses from the Enabled/Disabled Status
drop-down list. The options are listed below:

o Enabled
o Disabled

Note: Enabled/Disabled Status filtering is not applicable to Event Stream Analysis Rule content.

To filter by subscription status, select one or more statuses from the Subscription drop-down list.
The options are listed below:

¢ Subscribed
¢ Unsubscribed

To filter by a resource created date range, under the Resource Created Date, select the start date and
end date from the date fields.

For example, to filter contents that were created between July 1 and July 30, you select July 1 as the
start date and July 30 as the end date. You must enter dates in mm/dd/yyyy format or you click and
pick dates from a calendar.

To filter by date range, under the Last Update date, select the start date and end date from the date
fields.

For example, to filter contents that were updated between July 1 and July 30, you select July 1 as the
start date and July 30 as the end date. You must enter dates in mm/dd/yyyy format or you click and
pick dates from a calendar.

To hide, click the H icon at the top-right of the panel.

The contents are displayed in the right panel according to the filter you selected. Click Reset to clear
the existing filter results.

Merge Policy with ESA Content

From the 12.1 version, the ESA content is managed through the (CONFIGURE) > Policies page.
After you upgrade to the 12.1 version, all the existing ESA deployments will be migrated to the policies
and groups view. The Merge Policy button will be available only for the policy having ESA content and
can only be merged with a policy with no ESA content.

Note: On merging a policy with another policy, the original policy gets deleted, and the other policy
gets updated with the original policy content.
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To merge Policy with an ESA Content
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. Select a policy having ESA content to merge with another policy.
The selected policy with ESA content view is displayed.

NETWITNESS v gal € Host € [BEI por

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS OG PARSER RULES  SERVICE TG

< pi

DESCRIPTION ~ GROUPS POLICYSTATUS  LASTUPDATED CREATED ON CREATEDBY
- ESAGrp (1) Published 2022/08/24 12:36:02 pm 2022/08/12 10:21:56 am admin

& Publish Policy @ Edit Policy T Merge Policy @ Delete Policy Force Publish

FEED (0)  APPLICATION RULE (0)  LOG DEVICE (0)  LUA PARSER (0) NETWORK RULE (0)  EVENT STREAM ANALYSIS RULE (4)  BUNDLE (0)

RULES  DEPLOYMENTS

%

NAME MEDIUM VERSION CUSTOM RULE LAST UPDATED SUBSCRIPTION

SAMPLE - P2P Software as Detected by an Intrusion Dete... | Cus log and packet True 2022/08/10 12:40:53 pm Unsubscribed

advanced-1 Custom log and packet True 2022/08/12 06:35:58 am Unsubscribed

regression-1 | Custom log and packet X True 2022/08/1206:14:21am Unsubscribed

Excessive Denied Inbound Traffic Followed By Permit By Source P log False 2019/03/18 04:56:27 pm Subscribed

4. Click Merge Policy.
The Merge Policy dialog is displayed.

DESCRIPTION  GROUPS POLICYSTATUS  LASTUPDATED cReATEDON creaTEDBY
Delete Policy Force Publish
Merge Policy

Select a policy from below to merge with the selected policy: p1

policy-4

NAME MEDIUM LAST UPDATED SUBSCRIPTION

Cancel |

Tr

5. Select a policy from the list or search for the name and Click Merge.
A confirmation pop-up is displayed.
6. Click Confirm.

Manage ESA Datasources

This section contains:

154



Live Services Management Guide

e View an ESA Datasource
Add an ESA Datasource
Edit an ESA Datasource

¢ Delete an ESA Datasource

View an ESA Datasource
This topic describes the steps to view the ESA datsources available.

To view an ESA Datasource

1. Go to Bl (CONFIGURE) > Policies.
2. In the policies panel, click Content.
Under Settings, click Event Stream Analysis > Data Sources.

The available datasources are displayed.

NETWITNESS vestigate espol Jser ost € yashboar( epor (o]

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES ~ POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES ~ SERVICE TOPOLOGY
CONFIGURATION ~ CONTENT

DATA SOURCES

+ Add Datasource
Groups (11)
O  NAME ADDRESS TRUSTED AUTHENTICATION COMPRESSION

© Settings O loghybrid1- Log Decoder true rue false

Event Stream Analysis
i O loghybrid1-Concentrator false rue false

Add an ESA Datasource

You can add one or more ESA data sources, such as Concentrators, to use for your selected ESA
Service. This enables you to specify different data sources for each deployment.

To add an ESA Datasource
1. Go to IBl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3. Under Settings, click Event Stream Analysis > Data Sources.
4. Click + Add Datasource.

The Add New Datasource dialog is displayed.
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Add New Datasource

Select a service from the following

NAME NAME ADDRESS TYPE

TRUSTED AUTHENTICATION COMPRESSION

packethybrid - Concentrator Concentrator o

endpointloghybrid1 - Concentr. Concentrator falee

decoder - Decoder Decoder

packethybrid - Decoder Decoder

endpointloghybrid1 - Log Deco... Log Decoder

Continue to configure the service Cancel

Note: You can add a Log Decoder as a data source for ESA. But, it is better to add a Concentrator

to take advantage of undivided aggregation as the Decoder may have other processes aggregating
from it.

5. Select a service and click Continue.

Note: You can add only one service at a time.

Add New Datasource

+ Add Datasource ! it

e O Trusted Authentication @ TRUSTED AUTHENTICATION S
f ide nti s
USERNAME fal

Cancel Back

6. Do one of the following:

o Select the Trusted Authentication checkbox.

o Enter your credentials (username and password) for the datasource.

Note:

- If you select Trusted Authentication instead of username and password. This option will
enable the use of SSL by default. However, you can still configure the compression settings.

- If you choose to enter your username and password. You can configure both SSL and
compression settings.

7. To enable the SSL settings, select the SSL checkbox. You can set your desired port number.
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8.

10.

IMPORTANT: Ensure that you turn on SSL only if necessary, in order to avoid performance
impact on the SSL protocol.

(Optional) You have the option to adjust the Compression Level for Concentrators on ESA. To
enable compression, select the Compression checkbox. You can set the Compression Level for a
Concentrator from 0-9:

¢ Compression Level = 0 (If compression is enabled, it allows Core Services to control the amount
of compression.)

¢ Compression Level = 1 (It uses the lowest amount of compression and has the highest
performance.)

e Compression Level =9 (It uses the highest amount of compression and has the worst
performance.)
Somewhere in the middle between 1 and 9 is usually the best setting, which is what you get when

you select a compression level of 0. For more detailed information, see the Core Database Tuning
Guide.

Note: When you set the compression level for a Concentrator on ESA, it sets the same
compression level for that Concentrator for ESA Correlation Rules.

Click Test Configuration to make sure that it can communicate with the ESA service.

Click Save.

After you configure your data sources and they appear in the Available Configured Data Sources
dialog, you can use them for your deployment.

Edit an ESA Datasource

You can edit the properties of the datasource at any point in time. You can edit the user credentials, SSL,
port, and compression value of the datasource. When a data source password changes, it is important to
change the password on the data source so that ESA can continue to communicate with the data source.

To edit an ESA Datasource

1.

Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
3.
4

Under Settings, click Event Stream Analysis > Data Sources.

Select a datasource and click Edit Datasource.

The Edit Datasource dialog is displayed.
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Edit Datasource

Cancel Save

5. Make the required changes in the datasource.

6. Click Save.

Delete an ESA Datasource

You can delete one or more ESA datasources. Once the datasource is deleted, the service will be
removed from the available configured list.

To delete an ESA Datasource
1. Go to IBl (CONFIGURE) > Policies.

. In the policies panel, click Content.

2
3. Under Settings, click Event Stream Analysis > Data Sources.
4

Select a datasource and click Delete Datasource.
A confirmation pop-up is displayed.
5. Click Delete Datasource.

Manage Deployments

The ESA deployment consists of a policy with ESA rules, ESA services, and data sources. The ESA
service scans your network for suspicious activity whenever you deploy policies. An ESA rule detects a
different event every time, such as when a user account is created and deleted within 24 hours.

In addition, you can perform other steps on your deployment, such as changing a data source, editing or
deleting a rule from the deployment through policy, renaming or deleting the deployment, or showing
updates to the deployment, see Additional ESA Correlation Rules Procedures

In 12.1 and later versions, you must create a policy with the ESA rule content type and associate the
policy with the group having a correlation service to create a deployment.

For more information on policies, see Policies

For more information about groups, see Groups
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Note: With the unified ESA Deployments tab, you can manage deployments from a single view across
all policies within Policy-based Centralized Content Management (CCM).

You can do the following:

View a Deployment

Create a Deployment

Edit a Deployment

Start a Deployment

Remove a Deployment

Stop a Deployment

Migrate ESA Deployments to Policies and Groups

View a Deployment

In the ESA deployment view, you can view a list of all the deployments associated with the policies and
the actions you can perform with them. It helps you manage and set-up deployments within CCM to
create, edit, deploy, remove, and stop deployments. NetWitness Platform XDR provides two methods to
manage deployments.

You can view deployments in the following ways:

Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can create, edit, remove, and pause deployments.

Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and create, edit, remove and pause a deployment.

To view all deployments using the ESA Deployments tab

1. Goto (CONFIGURE) > Policies > Content.
2. Under Settings, click Event Stream Analysis > ESA Deployments.

The available deployments are displayed.
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NETWITNESS Investigat Respor se s Fil Dashboard  Reports g 3

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES SERVICE TOPOLOGY
CONTENT
Content Library ESA DEPLOYMENTS DATA SOURCES
Policies (2)
—. Y | + Create
O NAME POLICY NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED

@ Settings
knjb new-policy ESA-primary - ESA Correlation ~ None Failed 12/08/2022 05:0..

Event Stream Analysis
new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New A& 12/08/2022 05:..
new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022
new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New & 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022
new-policy ESA-primary - ESA Correlation ~ None New A 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New & 12/08/2022 05:0...
new-policy ESA-primary - ESA Correlation ~ None New A& 12/08/2022
new-policy ESA-primary - ESA Correlation  None New A 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New & 12/08/2022 05:0...
new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022

new-policy ESA-secondary - ESA Correlat... None New A 12/08/2022 05:0...

Showing 14 out of 14 items 0O selected

To view a deployment from a selected policy

1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.

The available policies are displayed.

3. Click a Policy.

The selected policy view is displayed, and the Application Rule is default selected.
4. Click Event Stream Analysis Rule > Deployments.

The available deployments for the selected policy are displayed.

Caution: An icon ‘ is displayed in the deployments view indicating services require
deployments, publish policy will fail for correlation servers. You may need to create deployments
for such services if required.
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NETWITNESS

LE (0)  EVENT STREAM ANALYSIS RULE (2)  BUNDL

e deployments, Publish policy willfail for correlationserver

Create a Deployment

When you create a deployment, you need to select a policy, ESA service, and data sources. An ESA rule
deployment consists of an ESA service, one or more data sources, and a set of ESA rules. When you
deploy rules, the ESA service runs them to detect suspicious or undesirable activity in your network.
Each ESA rule detects a different event, such as when a user account is created and deleted within one
hour.

For more information on data sources, see Data Source

In 12.1 and later versions, you must create a policy with the ESA rule content type and associate the
policy with the group having a correlation service to create a deployment.

For more information on policies, see Policies
You can create deployments in the following ways:

» Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can create deployments.

o Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and create a deployment.

Prerequisites

o The group is assigned to a policy.
o The Correlation server service is available in the groups assigned.

e A minimum of one ESA rule is added to the policy.

o ESA data source must be configured.

161


https://community.netwitness.com/t5/netwitness-platform-online/data-sources-tab/ta-p/688899
https://community.netwitness.com/t5/netwitness-platform-online/about-policies/ta-p/685733

Live Services Management Guide

For more information about groups, see Groups

To create a deployment using the ESA Deployments tab

1. Go to Bl (CONFIGURE) > Policies > Content.
2. Under Settings, click Event Stream Analysis > ESA Deployments.

The available deployments are displayed.
3. Click + Create

NETWITNESS
LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES  CUSTOM FEEDS  LOG PARSER RULES
CONFIGURATION ~ CONTENT

Content Library ESA DEPLOYMENTS D

Policies (1)

S—
Create a deployment to associate a group of Event Stream Analysis rules

. POLICY NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED
@ Settings

demoDeploy demoPolicy ESAPrimary - ESA Correlation  PacketHybrid - Concentrator Deployed 12/26/202212:1...
Event Stream Analysis
demoDeploy2 demoPolicy ESAPrimary - ESA Correlation ~ None Failed 12/26/2022 12:0...
demoDeployStopped demoPolicy ESAPrimary - ESA Correlation  PacketHybrid - Concentrator Stopped 12/26/202211:5...

demoDeployMultipleDatasou...  demoPolicy ESAPrimary - ESA Correlation  PacketHybrid - Concentrator Deployed A 12/26/2022 11:5...

Showing 4 out of 4 items | Oselected

The Create Deployment dialog is displayed.
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NETWITNESS Investigate Responc Users  Hosts  Files  Dashboard  Reports o] ¥ O

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  SERVICE TOPOLOGY

te Deployment

PoLicY

DEPLOYMENT NAME
ESA SERVICE

DATA SOURCES
Add data sources to configure the data relevant to this deployment

+ “ﬂ Set Position Tracking Information

DATASOURCE NAME

DATA SOURCE FILTER
To improve performance,add a filter query to forward only the data relevant to this deployment

~+ Create Data Source Filter

FILTER QUERY

Cancel |

4. Select an eligible policy from the policy list.

Note: All the policies that meet the criteria mentioned above are listed in the policy drop-down
required to select a policy to proceed further.

If required, you can click on View ESA Rules to search for rules associated with selected policy.

NETWITNESS

POLICIES

demoPolicy

ESA rules associated with selected Policy
aws

NAME MEDIUM SUBSCRIPTION

AWS Critical VM Modified log Unsubscribed

DATASOURCE NAME

—+ Create Data Source Filter

Cancel
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5. Enter a name for the deployment.

6. Select a service from the ESA Service drop-down list.

Note: Once the deployment is saved, the selected policy, name and ESA service cannot be modified.

7. Under Data Sources, click + to add a data source.

The Add Data Source dialog is displayed.

NETWITNESS

Add Data Source

Select v

O Select All

O log-hybrid - Concentrator

| Cancel

- Create Data Source Filter

8. Select one or more data sources and click Done.

IMPORTANT: If the data sources are not listed, you can add the required datasource. For more
information, see the topic Add an ESA Datasource.

9. To delete the data source, select the data source and click .
10. (Optional) Select the required data source and click Set Position Tracking Information to process
specific or ignore certain sessions.

The Set Position Tracking Information dialog is displayed.
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Session ID

SESSION ID

a. In the Position Tracking Information dialog, perform the following:
i. If you want to set the position tracking information based on date and time stamp:
In the Go To drop-down menu, select Date and Time and enter the date and time.
ii. If you want to set the position tracking information, based on the session ID:

In the Go To drop-down menu, select Session ID and enter the session ID in the Session ID
field.

The ESA Correlation service starts processing the events from the session ID that you
entered.

b. Click Calculate Sessions to calculate the number of sessions that will be processed to the
existing position of the data source, if any.

c. To save the edited position tracking data source, click Save.

For more information on Position Tracking Information, see Appendix B: Position Tracking
Information.

11. (Optional) To filter out specific session data coming into ESA, under Data Source Filter, click +
Create Data Source Filter.

Caution: The data source filter is for advanced users familiar with Decoder application rules.
Improper filtering can cause the required data not to be forwarded to and analyzed by ESA.

The Create Data Source Filter dialog is displayed.
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NETWITN

= tion: | he data source filter is
esasecondary - ESA Correlation o

Jata to not be f

cking Information

DATASOURCE NAME

brid1 - Concentrator

a. Specify the filter query in the below format as shown in the following example:

Select *where service = 443

Based on the query processed, it will filter out only HTTPS logs-related sessions and will be forwarded

to the ESA.
b. Click Add.

c. If you want to delete the existing data sources filter,

remove it permanently.

12. To save the deployment, click Save.

13. Select the created deployment and click Deploy.

NETWITNESS In
SUB IPTIONS CAPTURE POLICIES POLICIES
CONTENT

ESA DEPLOYMENTS DAT

+ Create || & Edit | T Remove

POLICY NAME
new-policy
new-policy
new-policy
new-policy
new-policy
new-policy
new-policy
new-policy
-policy
new-policy
policy
policy
new-policy

new-policy

ESA SERVICE

ESA-primary - ESA Correlation

ESA-secondary - ESA Correlat...

SA-secondary - ESA Correlat...

ondary - ESA Correlat...

econdary - ESA Correlat...

econdary - ESA Correlat...

ondary - ESA Correlat...

ESA-primary - ESA Correlation

ESA-secondar

ESA-primary - ESA Correlation

ESA-primary - ESA Correlation

ESA-secondar

ESA-secondar

ESA-secondary - ESA Correlat...

click Clear Data Source Filter, and Save to

CUSTOM FEEDS

DATA SOURCE

log-hybrid - Concentrator

None

None

None

Nane

Showing 14 out of 14 items

DEPLOYMENT STATUS LAST UPDATED
Deployed

Failed

Failed

Failed

/2022 05:0.
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To create a deployment from a selected policy
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
The available policies are displayed.

3. Click a Policy.

The selected policy view is displayed and by default Application Rule is selected.
4. Click Event Stream Analysis Rule > Deployments.

The available deployments for the selected policy are displayed.
5. Click + Create Deployment.

The Create Deployment dialog is displayed.

NETWITNESS Investigat

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES ~ CUSTOM FEEDS  LOG PARSER RULES

esaaprimary - ESA Correlation

DATA SOURCES DATA SOURCE FILTER

o for ~+ Create Data Source Filter ‘

FILTER QUERY

None

6. Enter a name for the deployment.

Note: The policy is preselected as the user creates the deployment from the policy details view.

7. Select a service from the ESA Service drop-down list.

8. Under Data Sources, click + to add a data source.
The Add Data Source dialog is displayed.

9. Select one or more data sources and click Done.

IMPORTANT: If the data sources are not listed, you can add the required datasource. For more
information, see the topic Add an ESA Datasource.

10. To delete the data source, select the data source and click .

11. (Optional) the required data source and click Set Position Tracking Information to reprocess
specific sessions or ignore certain sessions.

The Set Position Tracking Information dialog is displayed.
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NETWITNESS

Session ID

SESSION ID

a. In the Position Tracking Information dialog, perform the following:
i. If you want to set the position tracking information based on date and time stamp:
In the Go To drop-down menu, select Date and Time and enter the date and time.
ii. If you want to set the position tracking information, based on the session ID:

In the Go To drop-down menu, select Session ID and enter the session ID in the Session ID
field.

The ESA Correlation service starts processing the events from the session ID that you
entered.

b. Click Calculate Sessions to calculate the number of sessions that will be processed with respect
to the existing position of the data source, if any.

c. To save the edited position tracking data source, click Save.

d. The tracking position information will be deployed to the ESA Correlation service, only when the
deployment is successfully completed.

For more information on Position Tracking Information, see Appendix B: Position Tracking
Information.

12. (Optional) To filter out certain session data coming into ESA, under Data Source Filter, click +
Create Data Source Filter.

Caution: The data source filter is for advanced users familiar with Decoder application rules.
Improper filtering can cause the required data to not be forwarded to and analyzed by ESA.

The Create Data Source Filter dialog is displayed.
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NETWITNESS

Create Data Source Filter

a. Specify the filter query in the below format as shown in the following example:
Select *where service = 443

Based on the query processed, it will filter out only HTTPS logs related sessions and will be
forwarded to the ESA.

b. Click Add.

c. If you want to delete the existing data sources filter, click Clear Data Source Filter and click
Save to remove it permanently.

13. To save deployment, click Save.

14. Select the created deployment and click Deploy.

Edit a Deployment

You can edit a deployment to change the data source, create a data source filter, and view ESA rules that
are associated with this deployment. A data source filter can improve performance by only aggregating
the data that is relevant to an ESA rule deployment. For the filter to work, application rules must be
enabled on the mapped decoders to apply the meta keys required for this filter. After saving the filter, it
must be deployed for it to take effect.

However, you cannot change the deployment name, or ESA service that are associated with the
deployment.

NetWitness Platform XDR provides two methods to manage deployments.
You can edit deployments in the following ways:

o Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can edit deployments.

o Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and edit a deployment.

To edit a deployment from the ESA Deployments tab
1. Go to Bl (CONFIGURE) > Policies > Content.
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2. Under Settings, click Event Stream Analysis > ESA Deployments.
The available deployments are displayed.
3. Select a deployment and click Edit or Edit Deployment.

a. When you select the checkbox and click Edit.

NETWITNESS

CONTENT s CRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDE

URATION  CONTENT

Content Library ESA DEPLOYMENTS  DAT

Y | + Create || & Edit || @ Remove | @ Deploy

[ NAME POLICY NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED
@ Settings

demaDeploy cy ESAPrimary - ESA Correlation  PacketHybrid - Cancentrator Deployed
Event Stream Analysis

demoDeploy2 demoPolicy ESAPrimary - ESA Correlation  None Falled
demoDeployStopped demoPolicy ESAPrimary - ESA Correlation  PacketHybrid - Cancentrator Stopped

demoDeployMultipleDatasou...  demaPolicy ESAPrimary - ESA Correlation ~ PacketHybrid - Concentrator Deployed &

Showing 4 out of 4items | 1 selected

b. When you select or click a row of the deployment, a right panel is displayed to click Edit
Deployment.

NETWITNESS

POLICIES  INCIDENT RULES

ESA DEPLOYMENTS

demoDeploy2
£ Edit | @ Remove || @ Deploy

£ Edit Deployment
POLICYNAME  ESASERVICE DATASOURCE T
© Settings

demoPolicy ESAPrimary-ES.. PacketHybrid-Concen.. Deployed
Event Stream Analysis

ESAPrimary-£5..  None

ESAPrimary-ES...  PacketHybrid - Concen.

ESAPrimary-ES...  PacketHybrid - Concen.
DEPLOYMENT STATUS

LASTUPDATED

FAILURE REASONIS)

FILTER QUERY

Showing 4 out of 4 items | 1 selected

The Edit Deployment dialog is displayed.
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NETWITNESS

LIVE CONTENT Sl APTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA

poLicy

demoPolicy

DEPLOYMENT NAME

ESA SERVICE

ESAPrimary - ESA Correlation

|+

O DATASOURCE NAME

0O Packethybrid-Co

| ++ Create Data Source Filter

4. (Optional) you can click on View ESA Rules to search for rules associated with selected policy. To
save current changes to the deployment and modify the policy, select click here and navigate to the
Edit Content Policy page.

ESA rules associated with selected Policy

To save current cha ployment and edit policy

NAME MEDIUM SUBSCRIPTION

AWS Critical VM Modified log Unsubscribed

5. Make the required changes in the deployment.
Policy, deployment name, and ESA service are pre-populated and cannot be modified.

6. Click Save.

7. Select the deployment and click Deploy.
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To edit a deployment from a selected policy
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
The available policies are displayed.

3. Click a Policy.

The selected policy view is displayed and by default Application Rule is selected.
4. Click Event Stream Analysis Rule > Deployments.

The available deployments for the selected policy are displayed.
5. Select a deployment to edit and click Edit Deployment.

The Edit Deployment dialog is displayed.

NETWITNESS

| + Create Data Source Filter

6. Make the required changes in the deployment.
7. Click Save.

8. Select the deployment and click Deploy.

Note: You can deploy the changes either by performing a Deploy action on selected deployment or
by publishing the policy. Publishing a policy with deployment in stopped state, will not deploy the
deployment.

Start a Deployment

The deployment includes ESA services with policy and associated ESA rules. When you initiate
deployment, the correlation services start processing sessions from the configured data sources for
matching events for the selected ESA rules in the policy.

For more information about ESA services and rules, see Alerting with ESA Correlation Rules

You can start deployments in the following ways:
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o Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can initiate deployments.

o Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and initiate a deployment.

To initiate a deployment, with the ESA Deployments tab
1. Go to Bl (CONFIGURE) > Policies > Content.
2. Under Settings, click Event Stream Analysis > ESA Deployments.

The available deployments are displayed.
3. Select a deployment and click Deploy.

NETWITNESS

NS CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES

ESA DEPLOYMENTS  DATA SOURCES

Y e @ Remove

o~ POLICY NAME DEPLOYMENT STATUS
Deployed
Failed
Failed
Failed
New &
New &

Failed

Showing 14 out of 14items | 1 selected

To start a deployment with selected policy
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
The available policies are displayed.

3. Click a Policy.

The selected policy view is displayed and by default Application Rule is selected.
4. Click Event Stream Analysis Rule > Deployments.

The available deployments for the selected policy are displayed.
5. Select the deployment to deploy and click Deploy.

Note: You can deploy the changes either by performing a Deploy action on selected deployment or
by publishing the policy. Publishing a policy with deployment in stopped state, will not deploy the
deployment.
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Remove a Deployment

You can delete one or more deployments when those deployments are not required. Once the deployment
is deleted, all the configurations associated with the deployment will be permanently deleted from the
correlation server. The alert process will be stopped for the deleted deployment.

You can remove deployments in the following ways:

o Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can remove deployments.

» Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and remove a deployment.

To remove a deployment from the ESA Deployments tab

1. Go to Bl (CONFIGURE) > Policies > Content.

2. Under Settings, click Event Stream Analysis > ESA Deployments.

The available deployments are displayed.

3. Select the deployment that needs to be removed and click Remove.
A confirmation pop-up is displayed to confirm.

4. Click Remove.

NETWITNESS

LIVE CONTENT ONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES NCIDENT NOTIFICATIONS

ESA DEPLOYMENTS D

Y | + create || 2 Edit W Remove colo
Remave all configurations associated with the deployment

0 NAME POLICY NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED

O Settings

demoPolicy PacketHybri or Deployed
Event Stream Analysis
der S relat ne Failed
Stopped

Deployed &

To remove a deployment from a selected policy
1. Go to Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
The available policies are displayed.

3. Click a Policy.
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The selected policy view is displayed and by default Application Rule is selected.
4. Click Event Stream Analysis Rule > Deployments.
The available deployments for the selected policy are displayed.
5. Select the deployment that needs to be removed and click Remove Deployment.
A confirmation pop-up is displayed to confirm if you want to remove it.

6. Click Remove.

“"FRemove Deployments

Note: It is required to have at least one deployment associated with the correlation service present
in the group associated with the policy.

Stop a Deployment

You can stop a deployment to temporarily pause an ESA deployment. This will stop processing the event
stream analysis alerts corresponding to the deployed policy.

To delete a deployment completely, see Remove a Deployment
To initiate a deployment again, see Start a Deployment
You can stop deployments in the following ways:

o Using the ESA Deployments tab. The ESA Deployments tab provides a consolidated view of all the
available deployments within CCM. You can stop deployments.

o Using a specific policy. In this method, you cannot view other deployments. You need to go to each
policy and stop a deployment.

To stop a deployment from the ESA Deployments tab

1. Goto (CONFIGURE) > Policies > Content.
2. Under Settings, click Event Stream Analysis > ESA Deployments.
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The available deployments are displayed.
3. Select the deployment that must be stopped temporarily and click Stop Deployment.

NETWITNESS
3SCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS
CONTENT

ESA DEPLOYMENTS  DATA SOURCES

POLICY NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED

© Settings

log-hybri
Event Stream Analysis

Showing 14 outof 14items | O selected

To stop a deployment from a selected policy
1. Go to [Bl (CONFIGURE) > Policies.

2. In the policies panel, click Content.
The available policies are displayed

3. Click a Policy.
The selected policy view is displayed and by default Application Rule is selected.
4. Click Event Stream Analysis Rule > Deployments.
The available deployments for the selected policy are displayed.
5. Select the deployment that needs to be stopped temporally and click Stop Deployment.
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Note: Publishing the policy will not deploy the stopped deployments.

NETWITNESS

LIVE CONTENT

PoLICYSTATUS
Unpublished 1

£ Publish Policy 4 EditPolicy

FEED (0)  APPLICATION RULE (0)  LOG DE

RULES  DEPLOYMENTS

S | + Create || & Edit || T Remove

1 NAME
demoDeploy
demoDeploy2

] demoDeployStopped

1 demoDeployMultipleDatasource

Migrate ESA Deployments to Policies and Groups

CAPTURE POLICIES

LASTUPDATED

T Merge Policy |

@® Deploy

POLICIES

CREATEDON
12/
T Delete Policy

VICE (0)  LUA PARSER(0) N

@ Stop Deployment

ESA SERVICE
ESAPrimary - ESA Correlation
ESAPrimary - ESA Correlation

ESAPrimary Correlation

ESAPrimary - ESA Correlation

INCIDENT RULES

Force Publish

ORK RULE (0}

DATA SOURCE
PacketHybrid - Concentrator
None

Packethybrid - Concentratar

PacketHybrid - Concentrator

INCIDENT NOTIFICATIONS

ESA RULES

EVENT STREAM ANALYSIS RULE (1)

BUNDLE (0

DEPLOYMENT STATUS LAST UPDATED
Deployed
Failed

Stopped

Deployed A

From version 12.1 and later, on successful upgrade of the Admin Server, the ESA deployments are

managed by the policies and groups page. The deployments are not available on (CONFIGURE) >

ESA Rules page.

12.0 and Earlier version

ESA Rules page in the 12.0 version.

S NETWITNESS  Inv

Services Settings

SAMPLE - P2P Software 2

SAMPLE - User Adde:

SAMPLE - Whitelist

Rule Library

+ &
_ Rule Name ~
= Endpoint Risk Scoring Rule Bundl
SAMPLE - Blacklist - From inside countries that are not the US, Non SMTP Tra
SAMPLE - Non SMTP Traffic on TCP table

Page 1 of1 &

tected by an Intrusio
Admin Group Same User su sudo

From outside of Germany, P2P Software as Detected by

Dashboard

RULES

Description

Page Size

100 ~

Alert when user is

tains many ru

upgraded to one of admin g

ESA RULES (e

(custom list of groups)

Whitelist Germany from P2P software as detected by an intrusion detection

Trial Rule

admin »

X
Type Actions
Endpoint Rule B. L]
Rule Builder &
Rule Builder &
Rule Builder &
Rule Builder L

e Builde £y

Displaying 1 - 6 of 6 rules

12.1 version

Updated ESA Rules page in 12.1 version, where only rule libraries are available.
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Note: The ESA deployments, after upgrading the Admin Server to 12.1 are not available to view or
modify until the Correlation servers are also upgraded to the 12.1 version. However, the events are
consumed, and ESA alerts are processed by the Correlation server.

NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports admin w
LIVE CONTENT  SUBSCRIPTIONS ~ CAPTURE POLICIES ~ POLICIES  INCIDENTRULES  INCIDENT NOTIFICA S ESARULES  CUSTOM FEEDS L RSER RULES  SERVICE TOPOLOGY
Services Settings

Rule Library
All Event Stream Analysis (ESA) rules created or downloaded. Add rules to a deployment to activate them.

+ - I & ¥ Filter X
[ Rule Name ~ Description Version TrialRule  Type Actions

] sfis 10 Yes Rule Builder & -
[ AWS Critical VM Modified Detects when Amazon Web Services (AWS) critical virtual machine instances are modified. Acti.. 0.3 Yes RSALive ESARule & -
[ AWs Permissions Modified Followed By Instance State Change Detects when an Amazon Web Services (AWS) permission is modified followed by an instances... 0.3 Yes RSALive ESARule | &F ~
[ Account Added to Administrators Group and Removed Detects log events when a user is added to an administrative group and then removed from th.. 0.4 Yes RSALive ESARule & ~
] Account Removals From Protected Groups on Domain Controller Detects account removal from a protected group on a domain controller. There are five param... 0.4 Yes RsALive ESARule | &F ~
[] Aggressive Internal Database Scan Detects a single host making connection attempts to 100 or more unique IP addresses in 1 min... 03 Yes RSA Live ESARule & ~
] Aggressive Internal NetBIOS Scan Detects a single host making connection attempts to 100 or more unique IP addresses in 1 min... 0.3 Yes RSA Live ESARule ¥
] Aggressive Internal Web Portal Scan Detects a single host making connection attempts to 100 or more unique IP addresses in 1 min... 03 Yes RSA Live ESARule | & -
[ BYOD Mobile Web Agent Detected Detects a web-browsing agent for a mobile device. To configure the rule, specify the list of una... 0.3 Yes RSALive ESARUle | % ©

| Page 1 of2 | ) ) | C PageSize 100 -~ Displaying 1 - 100 of 150 rules

NETWITNESS

All the deployments are automatically migrated to policies and groups:

o FEach deployment is converted into a policy and a group.

¢ Once the ESA Correlation server is upgraded to the 12.1 version, you can access these deployments as
groups and policies.

IMPORTANT: If there is any need to import ESA Rules and Enrichments. NetWitness recommends
importing those missing rules and enrichments before the upgrade.

The following table provides the information on different deployment states for Policy and Groups:

Post-upgrade Deployment State

Pre-upgrade The policy

Deployment State

Creates Policy | Creates Group | will be
Published

1 Healthy deployment Yes Yes Yes
2 Deployment with errors Yes Yes Yes
3 Deployment with only rules Yes No No
4 Deployment with no rules No No No

Healthy deployment contains no errors, and the required resources such as ESA Server, Data source, and
ESA rule are added.
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Note: NetWitness recommends that all the deployments maintain an error-free state and also remove
any unnecessary or unused ESA deployments.

References

This section is a collection of references, which describe the user interface and more detailed information
about how Policy-based Centralized Content Management works in NetWitness. The topics are presented
in alphabetical order.

Content Library Tab

The (CONFIGURE) > Policies view contains two tabs: Configuration and Content.
The CONTENT tab has Content Library, Policies and Groups on the left panel.

Below is an example of the Content > Content Library tab:

12.1 Version:

NETWITNESS

4~ Create Rule (3 Clone Rule & Delete 1 Import

0 HAME * MEDIUM LAST UPDATED

packet

12.1.1 Version:
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NETWITNESS \ Users H Files Dashb s o] 4 ®  admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES SERVICE T(
CONFIGURATION CONTENT
Content Library FEED APPLICATION RULE LOG DEVICE LUA PARSER NETWORK RULE EVENT STREAM ANALYSIS RULE BUNDLE

Policies (3) S’ | + CreateRule

Groups (2)
a RULE NAME RULE VALUE MEDIUM LAST UPDATED POLICIES

& Settings O @new | Custom @new-1 log and packet 10/11/2022 11:43:49 am pl-1

Event Stream Analysis O @new-1 | Custom @new-1 log and packet 10/11/2022 12:05:35 pm None
@new-2 | Custom @new-1 log and packet 10/11/2022 12:07:22 pm None
@new-3 | Custom @new-1 log and packet 10/12/2022 09:14:13 am None
@new-4 | Custom @new-1 log and packet 10/13/2022 05:51:01 am None
@new-5 | Custom @new-1 log and packet 10/12/2022 12:03:54 pm None
@new-67 | Custom @new-67-111 log and packet 10/12/2022 12:05:06 pm None
@sample-1 | Custom @sample-1 log 10/11/2022 11:01:31am None
@test | Custom @test log and packet 09/28/2022 05:42:00 am p1-1
@test-rhea-edit-2 | Custom @test-rhea-edit-rulevalue log and packet 10/11/2022 07:19:49 am None

@test-rhea-edit-2-1 | Custom @test-rhea-edit-rulevalue log and packet 10/11/2022 07:44:19 am ol-1

O Showing 50 out of 978 items | O selected

1 Toolbar

o Create Rule - Lets you create a rule.

o Clone Rue - Lets you clone an application rule or network rule. For more information, see
Clone Application Rule or Clone Network Rule.

o Delete - Lets you delete an application rule or network rule. For more information, see Delete
Application Rule or Delete Network Rule.

o Import - Lets you import an application rule or network rule. For more information, see Import
Content to Content Library.
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2 Rule List Pane for 12.1 Version:

¢ Name - Name of the rule.

Medium - Medium through which the rule is created.
Last Updated - Displays the time when the rule is updated.

Policies - Policies to which the rule is applied.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed: .

Click the icon to sort by the selected column.
Rule List Pane for 12.1.1 Version:

Rule Name - Name of the rule.

Rule Value - The rule value.

Medium - Medium through which the rule is created.

Last Updated - Displays the time when the rule is updated.

Policies - Policies to which the rule is applied.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed: .

Click the icon to sort by the selected column.

Create New Rule dialog:

Below is an example of the Create new rule dialog for 12.1 version:

NETWITNESS

POLICIES

CONTENT

oL @bl Create New Rule

NAME POLICIES
RULE NAME

CONDITION © @) ADVANCED

MEDIUM
Select medium type
SESSION DATA

O Stop Rule Processing

Below is an example of the Create new rule dialog for 12.1.1 version:
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NETWITNESS

POLICIES

CATION RULg

Create New Rule

RULE NAME RUEEIRAME LAST UPDATED POLICIES

p1-1 (32

RULE VALUE @

CONDITION @ @ ) Apvanced

MEDIUM

The table describes the information and options in the Create New Rule dialog:

Field

Rule Name

Rule Value

Condition

Medium

Description

Session Data

Session
Options

Alert On

Description

Name of the new rule. The name should be unique.

The rule value written to the alert meta. The rule value cannot be modified while
cloning the rule.

Note: This field is applicable only for 12.1.1 version.

Condition for the new rule. You can apply two types of conditions for the rule.
Normal mode:

It gives suggestions for supported metas (ip, host and so on) and operators (“=", “Not
Equal To”, “Contains”, “Exists” and so on).

The entered condition will be enclosed in a ‘Pill’. When you enter multiple conditions,
the conditions are automatically joined by an ‘AND’ operator. On clicking the ‘AND’
operator, you can toggle between ‘AND’ and ‘OR’ operators.

Advanced:

You can customize the conditions as a free form text.

Medium through which the rule is created. For a network rule, the value of medium is
selected as Packet as default and the user cannot edit it.

The description of the new rule.

Session data for the new rule. Indicates if the rule processing should stop, keep, filter
or truncate when the session data is running.

Session options for the new rule. Indicates if the session options should be alert,
forward or transient.

Conditions for which the alert should be turned on.
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Save Saves the settings and closes the Create New Rule dialog.
Cancel Cancels the operations.
Clone Rule dialog:

Below is an example of the Clone rule dialog for 12.1 version.

Cancel

The table describes the information and options in the Clone Rule dialog for 12.1 version:

Field Description

Enter Name for Cloned Rule Name of the cloned rule. The name should be unique.
Clone Clones the rule and closes the Cone Rule dialog.
Cancel Cancels the operation.

Below is an example of the Clone rule dialog for 12.1.1 version.

NETWITNESS

Content Library
Clone Rule X
Proceeding with cloning will create a custom rule and this

rule will not be part of any existing policy or bundle. To know

LAST UPDATED POLICIES
more about clone

Enter details to modify the rule

RULE NAME

CONDITION ©

ip.src exists
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The table describes the information and options in the Clone Rule dialog for 12.1.1 version:

Field

Rule Name

Rule Value

Condition

Medium

Description

Session Data

Session
Options

Alert On
Clone

Cancel

Description

Name of the cloned rule. The name should be unique.

The rule value written to the alert meta. The rule value cannot be modified while
cloning the rule.

Condition for the new rule. You can apply two types of conditions for the rule.
Normal mode:

It gives suggestions for supported metas (ip, host and so on) and operators (“=", “Not
Equal To”, “Contains”, “Exists” and so on).

The entered condition will be enclosed in a ‘Pill’. When you enter multiple conditions,
the conditions are automatically joined by an ‘AND’ operator. On clicking the ‘AND’
operator, you can toggle between ‘AND’ and ‘OR’ operators.

Advanced:

You can customize the conditions as a free form text.

Medium through which the rule is created. For a network rule, the value of medium is
selected as Packet as default and you cannot edit it.

The description of the new rule.

Session data for the new rule. Indicates if the rule processing should stop, keep, filter
or truncate when the session data is running.

Session options for the new rule. Indicates if the session options should be alert,
forward or transient.

Conditions for which the alert should be turned on.

Clones the rule and closes the Cone Rule dialog.

Cancels the operation.

Data Sources Tab

Below is an example of the Content > Settings > Event Stream Analysis > Data Sources tab:
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NETWITNESS y te Respond ~ Users  Hosts  Files Dashboard eports O) Q) admin

LIVE CONTENT

Content Library

Policies (4)

Groups (11)

@ Settings

Event Stream Analysis

SUBSCRIPTIONS  CAPTURE POLICIES POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  SERVICE TOPOLOGY

CONTENT

O NAME ADDRESS TRUSTED AUTHENTICATION COMPRESSION
O loghybrid1 - Log Decoder true false

O loghybrid1 - Concentrator false false

The following table describes the Data Sources tab.

1 Toolbar

Add Datasource- Lets you to add a new Datasource. For more information, see Add an ESA
Datasource.

Edit - Datasource - Lets you edit the Datasource. For more information, see Edit an ESA
Datasource.

Delete Datasource - Deletes the selected Datasource.

2 Data Sources List Pane

Below is

Name - Shows the name of the data sources used by the selected ESA service. Data sources
can be Concentrators or Decoders.

Address - IP address of the datasource where the ESA service is installed.
Port - Shows the port number used for authentication.

Trusted Authentication - Indicates that it uses Trusted Authentication for communication with
ESA Service.

SSL - Indicates that it uses SSL for Authentication.

Compression - Enables you to adjust the Compression Level on different datasources for ESA.

an example of the Add New Datasource dialog:
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NETWITNESS

POLICIES

CONTENT

ntent Library DATA SOURCES

+ AddDatasource
Groups (11)

© Settings

Event Stream Analysis

NETWITNESS
POLICIES
CONTENT
Content Library DATA SOURCES
Policies (4)

~+ Add Datasource
Groups (11)

@ Settings

Event Stream Analysis

The table describes the information and options in the Add New Datasource dialog.

Add New Datasource

Select aservice from Lhe following
NAME ADDRESS
packethybrid - Concentrator
endpointloghybrid1 - Concentr...
decoder - Decoder
packethybrid - Decoder

endpointloghybrid1 - Log Deco...

Add New Datasource

Complete service configuration
O Trusted Authentication @

P

USERNAME

PASSWORD

Configure th

OssL @
PORT NUMBER

50005

RE TRUSTED AUTHENTICATION

Concentrator true
Concentrator false
Decoder

Decoder

Log Decoder

Cancel | |

TRUSTED AUTHENTICATION

true

false

COMPRESSION

false

false

COMPRESSION

Trusted This option will enable the use of SSL by default for authentication.

Authentication

Username The username used to sign in to your account for authenticating the datasource.

Password The password for authenticating the datasource.

SSL This will enable the use of SSL for authentication.

Port Number This will enable the use of the port number for authentication.

Compression This option enables you to adjust the Compression Level on different datasources
for ESA.

Compression Enables you to set different compression level. Compression Level: 0, 1, and 9. For

Level more information, see Add an ESA Datasource,
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Test Validates the provided configuration.

Configuration

Save Saves the settings and closes the Add New Datasource dialog.
Cancel Cancels the operations.

Deployments Tab

Below is an example of the Content > Policies > select a policy > Event Stream Analysis Rule >
Deployments tab:

NETWITNESS Invesligale Respond Users osls Files Dashboard Reporls & % ® admin

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  SERVICE TOPOLOGY

< Content Policy

DESCRIPTION GROUPS POLICY STATUS. LAST UPDATED CREATED ON CREATED BY
- groupl Unpublished 08/16/2022 09:49:04 08/10/2022 21:35:20 admin

& Publish Policy 4 Edit Policy T MergePolicy | | | @ Delete Policy Force Publish

FEED (0)  APPLICATION RULE (0) LOG DEVICE (0) LUA PARSER (0) ~ NETWORK RULE (0) ~ EVENT STREAM ANALYSIS RULE (1) BUNDLE (0)

RULES  DEPLOYMENTS

+ Create Deployment

O  NAME ESA SERVICE DATA SOURCE DEPLOYMENT STATUS LAST UPDATED

O Deploymentl esaprimary - ESA Correlation loghybrid - Concentrator Deployed 08/16/202209:50:02
O  Deployment2 esaprimary - ESA Correlation loghybrid - Concentr... (+ New A 08/16/2022 09:50:36

O Deployment3 esaprimary - ESA Correlation loghybrid - Concentr... (+3) Stopped 08/16/202209:51:04

The following table describes the Deployments tab.

1 Toolbar

o Create Deployment - Lets you to Add a new Deployment. For more information, see
Create a Deployment.

o Remove Deployment - Lets you to remove the Deployment.For more information, see
Remove a Deployment.

e Deploy - Lets you to deploy the Deployment.

o Stop Deployment - Lets you to stop the selected Deployment.

187



Live Services Management Guide

2 Deployment List Pane

Name - Name of the content.
ESA Service - Displays the ESA service selected.
Data Source - Displays the Datasource added for ESA deployment.

Deployment Status - Status of the deployment. The values are: Deploying, Deployed,

New, Stopping, Stopped, and Failed.
Last Updated - Displays the time when the deployment is updated.

Create Deployment dialog:

Below is an example of the Create Deployment dialog:

NETWITNESS

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS LOG PARSER RULES

Create Deployme

DEPLOYMENT NAME

Respond Users Hosts Files yashboard Reports

nt

Deployl

ESA SERVICE

esaaprimary - ESA Correlation v

DATA SOURCES

DATA SOURCE FILTER

T | | Set Position Tracking Information + Create Data Source Filter

FILTER QUERY

DATASOURCE NAME

The table describes the information and options in the Create Deployment dialog.

Deployment
Name

Name of the deployment. The name must be unique.

ESA Service Displays the list of ESA services from the drop-down list.

o esaprimary — ESA Correlation

o esasecondary — ESA Correlation

]

% ® admin

SERVICE TOPOLOGY

Cancel

Adds a Datasource from the available list. At least one Datasource is required to set

the position tracking information for ESA.

Deletes the datasource that you are currently editing.

X

188



Live Services Management Guide

Set Position Adds a position tracking information on different datasources for ESA. Position

Tracking Tracking Information enables you to visualize the progress of the sessions that ESA

Information has processed, and provides information on the session IDs and the time/date when the
events were processed. For more information, see Appendix B: Position Tracking
Information.

Create Data Enables you to create the datasource filter to get the required results.
Source Filter

Save Saves the settings and closes the Create Deployment dialog.

Cancel Cancels the operations.

Below is an example of Add Data Source Dialog.

NETWITNESS

POLICIES

Add Data Source

e ) Sl
esaaprimary - ESA Correlation

O Select All
ATA SOURCES O loghybrid1 - Log Decoder

o et -
4 Set Position Tracking Information loghybrigd - Capcentiaton

DATASOURCE NAME

Cancel

The table describes the information and options in the Add Data Source dialog.

Select Datasource / Select All Allows you to select one or more datasources.

Done Adds the datasource and closes the Add Data Source dialog.

Cancel Cancels the operations.

Below is an example of Set Position Tracking Information dialog.
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NETWITNESS

POLICIES INCIDE

Set Position Tracking Information

Current Positit

i ) Session ID
esaaprimary - ESA Correlation

SESSION ID

ATA SOURCES

<+ || W || setPosition Tracking Information

DATASOURCE NAME

loghybrid1 - Concentrator

Cancel

Cancel

The table describes the information and options in the Set Position Tracking Information dialog.

Go To This option will enable the use of Session ID and data and time for ESA Correlation
Service for the events.

Session ID The ESA Correlation service starts processing the events from the session ID that you

entered.
Date and The ESA Correlation service starts processing the events from the date and time that
Time you entered.
Calculate This will calculate the number of sessions that will be processed with respect to the
Sessions existing position of the data source.
Save Saves the settings and closes the Set Position Tracking Information dialog.
Cancel Cancels the operations.

Below is an example of Create Data Source Filter Dialog
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NETWITNESS

POLICIES INCIDE

Create DataSourceFilter

= h Decoder application rules. Improper filtering can cause
esasecondary - ESA Correlation application 1proy 1g can ca

Set Position Tracl

e

DATASOURCE NAME

loghybrid1 - Cc

The table describes the information and options in the Create Data Source Filter dialog.

Data Source Enables you to enter the data source filter. For example, you can type Select *where
Filter service = 443

to filter based on the query processed, it will filter out only HTTPS logs related sessions
and will be forwarded to the ESA.

Add Adds the configurations and closes the Create Data Source Filter dialog.
Cancel Cancels the operations.
Groups Tab

Below is an example of the Content > Groups tab:
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NETWITNESS e 2 osts es ashboard 2eports S % ® admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES SH
CONFIGURATION CONTENT

Content Library Y | + CreateNew

Policies (1)
o ‘GROUP NAME T DESCRIPTION SERVICES POLICIES POLICY STATUS

Groups (1]
XY O  Nirvana-RSA-Primary esaprimary - ESA Correlation Nirvana-rsa-primary Published

& Settings

Event Stream Analysis

Showing 1 out of 1items | Oselected

The following table describes the Groups tab.

1 Toolbar

o Create New - Lets you create a new group. For more information, see Create a group.
o Edit - Lets you edit the group. For more information, see Managing Groups.
o Publish - Publishes selected groups.

o Delete - Deletes the selected group.

2 Group List Pane
e Group Name - Name of the group.

o Description - Description of the group.
o Services - Displays the service to the which the group is applied.

o Policies - Displays the policy to which the group is applied.

Policy Status - Status of the policy. The values are: Published, Unpublished, Failed, N/A.

You can also sort on any column. If you mouse over a column header, a sort icon is displayed: l

. Click I to sort by the selected column.

3 Groups Details Panel
Displays the properties of the selected group.

Below is an example of the Create group dialog:
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NETWITNESS Investigate Respond Users Hosts Files Dashboard Reports O] % ® admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES SH

Create Content Gi

New Group Identify Group - New Group

GROUP NAME

Define Group

Save and Close

The table describes the information and options in the Create Group dialog:

Field Description

Group Name Name of the group. The name should be unique.

Group Description Description of the group. Description should not exceed 8000
(Optional) characters.

Save and Close Saves the settings and closes the Create Group dialog.

Below is an example of the define group dialog:

@ | HIDE SIRVICES I A SROUP

The table describes the information and options in the Define Group dialog:
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Field Description

Services List Displays the list of services.
The following describes services list:
Service name — Name of the service.

e Group - Name of the group.
o Host - Host name of the service.
e Version - Service version.

« All - Lets you to add services to the group. You can either click [EE@lto add all
services or click @] to add specific service.

Hide Services in  Displays the services that is not assigned to any group. By default, this option is
a Group disabled.

Selected Services Displays the list of selected services for the group.
Save and Close Saves the setting and closed the create group dialog.

Save and Publish Saves and publishes the created group.

Note: This option is disabled if you have not:
- Assigned services.
- Assigned policies.

Below is an example of Assign policy dialog:

The following table describes assign policy dialog:

Field Description
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Policies List Displays the list of policies associated with the group.
The following describes policies list:

o Name - Name of the policy.
 Description - Description of the policy.
o Groups - Groups associated with the policy.

e Action - Click to add policies to the group.

Selected Policies Displays the list of selected policies for the group.
Save and Close Saves the setting and closed the create group dialog.
Save and Publish Saves and publishes the created group.

Note: This option is disabled if you have not:
- Assigned services.
- Assigned policies.

Policies Tab

IMPORTANT: The customers should note that, while publishing the first policy to a service, all
previous content except custom feeds, will be deleted. Ensure that all custom content are migrated to
Content Library before publishing the first policy.

The (CONFIGURE) > Policies view contains two tabs: Configuration and Content.
Below is an example of the Content > Policies tab:

NETWITNESS Investigate Respond sers osts es Dashboard eports S % ® admin
LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES ~ POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  S§

CONFIGURATION CONTENT

Content Library Y | + CreateNew | # MoreActions v

Policies (1)
©  DESCRIPTION GROUPS POLICY STATUS  LAST UPDATED UPDATED ...

Groups (1) 4 : 4 .
Nirvana-RSA-Primary Published 08/09/202202:26:...  admin

& Settings

Event Stream Analysis

Showing 1 out of 1items | Oselected
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Toolbar:

o Create New - Lets you create a new policy. For more information, see Create a policy.

o Edit - Lets you edit the policy. For more information, see Edit a Policy.

o Publish - Publishes selected policy or policies.

« More Actions:

°  Assign to Group --Lets you assign policy to a group.
o Clone - Lets you clone a policy.
o Delete - Deletes the selected group or groups permanently.

o Force Publish - Lets you republish all the content irrespective of the policy status. This
option allows you to re-push all content or configurations to all services in the group. Some
of the scenarios where you might want to force publish the policy are:

® There was a service that was down or did not successfully receive content when it was
first pushed out.

® Some content may have been modified or removed locally on a service (outside of CCM
control) and you want to re-apply the content from the policy.

Policy List Pane:

Name - Name of the policy.

Description - Description of the policy.

Groups - Lists the group to which this policy is applied.

Policy Status - Status of the policy. The values are: Published, Unpublished, Failed, N/A.
Last Updated - Displays the time when the policy is updated.

Updated By - The user who updated the policy. You can also sort on any column. If you

mouse over a column header, a sort icon is displayed: . Click the l icon to sort by the
selected column.
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3 Policy Details Panel:

MNETWITNESS

POLICY STATUS
blished

3 Publish Policy 4 Edit Policy

APPLICATION RU

T Subscribe

O ORDER MAME MEDIUM UPDATED SUBSCRIFTION STATUS

ANVS - Network route modifed g i Uy ] Enabled

out of 1 items | 1 selected

Displays the Displays the properties of the selected policy.
Toolbar:

Publish Policy - Lets you publish all the unpublished and/or failed content. For more
information, see Create a Policy.

Edit Policy - Lets you edit the policy. For more information, see Edit a Policy.
Delete Policy - Deletes the selected policy or policies permanently.

Force Publish - Lets you republish all the content irrespective of the policy status.

Policy Details Pane:

Order - Order of the content.

Name - Name of the content.

Medium - Meta data source medium.

Last Updated - Displays the time when the content is last updated.
Subscription - Indicates if the content is subscribed or unsubscribed.
Status - The status of resource.

Subscribe - Lets you subscribe for the content if it is unsubscribed.
Unsubscribe - Lets you unsubscribe for the content if it is subscribed.
Enable - Lets you enable the content for the policy.

Disable - Lets you disable the content from the policy.

Below is an example of the Create Content Policy dialog.
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NETWITNESS ¢ osts es ashboard X s & % @ admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES sSH

ontent Policy

New Policy Identify Policy - New Policy

POLICY NAME

Enterau
POLICY DESCRIPTION (OPTIONAL)

Define Policy

Save and Close Cancel

The table describes the information and options in the Create Policy dialog:
Field Description
Policy Name Name of the policy. The name should be unique.

Policy Description Description of the policy. Description should not exceed 8000
(Optional) characters.

Define Policy Settings:

NETWITNESS ate Respond Users Host: Files Dashboard Reports S e @) admin

LIVE CONTENT SUBSCRIPTIONS CAPTURE POLICIES POLICIES INCIDENT RULES INCIDENT NOTIFICATIONS ESA RULES CUSTOM FEEDS LOG PARSER RULES S

Define Policy - asas

Add content along with its dependencies to the

Identify Policy > | Available Content Selected Content

omatically for the sel

MEDIUM  CREATED LAST UPDAT... SUBSCRIPTI...

log 09/14/202.. 09/14/2021.. @ )

> lLuaParser

Previous Next Save and Close
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Field

Available
Content

Description

Displays the available content resources in your deployment. Click expand the resource
type.

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES

NETWITNESS vestigate Respond L

ent Policy

Define Policy - asas

Add content along w

Available Content

Jser Host

v Application Rul

NAME MEDIUM

endpoint:

endpoint

Previous ‘ Next

CREATED
02/03/20220...
02/03/20220.
02/03/20220.
02/03/20220.
04/10/20190.

04/10/20190...

‘ Save and Close ‘

The following describes resource type:

Name - Name of the resource.

Files

INCIDENT RULES

LAST UPDATED  ACTI...

02/03/20220...

02/03/20220.

02/03/20220.

02/03/20220.

04/10/20190.

04/10/20190...

Dashboard

Report & ¥ @ admin

INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES

Selected Content

Allthe

\pplication Rule

NAME MEDIUM CREATED  LASTUPDAT.. SUBSCRIPTL. (...

st

log 09/14/202..  09/14/2021.. @ ®

Cancel

Medium - Meta data source medium. Available values for medium are as follows:

o Endpoint: applied to content that uses meta derived from endpoint agent and

endpoint server data

o Log: applied to content that uses meta derived from log data

o Packet: applied to content that uses meta derived from network packets

» Log and packet: applied to content that correlates meta derived across log and

packet data

Created - Displays the time when the resource is created

Last Updated - Displays the time when the resource is updated last.

Action- Click + to add the resource and its dependencies to your deployment.
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Selected Lists the selected resource.

Content Additionally, you can subscribe the content. Once the content is subscribed, the content
resources are updated automatically in case of any changes.

NETWITNESS vestigate ESPONC se ost Files Dashboard eport:

LIVE CONTENT  SUBSCRIPTIONS  CAPTURE POLICIES  POLICIES  INCIDENT RULES  INCIDENT NOTIFICATIONS  ESA RULES  CUSTOM FEEDS  LOG PARSER RULES  sif
- 2 BaF
_ontent Policy

Define Policy - asas

Add content along with its dependencies to the policy

Identify Policy Available Content Selected Content

 fites | [ a Allth utomatically for t

Application Rule v Appl on Rule

NAME MEDIUM CREATED LAST UPDATED  ACTI... MEDIUM CREATED  LASTUPDAT.. SUBSCRIPTI..
log 02/03/20220...  02/03/20220. @) log 09/14/202. 09/14/2021 r
log 02/03/20220..  02/03/20220.. @
log 02/03/20220..  02/03/20220.. @
log 02/03/20220...  02/03/20220.
endpoint 04/10/20190...  04/10/20190.

endpoint 04/10/20190...  04/10/20190...

Previous Next Save and Close Cancel

Assign to Group:

POLICIES SERVICES ACTION
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Group List  Displays the list of groups associated with the policy. A group is disabled if it is
already assigned to another policy.

e Group Name

o Policies

e Services

e Action
Selected Lists the selected groups. Click Bl to add groups.
Group
Save and Saves the settings and closes the Create Policy dialog.
Close
Save and Saves and publishes the created policy.
Publish

Note: This option is disabled if:
- Policy settings are not customized.
- Policy is not assigned to groups.

Appendix A: Endpoint Risk Scoring Rules

Endpoint risk scoring requires the following content:

o "accesses administrative share using command shell"
» "activates bits job"

» "adds files to bits download job"

o "adds firewall rule"

 "allocates remote memory"

» "antivirus disabled"

 "archiving software reads multiple documents"
» "autorun debian package mismatch"

« "autorun file path not part of debian package"
 "autorun file path not part of rpm"

 "autorun key contains non-printable characters"
o "autorun"

« "autorun rpm mismatch"

» "autorun unsigned active setup"

o "autorun unsigned appinit_dlIs"
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e "autorun unsigned bho"

o "autorun unsigned bootexecute registry startup method"
 "autorun unsigned explorer registry startup method"

o "autorun unsigned hidden"

 "autorun unsigned hidden only executable in directory"
o "autorun unsigned ie toolbar"

 "autorun unsigned in appdatalocal directory"

o "autorun unsigned in appdataroaming directory"

» "autorun unsigned in programdata directory"

o "autorun unsigned in temp directory"

 "autorun unsigned logontype registry startup method"
o "autorun unsigned Isa provider"

 "autorun unsigned servicedIl"

o "autorun unsigned winlogon helper dll"

 "autorun unsigned winsock Isp"

o "bad certificate warning disabled"

o "blacklisted file"

e "browser runs command prompt"

 "browser runs mshta"

o "browser runs powershell"

 "builds script incrementally”

o "clears application event log"

 "clears event logs using powershell"

o "clears security event log"

o "clears setup event log"

o "clears system event log"

» "combines binaries using command prompt"

e "command line usage of archiving software"

e "command line writes script files"

e "command prompt obfuscation"
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"command prompt obfuscation using value extraction"
"command shell runs rundll32"
"completes bits download job"
"configures image hijacking"

"configures port redirection”

"copies binary over administrative share"
"created in last month"

"creates browser extension"

"creates domain user account”

"creates executable in startup directory"
"creates local driver service"

"creates local service"

"creates local task"

"creates local user account"

"creates password-protected archive"
"creates recursive archive"

"creates remote process using wmi command-line tool"
"creates remote service"

"creates remote task"

"creates run key"

"creates shadow volume for logical drive"

"creates suspicious service running command prompt"

"debian package hash mismatch in important system directory"

"debian package hash mismatch"

"deletes backup catalog"

"deletes firewall rule"

"deletes shadow volume copies"

"deletes shadow volume copies using powershell"
"deletes usn change journal"

"disables event logging service"
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» "disables firewall"

o "disables safe mode"

 "disables security service"

o "disables startup repair"

 "disables uac"

» "disables uac remote restrictions"
 "disables windows audit policy"

o "disables windows defender using powershell"
o "downloads binary using certutil"

o "drops credential dumping tools"

e "dumps dns cache"

o "dyld inserted"

 "enables cleartext credential storage"

o "enables login bypass"

 "enables rdp from command-line"

» "enables safe mode"

» "enumerates arp table"

o "enumerates available systems on network"
» "enumerates domain account policy"

o "enumerates domain administrators"

o "enumerates domain computers"

o "enumerates domain controllers"

» "enumerates domain groups"

o "enumerates domain users"

» "enumerates enterprise administrators"
o "enumerates exchange domain servers"
» "enumerates exchange servers"

o "enumerates ip configuration"

» "enumerates local account policy"

e "enumerates local administrators"
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"enumerates local administrators on domain controller"
"enumerates local groups"

"enumerates local services"

"enumerates local users"

"enumerates logical disk"

"enumerates mapped resources"

"enumerates network connections"

"enumerates primary domain controller"

"enumerates processes on local system"

"enumerates processes on remote system"

"enumerates remote netbios name table"

"enumerates remote resources"”

"enumerates route table"

"enumerates services hosted in processes"

"enumerates system info"

"enumerates trusted domains"

"evades scanning within windows defender"

"evasive powershell used over network"

"event viewer executes uncommon binary"

"execute dll through rundI132"

"exports sensitive registry hive"

"extracts password-protected archive"

"file encrypted"

"file hidden"

"file path not part of debian package in important system directory"
"file path not part of debian package"

"file path not part of rpm in important system directory"
"file path not part of rpm"

"file vault disabled"

"floating module and hooking"

205



Live Services Management Guide

 "floating module in browser process"
o "floating module in os process"
 "floating module"

» "gatekeeper disabled"

o "gets current user as system"

o "gets current username and group information"
 "gets current username"

o "gets hostname"

o '"gets remote time"

» "gina replacement"

o "graylisted file"

e "hidden and hooking"

e "hidden in appdata"

e "hidden plist and autorun"

e "hidden running as root"

e "hooks audio output function"

e "hooks authentication function"

» "hooks crypto function"

e "hooks dnsquery function"

e "hooks gui function"

» "hooks network http function"

» "hooks network io function"

e "hooks ntldr function"

» "hooks registry access function"

e "hooks registry enumeration function"
o "http daemon runs command prompt"
 "http daemon runs powershell"

o "http daemon runs reconnaissance tool"
 "http daemon writes executable"

o "ie dep disabled"
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"ie enhanced security disabled"

"in appdata directory"

"in hidden directory"

"in recycle bin directory"

"in root of appdatalocal directory"
"in root of appdataroaming directory"
"in root of logical drive"

"in root of program directory"

"in root of users directory"

"installs root certificate"

"in system volume information directory"

"in temporary directory"
"in uncommon directory"
"invalid signature"

"kext signature validation disabled"

"lateral movement with credentials using net utility"

"ld preload"

"library preferences directory"
"lists anti-spyware products"
"lists antivirus products"

"lists firewall products"

"login bypass configured"
"lua disabled"

"mac firewall disabled"
"malicious file by reputation service"
"maps administrative share"
"maps ipc$ share"
"misleading file extension"

"modifies file associations"

"modifies image file execution for persistence"
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» "modifies registry using command-line registry tool"
e "modifies run key"

e "modifies shell-open-command file association"

o "modifies startup folder location"

» "modifies winlogon dll for persistence"

o "modifies winlogon registry settings"

e "mshta runs command prompt"

o "mshta runs powershell"

o "mshta runs scripting engine"

» "mshta writes executable"

» "network access"

» "no antivirus notification disabled"

e "no firewall notification disabled"

e "non-microsoft modifies bad certificate warning setting"
e "non-microsoft modifies firewall policy"

o "non-microsoft modifies internet zone setting"

» "non-microsoft modifies lua setting"

o "non-microsoft modifies registry editor setting"

» "non-microsoft modifies security center config"

e "non-microsoft modifies services imagepath"

» "non-microsoft modifies task manager setting"

e "non-microsoft modifies windows system policy"

» "non-microsoft modifies zone crossing warning setting"
» "no uac notification disabled"

e "no windows update notification disabled"

o "office application crashed"

 "office application injects remote process"

o "office application runs bits"

 "office application runs command prompt"

o "office application runs powershell"
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"office application runs scripted ftp"
"office application runs scripting engine"
"office application runs task scheduler"
"office application runs wmi scripting engine"
"office application writes executable"
"opens browser process"

"opens os process"

"opens process"

"opswat reported infected"

"opswat reported suspicious"

"os process runs command shell"
"packed and autorun"

"packed and network access"

"packed"

"performs scripted file transfer"
"possible login bypass"

"possible mimikatz activity"

"possible rdp session hijacking"
"possibly configures uac bypass"
"possibly renamed net.exe detected"
"potential abuse of odbcconf™

"potential outlook exploit"

"powershell command using string manipulation"
"powershell injects remote process"
"powershell opens Isass process"
"powershell runs command prompt"
"powershell runs scripting engine"
"process authorized in firewall"

"process redirects to stdout or stderr"

"process with matched yara rule"
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» "process with opswat reported infected"
o "process with opswat reported suspicious"
o "psexesvc runs powershell"

o "psexesvc runs scripting engine"

e "psexesvc runs shell commands"

o "pubprn detection"

e "queries cached kerberos tickets"

o "queries processes on local system"
 "queries processes on remote system"

o "queries registry using command-line registry tool"
 "queries terminal sessions"

e "queries users logged on local system"

e "queries users logged on remote system"
o "record screen captures using psr tool"

» '"registers always install elevated policy"
o "registers appcert dIl"

 '"registers appinit dll"

o "registers boot execute"

 '"registers lsa authentication package"

o "registers Isa notification package"
 '"registers lsa security package"

o "registers netsh helper dll"

 '"registers port monitor dIl"

o "registers shim database"

 '"registers startup during safe mode boot"
o "registers time provider dIl"

 '"registry tools disabled"

o "regsvr32 creates windows task"

e "regsvr32 runs powershell"

e "regsvr32 runs rundll32"
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"regsvr32 writes executable"

"remote directory traversal"

"removes windows defender definitions"

"rpm hash mismatch in important system directory"
"rpm hash mismatch"

"rpm ownership changed"

"rpm permissions changed"

"rundll32 creates windows task"

"rundll32 runs powershell"

"runkey persistence"

"runs acl management tool"

"runs active directory service query tool"

"runs binary located in recycle bin directory"
"runs binary located in root of logical drive"
"runs binary located in root of program directory"
"runs binary located in root of users directory"
"runs binary located in system volume information directory"
"runs blacklisted file"

"runs certutil with decode arguments"

"runs certutil with encode arguments"

"runs certutil with hashfile arguments"

"runs chained command shell"

"runs chmod"

"runs credential dumping tools"

"runs curl"

"runs ditto"

"runs dns lookup tool for txt record"

"runs dns lookup tool"

"runs file attributes modification tool"

"runs file transfer tool"
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e "runs forfiles.exe"

o "runs graylisted file"

 "runs ifconfig"

e "runs kextload"

e "runs kextstat"

e "runs launchetl"

 "runs malicious file by reputation service"

o "runs mshta with http argument"

 "runs mshta with script argument"

o "runs msiexec with http argument"

 "runs netstat"

o "runs network configuration tool"

 "runs network connectivity tool"

» "runs one letter executable"

 "runs one letter script"

e "runs ping"

 "runs powershell bypassing execution policy"
o "runs powershell decoding base64 string"
 "runs powershell defining function"

o "runs powershell downloading content"

e "runs powershell invoke-mimikatz function"
e "runs powershell memory stream function"
e "runs powershell"

e "runs powershell shellexecute function"

e "runs powershell using encoded command"
o "runs powershell using environment variables"
e "runs powershell with hidden window"

e "runs powershell with http argument"
 "runs powershell with long arguments"

e "runs psexec on remote system and silently accepts user license"
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"runs psexec on remote system as system user"
"runs ps"

"runs registry tool"

"runs regsvr32 com scriplets"

"runs regsvr32 using one letter dll"

"runs regsvr32 with http argument"

"runs regsvr32 without arguments"

"runs remote execution tool"

"runs remote powershell command"

"runs robocopy.exe"

"runs rundll32 using one letter d11"

"runs rundll32 with http argument"

"runs rundll32 with javascript argument"
"runs rundll32 without arguments"

"runs scripting engine in batch mode using execution engine argument"
"runs scripting engine"

"runs service control tool"

"runs shim database installer"

"runs sh"

"runs suspicious file by reputation service"
"runs tar"

"runs tasks management tool"

"runs unzip"

"runs waitfor.exe"

"runs wmi command-line tool"

"runs wmi scripting engine"

"runs xcopy.exe"

"safari fraud website warning disabled"
"scripting addition in process"

"scripting engine injects remote process"
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 "scripting engine runs powershell"

o "scripting engine runs regsvr32"

« '"scripting engine runs rundl132"

o "self signed"

» "services in programdata directory"

» "services runs command shell"

o "smartscreen filter disabled"

 '"starts local service"

 '"starts rdp service"

 '"starts remote service"

 "stops diagtrack service"

 "stops error reporting service"

 "stops security service"

o "stops windows update service"

 "sudo no password prompt"

o "suspicious file by reputation service"
 "suspicious regsvr32.exe task"

o "system integrity protection disabled"
 "system restore disabled"

o "tampers with windows defender registry"
 "task manager disabled"

o "tasks in programdata directory"
 '"terminates process"

o "transfers file using bits"

e "uac disabled"

o "unexpected csrss.exe parent"

o "unexpected explorer.exe destination location"
o "unexpected explorer.exe parent"

o "unexpected explorer.exe source location"

o "unexpected Isass.exe parent"
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"unexpected Ism.exe parent”

"unexpected msdtc.exe parent"

"unexpected os process destination location"

"unexpected os process source location"

"unexpected runtimebroker.exe parent"

"unexpected services.exe parent"

"unexpected smss.exe parent"

"unexpected svchost arguments"

"unexpected svchost.exe parent"

"unexpected taskhostw.exe parent"

"unexpected wininit.exe parent”

"unexpected winlogon.exe parent”

"unknown segment"

"unsigned copies self"

"unsigned creates remote thread and file hidden"
"unsigned creates remote thread"

"unsigned cron job"

"unsigned deletes self"

"unsigned kext"

"unsigned library in suspicious daemon"

"unsigned module in signed process"

"unsigned reserved name"

"unsigned runs python"

"unsigned writes executable"

"unsigned writes executable to appdatalocal directory"
"unsigned writes executable to appdataroaming directory"
"unsigned writes executable to library application support directory"
"unsigned writes executable to library directory"
"unsigned writes executable to library preferences directory”

"unsigned writes executable to scripting additions directory"
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» "unsigned writes executable to system directory"
o "unsigned writes executable to var directory"

» "unsigned writes executable to windows directory"
o "unsigned writes to autorun"

 "uses libnss"

o '"uses libpcap"

 "uses mach injection"

o "uses mach override"

» "warning on post redirect disabled"

o "windows firewall disabled"

o "windows task runs powershell"

o "windows update disabled"

o "wmic remote node activity"

o "wmiprvse runs command shell"

e "wmiprvse runs powershell"

o "wmiprvse runs scripting engine"

o "writes blacklisted file"

o "writes executable to recycle bin directory"

» "writes executable to root of logical drive"

o "writes executable to root of program directory"
o "writes executable to root of users directory”

o "writes executable to system volume information directory"
o "writes graylisted file"

o "writes malicious file by reputation service"

o "writes suspicious file by reputation service"

o "yara rule matched"

» "executable in ads"

o "explorer public folder dll load"

o "powershell double base64"

o "outbound from windows directory"
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|l

 "outbound from unsigned temporary directory’
o "unsigned opens Isass"

 "outbound from unsigned appdata directory"

e "rdp launching loopback address"

 "autorun invalid signature windows directory"

e "command shell copy items"

Appendix B: Position Tracking Information

The ESA Correlation service continuously streams data from the data sources like decoders (log and
network), and concentrators. ESA retrieves events from the data sources, and applies rules to generate
alerts to detect malicious activities. When you deploy a data source, ESA starts processing information
from the latest available session, by default. Position Tracking Information enables you to visualize the
progress of the sessions that ESA has processed, and provides information on the session IDs and the
date and time when the events were processed.

Set Position Tracking Information enables you to:

» Visualize the number of sessions that a particular ESA data source has already analyzed, review the
number of sessions ESA would process after you edit the position tracking, and plan your work.

 Set the tracking position information based on:

o Session ID
o Date and Time (Collection Time)
 Set position tracking for multiple data sources before you deploy them.
o Calculate the number of sessions that the ESA Correlation Service is scheduled to process for a

particular data source to either process, reprocess, or skip sessions with respect to the current position
of the data source.

Note: The Position tracking feature with the Date and Time option works based on the profile time
settings in the NetWitness Platform XDR UI. This time-zone based time from the Ul is converted to
UTC, and is sent to the core, to retrieve the corresponding session ID for that time stamp.

Example: If the UI follows IST, the UI converts it to UTC and sends it to the core. The session ID is
fetched for the specific UTC time stamp, and set to position tracking at deployment.

Use Case Scenario
This section provides information about how you can use position tracking information in a real-world
scenario.

Case 1: If you have deployed a data source with a total of 400 sessions that ESA has already processed,
and if you want to start processing the events from the beginning, perform the following steps to
reprocess the sessions.

Edit the position Tracking Information
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1. Select the deployment and click Edit Deployment.

2. Select the datasource and click Set Position Tracking Information.
The Set Position Tracking Information dialog is displayed.

3. In the Go To drop-down menu, select the Session ID and enter the session number as 1 in the
Session ID text field.

You can also set the position tracking information based on date and time and the sessions will be
calculated using data and time.

4. Click Calculate Sessions.
5. Click Save twice.

6. Select the Deployment and click Deploy.
All the 400 sessions will be reprocessed.

The following image shows the use case scenario.

Set Position Tracking Information

Current Position:
Position tracking has been edited and set to Session ID: 400

GO TO

Session ID

SESSION ID

1

Calculate Sessions

400 sessions will be reprocessed

Cancel Save

Case 2: If you have deployed a data source with a total of 700 sessions available and the current position
of the data source is at 100 and if you set the sessions ID to 250. In this case, 150 sessions will be
skipped. You can also set the sessions based on the date and time.

The following image shows the use case scenario.
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Set Position Tracking Information

Current Position:
Position tracking has been edited and set to Session ID: 100

GO TO

SESSION ID

250

Calculate Sessions

150 sessions will be skipped

Cancel

Case 3: If you have deployed a data source that has a total of 1921237 sessions available and if you set
the session ID higher than the available sessions for the data source. In this case, no remaining sessions
will be processed. You can also set the sessions based on date and time.

The following image shows the use case scenario.
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Set Position Tracking Information

Current Position:
Position tracking has been edited and set to Session ID: 100

GO TO

Session |ID

SESSION ID

No sessions remaining to be processed

Save

Note: Editing the tracking information is optional. If you add a new data source to an existing ESA
deployment, and you do not edit the tracking information, ESA follows the default behavior to process
events.
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